OPERATIONS MANUAL

Versions up to 2.11.xx
INSTALL-118 (Europe)
<table>
<thead>
<tr>
<th>3.6 Setting User Preferences</th>
<th>..............................................................</th>
<th>28</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.6.1 User Sound Settings</td>
<td>.............................................</td>
<td>28</td>
</tr>
<tr>
<td>3.6.2 User Temperature Unit Settings</td>
<td>.............................................</td>
<td>28</td>
</tr>
<tr>
<td>3.6.3 User Alarm List View Settings</td>
<td>.............................................</td>
<td>29</td>
</tr>
<tr>
<td>3.6.4 User Device Notes List View Settings</td>
<td>.............................................</td>
<td>29</td>
</tr>
<tr>
<td>3.7 780 Series/GCC-9000 Configuration</td>
<td>.............................................</td>
<td>30</td>
</tr>
<tr>
<td>3.8 AC 2000+ Configuration</td>
<td>.............................................</td>
<td>30</td>
</tr>
<tr>
<td>3.9 NGC-UIT Configuration</td>
<td>.............................................</td>
<td>31</td>
</tr>
<tr>
<td>3.10 HTC-Direct Configuration</td>
<td>.............................................</td>
<td>31</td>
</tr>
<tr>
<td>3.11 Program Configuration</td>
<td>.............................................</td>
<td>31</td>
</tr>
<tr>
<td>3.11.1 RTS Control</td>
<td>.............................................</td>
<td>32</td>
</tr>
<tr>
<td>3.11.2 Tx Delay</td>
<td>.............................................</td>
<td>32</td>
</tr>
<tr>
<td>3.11.3 Installing a 780 Series/GCC-9000 or an AC 2000+</td>
<td>.............................................</td>
<td>32</td>
</tr>
<tr>
<td>3.11.4 Installing HTCs</td>
<td>.............................................</td>
<td>33</td>
</tr>
<tr>
<td>3.11.5 Installing an HTC Using a Direct Connection</td>
<td>.............................................</td>
<td>34</td>
</tr>
<tr>
<td>3.11.6 Installing an AC 2000+ Connected to an Ethernet LAN</td>
<td>.............................................</td>
<td>35</td>
</tr>
<tr>
<td>3.11.7 Installing a GCC Connected To a Serial/Ethernet Gateway</td>
<td>.............................................</td>
<td>36</td>
</tr>
<tr>
<td>3.11.8 Installing an HTC-Direct Connection to an Ethernet Gateway</td>
<td>.............................................</td>
<td>36</td>
</tr>
<tr>
<td>3.11.9 Installing an NGC-UIT</td>
<td>.............................................</td>
<td>36</td>
</tr>
<tr>
<td>3.11.10 Installing an NGC-UIT Connected to an Ethernet LAN</td>
<td>.............................................</td>
<td>37</td>
</tr>
<tr>
<td>3.11.11 Installing an NGC-40 Bridge</td>
<td>.............................................</td>
<td>38</td>
</tr>
<tr>
<td>3.11.12 Installing a NGC-40 Bridge connected to an Ethernet LAN</td>
<td>.............................................</td>
<td>38</td>
</tr>
<tr>
<td>3.11.13 Search Network for devices</td>
<td>.............................................</td>
<td>39</td>
</tr>
</tbody>
</table>

**Section 4 – Using RAYCHEM Supervisor** .............................................................. 40

| 4.1 RAYCHEM Supervisor and Multi-user Access | ........................................................ | 41 |
| 4.2 Setting Up Servers | .......................................................... | 42 |
| 4.3 Add GCC, Add NGC-UIT and Add NGC-40 Bridge Windows | ............................................. | 43 |
| 4.4 Add HTC Window | .......................................................... | 43 |
| 4.5 View Alarms Window | .......................................................... | 44 |
| 4.6 Configuration Windows | .......................................................... | 44 |
| 4.6.1 GCC Configuration | .......................................................... | 44 |
| 4.6.2 HTC Configuration | .......................................................... | 47 |
| 4.6.3 NGC-UIT Configuration | .......................................................... | 49 |
| 4.6.4 NGC-30-CRM/CRMS Configuration | .......................................................... | 49 |
| 4.6.5 NGC-20 Configuration | .......................................................... | 51 |
| 4.6.6 NGC-40 Bridge Configuration | .......................................................... | 52 |
| 4.6.7 NGC-40 HTC/HTC3 Configuration | .......................................................... | 53 |
| 4.6.8 NGC-40 IO Configuration | .......................................................... | 54 |
| 4.6.9 Elexant 4010i/4020i Configuration | .......................................................... | 54 |
| 4.7 Monitor Button | .......................................................... | 55 |
| 4.7.1 Monitoring a Single Device | .......................................................... | 55 |
| 4.7.2 Monitoring Multiple Devices | .......................................................... | 56 |
| 4.8 Database Synchronization | .......................................................... | 58 |
| 4.8.1 Database Synchronization for an AC 2000+ | .......................................................... | 59 |
| 4.8.2 Database Synchronization for an NGC-UIT and NGC-40 Bridge | .......................................................... | 60 |
| 4.9 Using the Device Configuration Loader | .......................................................... | 60 |
| 4.9.1 Load HTC Configurations | .......................................................... | 60 |
| 4.9.2 View Device Configuration Loaders | .......................................................... | 61 |
12.7 Viewing Your Plant ........................................................................................................ 132
12.7.1 Viewing by Devices .................................................................................................. 132
12.7.2 Viewing by Group .................................................................................................... 133
12.7.3 Viewing by Server .................................................................................................... 133
12.7.4 Viewing by Line/Equipment Number ....................................................................... 134
12.7.5 Viewing by Location ................................................................................................. 134
12.7.6 Viewing by Breaker Panel ........................................................................................ 135
12.7.7 Viewing by Controller Panel .................................................................................... 136

Section 13 – Working with Offline Devices ....................................................................... 137
13.1 Setting Devices Offline ................................................................................................. 137
  13.1.1 Setting EHT System Offline .................................................................................... 137
  13.1.2 Setting a GCC or NGC-UIT or NGC-40 Bridge Offline .......................................... 138
  13.1.3 Setting an HTC-direct or NGC-20 direct Offline .................................................... 138
  13.1.4 Setting an HTC Offline ........................................................................................... 139
13.2 Setting Devices Online ................................................................................................ 139
  13.2.1 Setting the EHT System Online ............................................................................. 139
  13.2.2 Setting a GCC or NGC-UIT or NGC-40 Bridge Online .......................................... 140
  13.2.3 Setting an HTC-direct Online ................................................................................ 140
  13.2.4 Setting an HTC Online .......................................................................................... 141
13.3 Working With Offline Devices ....................................................................................... 141
  13.3.1 Installing a GCC or NGC-UIT or NGC-40 Bridge Offline ........................................ 142
  13.3.2 Installing an HTC Offline ....................................................................................... 142
  13.3.3 Installing an HTC-direct Offline ............................................................................ 143
  13.3.4 Editing a GCC or NGC-UIT or NGC-40 Bridge Offline .......................................... 144
  13.3.5 Editing an HTC Offline .......................................................................................... 144
  13.3.6 Removing a GCC, an NGC-UIT or an NGC-40 Bridge Offline ............................... 145
  13.3.7 Removing an HTC or HTC-direct or NGC-UIT Circuit or NGC-40 module Offline ... 145
  13.3.8 Changing GCC, NGC-UIT, or NGC-40 Bridge Communications Offline ............... 145
  13.3.9 Changing an HTC or HTC-direct Communications Offline ................................. 146

Section 14 – Database Tools ............................................................................................. 147
14.1 Export and Import .................................................................................................... 147
  14.1.1 Export ................................................................................................................... 147
  14.1.2 Importing .............................................................................................................. 147
14.2 Back Up and Restore the System Databases .............................................................. 150
  14.2.1 Back Up the System Database .............................................................................. 150
  14.2.2 Restore the System Database ............................................................................... 150
14.3 Converting RAYCHEM Supervisor Databases ............................................................ 151
14.4 Converting TraceMaster Databases ......................................................................... 151
14.5 Converting PyroMaster Databases .......................................................................... 152

Section 15 – Software Activation and Registration ......................................................... 153
15.1 Activate Software License ........................................................................................ 153
  15.1.1 Activate a DEMO version ..................................................................................... 153
  15.1.2 Activate a New License ....................................................................................... 154
  15.1.3 Activate an Upgrade ............................................................................................ 154
  15.1.4 Upgrade SQL Server Licenses ............................................................................. 155
  15.1.5 Upgrade Windows Server Licenses ...................................................................... 156
Section 1 – INTRODUCTION

1.1 WELCOME

The nVent RAYCHEM Supervisor heat-tracing controller configuration and monitoring software provides a graphical user interface for RAYCHEM communications and controller products. The software supports the following products:

- NGC-40 system, including the nVent RAYCHEM NGC-40 HTC, NGC-40 HTC3, NGC-40 IQ, and NGC-40 Bridge modules
- Elexant 4010/4020i, NGC-20 controllers, connected directly
- nVent RAYCHEM NGC-UIT User Interface Terminals with NGC-20 or NGC-30 controllers
- 780 Series/GCC-9000 Group Communications Controllers
- RAYCHEM T2000 AC 2000+ alarm/communications interface cards
- RAYCHEM 910/915/920 Heat Trace Controllers and/or legacy RAYCHEM Controllers (except the RAYCHEM 200N) using the Modbus® protocol.

The software allows the user to configure and monitor any RAYCHEM controller which has the appropriate communications interface installed from one central location. The software also incorporates advanced features such as data logging and trending, batch and recipe processing, scheduled events, and so on.

This new version has added support for the NGC-40 system. Version 2.9 retains the full multi-user, multi-server and networking capabilities that were added in V2.0. Electric Heat-Tracing (EHT) system information can now be accessed and managed from almost anywhere in the world, using the latest connectivity technologies. This flexibility can reduce the cost of installing communications to controllers within your facility. Devices are no longer limited to simple hard-wired serial communications, but can now take advantage of existing network infrastructures including Ethernet LANs (Local Area Networks), and Internet-based WANs (Wide Area Networks).

1.2 NEW FEATURES

RAYCHEM Supervisor version 2.9 replaces previous versions of the RAYCHEM Supervisor software.

This section provides a summary of the new features that have been added since the last version release of this software package.

The software now includes support for the following:

- Column sorting in list views
- Column sorting is carried through from one list view to another (View Devices, View Alarms, and View Notes tab)
- Assigning devices to Recipes using the generic EHT device picker screen to simplify device selection (all devices were displayed on the screen previously)
- The Excel Data Importer (available through the Tools\Administrative\Import Excel File menu) can import drawings, Steamout enable, and device priority settings
- New user permission allowing a user to modify the name and descriptions of the plant documentation settings in Supervisor. Note that this permission does not allow the user to add, delete, or modify other settings associated with the plant documentation.

1.3 VITAL INFORMATION

IMPORTANT: All information, including illustrations, is believed to be reliable. Users, however, should independently evaluate the suitability of each product for their particular application. nVent makes no warranties as to the accuracy or completeness of the information, and disclaims any liability regarding its use.

nVent only obligations are those in the nVent Standard Terms and Conditions of Sale for this product, and in no case will nVent or its distributors be liable for any incidental, indirect, or consequential damages arising from the sale, resale, use, or misuse of the product.
Specifications are subject to change without notice. In addition, nVent reserves the right to make changes—without notification to Buyer—to processing or materials that do not affect compliance with any applicable specification.

1.4 USER RESPONSIBILITIES

The performance, reliability and safety of your heat-tracing system depend on proper design, selection and installation. The RAYCHEM Supervisor program will help you configure and monitor a system that meets your requirements, but it is only a tool. It assumes that your input is accurate, that you are familiar with heat-tracing system design and configuration, and that you will ensure that all components of the heat-tracing system are installed, maintained and used as intended. The configuration of the RAYCHEM Supervisor program should be reviewed by a knowledgeable engineer to ensure it is appropriate for your application. Additional information relating to safety, design and installation is contained in Design Guides, Installation Manuals, Data Sheets, and other literature available from nVent. Be sure to consult these documents as needed.

1.5 SAFETY WARNINGS

There are important safety warnings shipped with our products and printed in our literature. Be sure to read and follow them to reduce the risk of fire, shock or personal injury. If you have any questions, contact your local Representative or nVent directly.

1.6 TECHNICAL SUPPORT

In North America, contact nVent directly at:

nVent
7433 Harwin Drive
Houston, TX 77036
Tel: +1.800.545.6258
Fax: +1.800.527.5703
email: thermal.info@nvent.com

Or for other parts of the world, contact nVent at:

Europe, Middle East, Africa
nVent
Romeinse straat 14
3001 Leuven
Belgium / België / Belgique
Tel: +32.16.213.511
Fax: +32.16.213.604
email: thermal.info@nvent.com

Asia Pacific
nVent
20F, Innovation Building
1009 Yi Shan Rd,Shanghai 200233, P.R.China
Tel: +86.21.2412.1688
Fax: +86.21.5426.3167
email: cn.thermal.info@nvent.com

Latin America
nVent
Rua Werner von Siemens 111
Prédio 11 (Torre A) 2- Andar
Brazil
Tel: +1.713.868.4800
Fax: +1.713.868.2333
email: thermal.info@nvent.com
The RAYCHEM Supervisor heat-tracing controller configuration and monitoring software provides a graphic interface for the following products:

- NGC-40 system, including NGC-40 HTC, NGC-40 HTC3, NGC-40 IO, and NGC-40 Bridge modules
- Elexant 4010i/4020i, NGC-20 controllers, connected directly
- NGC-UIT User Interface Terminals with NGC-20 or NGC-30 controllers
- 780 Series/GCC-9000 Group Communications Controllers
- RAYCHEM T2000 AC 2000+ alarm/communications interface cards
- RAYCHEM 910/915/920 Heat Trace Controllers and/or legacy RAYCHEM Controllers (except the RAYCHEM 200N) using the Modbus® protocol.

The software allows the user to configure and monitor any RAYCHEM controller installed in the field which has the appropriate communications interface installed from one central location. The software also supports alarm monitoring, with the ability to acknowledge and clear alarms.

2.1 SYSTEM REQUIREMENTS

The RAYCHEM Supervisor software is designed to run in a networked environment using one or more computers. The software is composed of three components, and it is assumed that all computers are networked together on a corporate intranet. Implementation details of this type of networking environment are beyond the scope of this document. The three components of the software are:

RAYCHEM Supervisor Master Server
RAYCHEM Supervisor Slave Server
RAYCHEM Supervisor Client

The RAYCHEM Supervisor Master Server and RAYCHEM Supervisor Slave Server applications must be installed and run on separate computers. RAYCHEM Supervisor Slave Servers are optional; however you may add new RAYCHEM Supervisor Slave Servers to your EHT system as required. Using RAYCHEM Supervisor Slave Servers allows your EHT system to distribute the communications workload. For example, instead of one computer providing the monitoring for all devices in your system, one or more slave servers can be configured to monitor for alarms at the same time.

The RAYCHEM Supervisor Client provides the user interface and can be installed on any computers that require user interaction with the system. Once the RAYCHEM Supervisor Master Server, RAYCHEM Supervisor Slave Server(s) and RAYCHEM Supervisor Client(s) are installed, multiple users can access the RAYCHEM Supervisor EHT system from different client computers simultaneously.

The computer hardware required to run RAYCHEM Supervisor Master Server, RAYCHEM Supervisor Slave Server and RAYCHEM Supervisor Client are outlined in the following sections.

2.1.1 TYPICAL SYSTEM ARCHITECTURES

While many RAYCHEM Supervisor system architectures are possible, they will generally fall into one of three types, and these in turn will use either Microsoft SQL Express or Microsoft SQL Server for their databases.

**Single Master Server, no Slave Servers, Single User (Client)**. This type of installation will typically use the Microsoft SQL Express database (“Standard”) version of RAYCHEM Supervisor.
**Single Master Server, no Slave Servers, Multiple Users (Clients).** This architecture may be SQL Express-based as long as the number of simultaneous users is limited to a maximum of four. Due to SQL Express database limitations, no performance guarantees can be made in all situations with this many users. For example, if several data trending or batch jobs are being run simultaneously, only one or two users may be able to connect without impacting system performance. Applications that require more users or the ability to have a larger number of batch/trending/configuration jobs must use the MS-SQL-Server-based (with Multi-User/Server Capability) version of RAYCHEM Supervisor.

**Single Master Server, one or more Slave Servers, Multiple Users (Clients).** This topology represents the largest system type, where multiple computers are used to distribute the communications and process workload. This type of installation will always use the MS-SQL-Server-based (with Multi-User/Server Capability) Enterprise version of RAYCHEM Supervisor and will support a large number of simultaneous users and data processing jobs.
To effectively use the software, the following configuration is required:

- A Quad core® – 2.0 GHz or faster (Recommended), Pentium®4 – 1 GHz (Minimum) computer.
- Large systems using multiple Slave Servers should consider the use of a higher speed/multiple processor Master Server computer for best performance. Consult nVent Applications Engineering for guidance.
- A hard disk with at least 4 gigabytes of free space (Recommended), 2 gigabytes (Minimum)
- 8 gigabyte of RAM (Recommended), 1 gigabytes of RAM (Minimum)
- CD-ROM Drive
- One or more available serial ports
- A mouse or other compatible pointing device
- SVGA display with 800x600 resolution
- Standard configurations using Microsoft SQL Express: Windows® XP Pro SP3, Windows Vista, Windows 7, Windows 8 or Windows 10, either 32 or 64 bit.
- Multi-User/Server Capable configurations using MS SQL Server: Microsoft Windows® Server 2000 through 2017
- Microsoft .NET® Framework version 4.0
- Network connectivity
2.1.3 RAYCHEM SUPERVISOR SLAVE SERVER

To effectively use the software, the following configuration is required:

- A Quad core© – 2.0 GHz or faster (Recommended), Pentium®4 – 1 GHz (Minimum) computer. Large systems using multiple Slave Servers should consider the use of a higher speed/multiple processor Master Server computer for best performance. Consult nVent Applications Engineering for guidance.
- A hard disk with at least 4 gigabytes of free space (Recommended), 2 gigabytes (Minimum)
- 8 gigabyte of RAM (Recommended), 1 gigabytes of RAM (Minimum)
- CD-ROM Drive
- 1 or more available serial ports
- A mouse or other compatible pointing device
- SVGA display with 800x600 resolution
- Microsoft .NET® Framework version 4.0
- Network connectivity

2.1.4 RAYCHEM SUPERVISOR CLIENT

To effectively use the software, the following configuration is required:

- A Quad core© – 1GHz or faster (Recommended), Pentium®4 – 1 GHz (Minimum) IBM compatible personal computer
- A hard disk with at least 1 gigabytes of free space (Recommended), 500 megabytes (Minimum)
- 2 gigabytes of RAM (Recommended), 1 gigabytes of RAM (Minimum)
- CD-ROM Drive
- 1 or more available serial ports
- A mouse or other compatible pointing device
- SVGA display with 800x600 resolution
- Microsoft .NET Framework version 4.0
- Network connectivity

2.1.5 780 SERIES/GCC-9000 GCC CONNECTIONS

The 780/GCC-9000 Group Communications Controller has both an RS-232C and RS-485 serial communications port, either of which you can use to communicate with the computer using the RAYCHEM Supervisor software. Connections are as follows:

**RS-232C**

You will normally use this type of connection when only one 780/GCC-9000 is in the system and it is in close proximity to the computer. The RS-232C requires a Null Modem Serial cable connection, with a 25 pin male connector on the GCC end and either a 9 or 25 pin connector on the PC end. Refer to Appendix A at the back of this manual for connection details.

**RS-485**

Use this type of connection when longer distances are to be covered and/or multiple GCCs are to be connected to the RAYCHEM Supervisor software. The RS-485 wiring should be a twisted, shielded cable of appropriate gauge based on transmission speed and distance. Refer to Appendix A, or the RS-485 Standard, for wire gauge versus speed/distance. Appendix A also includes jumper details for the GCC when using an RS-485 connection.
2.1.6 AC 2000+ ALARM/COMMUNICATIONS INTERFACE CARD CONNECTIONS

The AC 2000+ has a local and a remote port. You can select the local port as an RS-232C or a 2-wire non-isolated RS-485 interface. You can select the remote port as a 2-wire isolated RS-485 or as a 10Base-T Ethernet connection. You can use either port to communicate with the computer using the RAYCHEM Supervisor software. Connections are as follows:

RS-232C

You will normally use this type of connection when only one AC 2000+ is in the system and it is in close proximity to the computer. The RS-232C requires a standard, straight-through serial cable connection, with a 9 pin male connector on the AC 2000+ end and either a 9 or 25 pin connector on the PC end. Refer to Appendix A at the back of this manual for connection details.

RS-485

Use this type of connection when longer distances are to be covered and/or multiple AC 2000+ units are to be connected to the RAYCHEM Supervisor software. The RS-485 wiring should be a 2-wire twisted, shielded cable of appropriate gauge based on transmission speed and distance. Refer to Appendix A, or the RS-485 Standard, for wire gauge versus speed/distance recommendations.

Ethernet

For this type of connection, you can use a standard 10Base-T Ethernet cable with a RJ-45 plug. The network speed supported by the AC 2000+ alarm/communications interface card is 10 Mbps. Consult with your network administrator regarding assigning IP addresses for the AC 2000+ alarm/communications interface card.

2.1.7 NGC-UIT USER INTERFACE TERMINAL CONNECTIONS

The NGC-UIT has both local and remote communication ports. You may elect to use the local serial port (RS-232C) or one of the remote ports (either 2-wire isolated RS-485, or the 10/100Base-T Ethernet). Any of these ports may be used to communicate with a computer using the RAYCHEM Supervisor software.

RS-232C

You will normally use this type of connection when only one NGC-UIT is in the system and it is in close proximity to the computer. Connections via the RS-232C port require use of a special serial cable provided with the NGC-UIT. See the NGC-30 Programming Guide (H58186) and the NGC-30 Installation Manual (H57878) for additional details on setting up this type of connection.

RS-485

Use this type of connection when longer distances are to be covered and/or multiple NGC-UITs are to be connected to the RAYCHEM Supervisor software. The RS-485 wiring should be a 2-wire twisted, shielded cable of appropriate gauge based on transmission speed and distance. Refer to Appendix A, or the RS-485 Standard, for wire gauge versus speed/distance recommendations.

Ethernet

For this type of connection, you can use a standard 10/100Base-T Ethernet cable with an RJ-45 plug. The NGC-UIT supports both 10 Mbps and 100 Mbps connections. Consult with your network administrator, the NGC-30 Programming Guide (H58186) regarding assignment of IP addresses.
2.1.8 HTC-DIRECT CONNECTIONS

A device acting as a Modbus master (i.e.: a PC running the RAYCHEM Supervisor software) may communicate directly with Raychem Elexant 4010/4020, NGC-20, 910, 915 or 920 Series controllers supporting Modbus communication protocols.

Three types of communications option cards are presently available for 910 and 920 Controllers: Modem, RS-232C and RS-485. Only RS-232C and RS-485 communications option cards are used for HTC-direct connections to RAYCHEM Supervisor. The Modem option card is used only when connecting to a 780 Series/GCC-9000 Group Communications Controller.

**RS-232C**

Use an RS-232C connection when only one controller is present and is in close proximity to the computer. Refer to the User Manual for the specific type of controller and communications option card you are using for connection details.

**RS-485**

Use an RS-485 connection when longer distances are to be covered and/or multiple controllers are to be connected to the RAYCHEM Supervisor software. The RS-485 wiring should be a 2-wire twisted, shielded cable of appropriate gauge based on transmission speed and distance. Refer to Appendix A, or the RS-485 Standard, for recommended wire sizes versus speed/distance.

2.1.9 NGC-40 BRIDGE CONNECTIONS

The NGC-40 Bridge has 1 local and 2 remote communication ports plus an Ethernet port. You may elect to use the local serial port (RS-232C) or the remote ports (RS-485) or Ethernet port. Any of these ports may be used to communicate with a computer using the RAYCHEM Supervisor software.

**RS-232C**

You will normally use this type of connection when only one NGC-40 Bridge is in the system and it is in close proximity to the computer. Connections via the RS-232C port require use of a special serial cable provided with the NGC-40 Bridge. See the NGC-40 Programming Guide and the NGC-40 Installation Manual for additional details on setting up this type of connection.

**RS-485**

Use this type of connection when longer distances are to be covered and/or multiple NGC-40 Bridges are to be connected to the RAYCHEM Supervisor software. The RS-485 wiring should be a 2-wire twisted, shielded cable of appropriate gauge based on transmission speed and distance. Refer to Appendix A, or the RS-485 Standard, for wire gauge versus speed/distance recommendations.

**Ethernet**

For this type of connection, you can use a standard 10/100Base-T Ethernet cable with an RJ-45 plug. The NGC-40 Bridge supports both 10 Mbps and 100 Mbps connections. Consult with your network administrator, the NGC-40 Programming Guide regarding assignment of IP addresses.
The RAYCHEM Supervisor software consists of three separate software components:

RAYCHEM Supervisor Master Server
RAYCHEM Supervisor Slave Server
RAYCHEM Supervisor Client

In addition to these, RAYCHEM Supervisor requires a database Server such as Microsoft SQL Server or Microsoft SQL Express to manage its information.

The RAYCHEM Supervisor Client is a typical Windows application that you can start by clicking the RAYCHEM SupervisorClient icon on the desktop, or by using the Start button and navigating to “All Programs” and selecting “RAYCHEM SupervisorClient.”

The RAYCHEM Supervisor Master, RAYCHEM Supervisor Slave, and Microsoft SQL Servers are Windows Services. Unlike Windows applications, Windows Services cannot be started just by clicking on an icon, or using the Start button. Windows Services are started and stopped automatically by the operating system when your PC starts up. They can also be started or stopped manually through the use of the Component Services applet in the Control Panel.

### 3.1 PLANNING YOUR SYSTEM

All RAYCHEM Supervisor EHT systems will have one Master Server and at least one Client. These may be installed on the same PC or may be separate PCs, depending on the topology of the system.

For larger systems, one or more Slave Servers may be added to distribute computing resources throughout a facility. Slave Servers can also reduce installed cost, by making interconnection easier and less expensive using an existing networking infrastructure.

In all cases, more than one user can access the Master and/or Slave Servers at the same time using the RAYCHEM Supervisor Client software. The Master Server and Slave Servers will manage communications to field devices (HTCs, UITs, NGC-40 Bridges, and GCCs), and the user’s plant data to provide multiple clients with up-to-date information. In order to achieve this, the Master and Slave Servers must be running as efficiently as possible.

The efficiency of your RAYCHEM Supervisor EHT system is directly related to how your plant data is organized. An EHT system that is well organized will run consistently and efficiently. End users will be able to navigate easily through the plant setup and get to the information they need quickly.

This section talks about the things you need to know in order to build an efficient EHT system. Once you have gathered this information, you can use it to plan your EHT system. It is important to spend enough time to understand your needs and partition the system accordingly prior to setting up the software. Time spent in the planning stages will save a lot of potential rework later.

The following are important items you need to determine before you begin using your RAYCHEM Supervisor software. After you have gathered all the information, you should be able to decide on the type of software license, the quantity of computers, and the type of SQL Server you’ll need for your EHT system. Also you will have information on the physical layout and installation of field devices that form part of your RAYCHEM Supervisor EHT system.

#### 3.1.1 LOCATION OF FIELD DEVICES

If you have field devices in remote locations of the plant, it may be easier and less expensive to add a Slave server to manage them rather than to run dedicated wiring back to the Master (or to another Slave) Server. Using Slave Servers helps distribute the work load within your EHT system for improved performance, particularly in larger systems. The only requirement is that the Slave Server must have network connectivity to the Master Server.

Note that you may also install the RAYCHEM Supervisor Client software on the same PC as the Server software. This lets you provide local access to system information at the Slave Server PC.
3.1.2 QUANTITY OF FIELD DEVICES

The number of devices in an EHT system affects both communication throughput and overall system performance. The communication throughput restricts how quickly your system can scan for alarms, trend data, etc., and is also limited by the type of communications interface (serial, LAN, etc.).

Depending on the number of installed field devices, your choice of which database to use for your system can affect system performance as well. For systems incorporating Slave Servers and/or more than 500 to 1000 controllers, use of Microsoft SQL Server instead of Microsoft SQL Express is highly recommended.

3.1.3 ORGANIZATION OF FIELD DEVICES

Gather device address, tag, model, and installation location details of your field devices. You can use this information to create plant groupings that will be used in your EHT system. For large installations, consider dividing your facility into groups by function or location. This will allow you to limit users to viewing only devices that are relevant to their area(s) of responsibility.

3.1.4 USER REQUIREMENTS

Estimate the number of users that will be working with the system. The RAYCHEM Supervisor software license restricts the number of simultaneous users that can log in. You can purchase a new license or a license upgrade should you need to increase the number of users.

3.1.5 EQUIPMENT REQUIREMENTS

Define how many Slave Servers (i.e. computers) will be required. This may be determined by deciding where Slave PCs are best located. Two primary factors will help you make this decision:

- How many controllers need to be connected to any one PC? A limit of 500 to 1000 controllers is recommended for best performance. Additional Slave Server PCs should be installed if this limit will be exceeded.

- Where are large groups of controllers concentrated? The most cost-effective installations will use a Slave Server PC in a location that minimizes separate communications field wiring and maximizes the use of existing networking infrastructure.

The RAYCHEM Supervisor software license restricts the number of Slave Servers you can use simultaneously. You may purchase a new license or a license upgrade should you need to increase the number of Slave Servers.

3.1.6 ESTIMATING SOFTWARE REQUIREMENTS

Once you finish gathering all of the information from the previous sections, you can estimate the types of software components needed to create your system. Refer to Section 2.1.1 "Typical System Architectures" for more information on possible topologies.
3.2 STARTING YOUR RAYCHEM SUPERVISOR MASTER OR SLAVE SERVER

This section describes how to start and stop the RAYCHEM Supervisor Master or Slave Server. The RAYCHEM Supervisor Master and Slave Server software components are Windows system services. Windows system services are not the same as Windows applications. They cannot be started manually with Windows Explorer or with the Command Prompt. Windows system services must be started with the Component Services applet in the Control panel, or by Windows when Windows starts. If the RAYCHEM Supervisor Master Server or Slave Server software is installed properly, you can follow the steps below to start them.

3.2.1 STARTING RAYCHEM SUPERVISOR MASTER OR SLAVE SERVER BY REBOOTING

You can start the Master Server or Slave Server simply by rebooting the computer on which the software has been installed. After the computer reboots, the Master or Slave Server automatically starts.

3.2.2 STARTING RAYCHEM SUPERVISOR MASTER OR SLAVE SERVER MANUALLY

Start up the Control Panel, select Administrative Tools, and then select Component Services. When the Component Services window displays, select the services (Local) node on the selection tree. A list of services will display on the list view window. Scroll down and search for RAYCHEM Supervisor Master Server Service or RAYCHEM Supervisor Slave Server Service. Right click on the mouse to bring up the context menu. Select Start to start the service. The start process can take several minutes depending on the number of field devices installed on the Server.

3.2.3 VIEWING WINDOWS SYSTEM EVENTS

System events for the RAYCHEM Supervisor Master Server or Slave Server services may be viewed by the user. The system events will indicate if the Server startup has been successful or if errors have occurred. To view these events, start up the Control Panel, select Administrative Tools, and then select Component Services. When the Component Services window displays, select the Event Viewer (Local), and then select RAYCHEM Supervisor. Any events will display in chronological order.

**IMPORTANT:** In order to view the status of a particular RAYCHEM Supervisor Slave server, you must follow the above procedure on each Slave Server computer.

3.3 STOPPING YOUR RAYCHEM SUPERVISOR MASTER OR SLAVE SERVER

If you must shutdown your EHT System for maintenance purposes, you can follow this procedure to stop a RAYCHEM Supervisor Master or Slave Server.

Start up the Control Panel, select Administrative Tools, and then select Component Services. When the Component Services window displays, select the Service (Local) node on the selection tree. A list of services will display. Scroll down and search for the RAYCHEM Supervisor Master Server Service or RAYCHEM Supervisor Slave Server Service. After you've selected it, right click on the mouse to bring up the context menu. Select Stop to stop the service. The stop process can take several minutes depending on the number of field devices installed on the Server.

3.4 STARTING YOUR RAYCHEM SUPERVISOR CLIENT

After you have successfully installed the RAYCHEM Supervisor Client software, you can start the Client software by clicking the RAYCHEM SupervisorClient icon on the Desktop or navigate through Start, All Programs and select RAYCHEM SupervisorClient. If you want to login to the Master Server, the RAYCHEM Supervisor Master Server must be already running (refer to Section 3.2 “Starting Your RAYCHEM Supervisor Master or Slave Server” for more details).
3.4.1 USER LOGIN

In order to use RAYCHEM Supervisor Client, you must log in to the RAYCHEM Supervisor Master server. When RAYCHEM Supervisor is first installed, a default "admin" user is created in the system. You can use this username with the password "ngc123" to log in. We recommend you change the password for the 'admin' user as soon as possible to prevent unauthorized use of RAYCHEM Supervisor.

There are two methods to change the password. The first is to use the Security drop-down menu, and select Users. The Set up Users window is displayed. Select the admin user and click the Edit button. The user password is disabled until you select the Reset Password checkbox. Once you complete your edit, click OK to save and exit.

The second way to change the password is to use the Security drop-down menu and select My Account Information. The User Account Information window displays. Select the Reset Password checkbox then edit the password textbox. Once you complete your edits, click OK to save and exit.

Figure 3-1 Log on to EHT system

IMPORTANT: The password is case sensitive.

3.4.2 CONNECTING TO THE MASTER SERVER

Regardless of the type of system configuration you have installed, you will need to connect the Client software to a Master Server. This is done during the first login from a specific Client, after which the information entered is saved for use during any subsequent login sessions.

Expand the login window by clicking on the Options button. A number of additional parameters will display as described below:

Selecting the Master Server

Using the "Log on to:" field, enter the Computer name or the IP address of the Master Server. You may also use the Browse button to view available computers on the network and navigate to the appropriate selection.

IMPORTANT: When using IP addresses instead of the Master Computer’s name, ensure that the IP address is a static IP and not a dynamic IP address. Otherwise, the system connections will have to be re-configured every time the Master computer establishes a network connection, or is restarted.

Selecting the Master Server Port

The "Server Port" field defines which TCP/IP port is used for Client→Master data exchanges.
IMPORTANT: The default port is "8888" and should not be changed unless the networking infrastructure cannot support use of this particular port. If the setting is changed, you must also modify the Master Server configuration to match the chosen port (see Section 3.4.3 "Master Server Port Configuration" for details).

IMPORTANT: All Client computers in the system must use the same Server port setting.

Selecting the Client Port

The "Client Port" field defines which TCP/IP port is used for Master→Client data exchanges.

IMPORTANT: The default port is "8887" and should not be changed unless the networking infrastructure cannot support use of this port. Setting this to a "0" will allow the system to automatically choose a port to use for communicating with a Client computer.

Figure 3-2 Select Master Server and Port Settings

3.4.3 MASTER SERVER PORT CONFIGURATION

If you must change the TCP/IP port that is used for Client→Master communications, the port you choose must also be configured into the Master Server (see Section 3.4.2 "Connecting to the Master Server" – Selecting the Master Server Port for details on configuring the Client).

To configure the Master Server port setting, perform the following steps at the computer where the Master Server software is installed:

1. Using Windows Explorer, navigate to the "nVent/RAYCHEM Supervisor Master Server" folder.
2. From the C:\Program Files\nVent\RAYCHEM Supervisor Master Server\ directory location, open the "SupervisorServer.exe.config" file using Note Pad or another text editor.
3. Find the <channels> section and modify the port number from 8888 to the port you want the Master Server to listen on.
4. Save the file.
5. Stop and Restart the Master Server (see Section 3.2 "Starting Your RAYCHEM Supervisor Master or Slave Server" for details).
3.5 SETTING SYSTEM PREFERENCES

System Settings include general and specific settings for Alarms, History Logs, Drawing Types, Device Priorities, and Steam out. A user must have Setup System Preference permission to change the System Preferences. Each of the major settings is grouped together in separate tabbed windows for ease of access.

3.5.1 GENERAL SETTINGS

This window includes company specific information, including company name, company facility, company address, and company location.

Also included are the SMTP mail settings such as the SMTP Server name, SMTP username, and password. These fields must be filled in if you are planning to use the Alarm Email notification feature (refer to Section 4.12.2 “Email Notification” for more details). Note that filling the SMTP username and password fields are optional. These two fields are needed if you are required to login to the SMTP server in order to send emails outside the company’s intranet. We recommend that you create a new user name and password solely for this purpose, since the SMTP protocol does not encrypt this information during transmission. Computer hackers could possibly capture this information.

There are 2 checkboxes available that can be used to customize the email client in Supervisor to work with your SMTP Server. They are the Enable SSL Option and Use Default Credentials checkboxes.

**Enable SSL Option**: This option specifies whether SSL is used to access the specified SMTP mail server.

**Use Default Credentials**: This option specifies whether the Default Credentials is used to access the specified SMTP mail server. The Default credential represents the Windows credentials (i.e. user name, password, and domain) of the user running the application. In this case it is the Master Server Service, or Slave Server Service. If this checkbox is not checked, then the SMTP User name and password is used instead.

![General settings](image-url)
3.5.2 ALARM EMAIL NOTIFICATION SETTINGS

This window includes the Alarm Email Settings and is used to set up RAYCHEM Supervisor to send an email to a specific email address(es) when an alarm occurs. There are different settings available to filter out the types of alarms that can trigger an email. These settings include Device Priority, Alarm Priority, and plant Groups. RAYCHEM Supervisor will only send out an email when all of these criteria are met.

Figure 3-4 Alarm Email Notification List

Figure 3-5 Add a new alarm notification

You must choose the format of the email message RAYCHEM Supervisor will send. The format is determined by the Receiving Device field. If you select pager, the email message is of minimal length. If you select computer, a more descriptive email message is used.
3.5.3 OTHER ALARM SETTINGS

This window includes settings for Auto Alarm Acknowledgement and Alarm Scan interval. For more information on Auto Alarm Acknowledgement, refer to Section 4.12.3 “Auto Alarm Acknowledgement.”

![Figure 3-6 Other Alarm Settings](image)

3.5.4 HISTORY LOG SETTINGS

This window provides access to the History Log settings. The Maximum Number of Records field determines the total number of records the system will store before the system archives the data. Each record will have one history log.

The “When maximum number of records” is reached option determines the action RAYCHEM Supervisor will take when the maximum number of records is reached. You can choose to overwrite the oldest record or to archive the history logs. In addition, you can set the Archive Percentage of logs to archive. For example, once the Maximum number of records is reached, the Archive Percentage will determine what percentage of records remains in the DB and the balance of the records is archived.

For example: If the Maximum number of records is set to 1000, and Archive Percentage is set to 30%, then 700 records will get archived. The larger the Archive Percentage is, the less archiving is done by RAYCHEM Supervisor.

If you experience slow performance and the Archive Percentage is low, you can try increasing this number. The Maximum number of Archive files restricts the total number of archived files that can exist on the Master Server computer. If the Maximum number of archived file exceeds this number, then the system will overwrite the oldest archive file and continue logging. If this happens, a system alarm is generated to notify the user. To clear this alarm and resume logging, move or delete the archive files found in the Archive folder to provide more space for the logged records.
3.5.5 DRAWING TYPE SETTINGS

This window includes a list of user defined drawing types in your EHT system. When you run RAYCHEM Supervisor for the first time, you should create and define your own drawing types. Drawing types are used in RAYCHEM Supervisor to group and organize your drawings. You can use the Add button to add a drawing type, the Edit button to edit the drawing type, and the Remove button to remove a drawing type.
3.5.6 DEVICE PRIORITY COLOR SETTINGS

This window is used to set Device Priority Color Settings. Each device added to the RAYCHEM Supervisor is assigned a Device Priority. A Device Priority is a number ranging from 0 to 7, where 0 is least important and 7 is most important. The default value is set to 0 whenever a new device is added.

Several RAYCHEM Supervisor features make use of the Device Priority: Alarm, and Alarm Email Notification. You can assign a unique foreground and background color for each of the Device Priority values. These combinations of foreground and background colors are used in the alarm list display to enhance the visibility of the alarms.

![Device Priority Color Settings](image)

Figure 3-9 Device priority color settings

3.5.7 STEAM OUT SETTINGS

Steam out settings are accessed using this window, and apply to HTCs only. HTCs must be enabled for use with the Steam out feature.

A Steam out task may be started using the Steam out function (refer to Section 4.12.4 “Steam Outs”). Once the Steam out task starts, RAYCHEM Supervisor will raise the control setpoint temperature of the HTC to the value specified by the Steam out setpoint field. After the time specified by the “Steam out duration” parameter has elapsed, RAYCHEM Supervisor will return the HTC control setpoint to its previous value.
3.6 SETTING USER PREFERENCES

The My Preferences window includes settings for Sound Notification, Temperature Display Units, Alarm List View and Note List View. Each User has his or her own preference settings. When a user logs in to the EHT system, RAYCHEM Supervisor restores the user’s preferences based on these settings.

3.6.1 USER SOUND SETTINGS

This window includes the sound notification settings when alarms occur. You can choose whether to be notified by sound whenever a Warning or Alarm is detected. You can also have sound generated on your PC’s speaker or played through your PC’s sound card.

3.6.2 USER TEMPERATURE UNIT SETTINGS

Use the Units window to select the Temperature Unit setting used by RAYCHEM Supervisor to display temperature. You can choose to display temperature values in degrees Fahrenheit or Celsius.
3.6.3 USER ALARM LIST VIEW SETTINGS

The Alarm List View Setting window shows options that affect how RAYCHEM Supervisor will display the alarms in the main window. The options available are:

1. Show alarms for selected node only. This option displays a list of alarms only for the selected device.
2. Show alarms for selected node and its direct sub-nodes (children). This option displays a list of alarms for the selected node and if the node has sub-nodes, the alarms of the immediate sub-nodes will display also.
3. Show alarms for selected node and all nodes in its hierarchy. This option displays a list of alarms for the selected node and if the node has sub-nodes, the alarms of all sub-nodes will display as well.

Option 1 has the least affect on system performance since a limited amount of data is retrieved from the Master Server whenever the display is refreshed. If you are encountering system performance problems particularly when using remote (WAN) connections, use Option 1.

3.6.4 USER DEVICE NOTES LIST VIEW SETTINGS

The Device Notes List View window defines how RAYCHEM Supervisor will display notes in the main window. The available options are:

1. Show notes for the selected node only. This option displays a list of notes for the selected device only.
2. Show notes for the selected node and its direct sub-nodes. This option displays a list of notes for the selected node and if the node has sub-nodes, the notes of the immediate sub-nodes will display as well.
3. Show notes for the selected node and all nodes in its hierarchy. This option displays a list of notes for the selected node and if the node has sub-nodes, the notes of all sub-nodes will display as well.

Option 1 has the least effect on system performance since a limited amount of data is retrieved from the Master Server whenever the display is refreshed. If you are encountering system performance problems particularly when using remote (WAN) connections, use Option 1.
3.7 780 SERIES/GCC-9000 CONFIGURATION

The GCC communications configuration must match that of the RAYCHEM Supervisor software; otherwise the two devices will not be able to communicate.

Configuration of the GCC is accomplished from the front panel of the GCC by selecting the options as shown in Figure 3-12. Figure 3-12 GCC Communications.

This sets the GCC to communicate through the selected port at 9600 baud, no parity, 2 stop bits, with 0.00 seconds of delay between receipt of a message and a transmitted response to it.

If you are using a two wire RS-485 configuration, then set the delay to 0.06 seconds to allow time for the line signals to stabilize between transmissions and receptions. Select RTU mode because it is a more efficient mode of transmission than ASCII. Refer to the 780 Series/GCC-9000 user’s manual for more detailed information.

![GCC Communications Setup](image)

**IMPORTANT:** The 780 Series/GCC-9000 firmware version must be V2.18 or higher. Upgrading to version V2.21 or higher is recommended to minimize any potential communication timing conflicts.

3.8 AC 2000+ CONFIGURATION

The AC 2000+ communications configuration must match that of the RAYCHEM Supervisor software or the two devices will not be able to communicate. Refer to the RAYCHEM T2000 HTC user’s manual for details on setting the AC 2000+ port parameters. The AC 2000+ supports both Page mapping and Linear mapping communication modes. Ensure that Page mapping is set in the AC 2000+ since RAYCHEM Supervisor supports only Page mapping.

To use TCP/IP with an AC 2000+, refer to Section 3.11.6 “Installing an AC 2000+ Connected to an Ethernet LAN.”

**IMPORTANT:** The AC 2000+ is similar in operation and functionality to a 780 Series/GCC-9000 Group Communications Controller. Therefore, RAYCHEM Supervisor will treat the AC 2000+ as a GCC. Throughout this manual and in the RAYCHEM Supervisor software, the AC 2000+ is referenced as either a GCC or an AC 2000+. All GCC related operations apply to both AC 2000+s and 780 Series/GCC-9000s unless otherwise noted.
3.9 NGC-UIT CONFIGURATION

The NGC-UIT communications configuration must match that of the RAYCHEM Supervisor software or the two devices will not be able to communicate. Refer to the NGC-30 Programming Guide (H58186) and the NGC-30 Installation Manual (H57878) for details on setting the NGC-UIT port parameters.

To use TCP/IP with an NGC-UIT, refer to Section 3.11.10 "Installing an NGC-UIT Connected to an Ethernet LAN."

3.10 HTC-DIRECT CONFIGURATION

Communications between RAYCHEM Supervisor and HTC-direct controllers normally requires an RS-232 to RS-485 converter at the computer end. Although a direct RS-232 connection to a single HTC-direct controller is possible, this is not a common configuration, since the system would then be limited to communications with a single controller.

The RS-232 to RS-485 converter provides the required electrical signal conversion from the communications (COM) port of the computer to the RS-485 network where HTC-direct controllers are connected. All of the HTC-direct units on an RS-485 network must be set up with the same communication parameters and they must match the communication port settings of RAYCHEM Supervisor. Follow the instructions in the HTCs user’s manual to set up each controller for RS-485 communications. To set up a communication port in RAYCHEM Supervisor, please refer to Section 3.11 "Program Configuration."

3.11 PROGRAM CONFIGURATION

When you launch RAYCHEM Supervisor for the first time, no NGC-UITs, NGC-40 Bridges, 780 Series/GCC-9000s, or AC 2000+s, or heat-tracing controllers (HTCs) will be installed in its database (unless you have imported a copy of the database from a previous version of RAYCHEM Supervisor).

The first step is to configure RAYCHEM Supervisor to communicate with your NGC-UIT, NGC-40 Bridge, 780 Series/GCC-9000, AC 2000+, or HTC-direct devices. In the RAYCHEM Supervisor Client software window use the System drop-down menu and select COM Ports Setup. Once the Setup COM Ports window displays, select the appropriate Server, then select the COM port to configure. You can use the Edit button or double click with your mouse on a COM port selection to bring up the Edit COM Port window (refer to Figure 3-13 Figure 3-13 COM Port Settings).

The RAYCHEM Supervisor software allows communications using multiple COM ports, and you must configure every port for each Master Server and Slave Server being used in the system. This may be accomplished using the Setup COM Ports window. Typical settings for each COM port are shown in Figure 3-13 Figure 3-13 COM Port Settings. The Baud Rate, Parity, Stop Bits, and Protocol values must match the settings for all of the NGC-UIT, NGC-40 Bridge, 780 Series/GCC-9000s, AC 2000+s, and HTC-direct controllers connected to the particular COM port being configured. If the COM port selection is TCP/IP, Read Timeout, Write Timeout, Retry, and Txdelay is used.
3.11.1 RTS CONTROL

You can set the Use RTS parameter to ‘Yes’ or ‘No’. If you select ‘No’, then RAYCHEM Supervisor will not use the RTS line when communicating to a device. If you select ‘Yes’, then RAYCHEM Supervisor will turn the RTS signal On and Off while communicating with a device.

You must enable the RTS signal if you are using all of the following:

- An RS-232 to RS-485 converter
- A 2-wire RS-485 connection to the controllers
- The converter is set to use RTS for communications handshaking.

If the converter is configured NOT to use the RTS signal, then you can set the Use RTS to ‘No’.

3.11.2 TX DELAY

The default for the Tx Delay setting is 50 milliseconds, although it may be set from 0 to 500 milliseconds. If you are using RTS control, you would not normally use this parameter.

You can use the Tx Delay parameter to ensure that RAYCHEM Supervisor inserts a delay between packets of data when communicating to an external device. You will want to keep the Tx Delay value as low as possible to improve system performance. If you encounter communication errors or slow responses during device communication, try adding a Tx Delay of 50-100 milliseconds. This will allow the external hardware some time to switch from sending to receiving mode operation.

Once each COM port is set up, the NGC-UIT, 780 Series/GCC-9000’s, AC 2000+s, and HTC-direct controllers should be able to communicate with the RAYCHEM Supervisor program.

You will now need to install each NGC-UIT, GCC and HTC-direct controller you have connected to the computer.

3.11.3 INSTALLING A 780 SERIES/GCC-9000 OR AN AC 2000+

To install a GCC, use the Device drop-down menu and select GCC, then Add GCC. The window (shown in Figure 3-14 Figure 3-14 Add a New GCC) displays, and allows you to enter the information for the GCC you wish to install.
Select the appropriate Server for the GCC you are installing. Enter a tag name for the GCC (to a maximum of 19 characters). You may choose to use the existing tag, or enter a new one. If you enter a new one, it will overwrite what is already stored in the GCC.

Next, enter the COM port to which the GCC is connected. You may use multiple COM ports on your computer to connect to different groups of GCCs. Finally, enter the address range of the GCC you are adding (i.e.: 1, 6, 11, etc.).

**IMPORTANT:** Two GCCs may have the same address as long as they are connected to different COM ports on your computer.

Once you have entered the information, click the **OK** button. The program will initiate communications with the GCC, and add it into the database.

**IMPORTANT:** Do NOT check the Clear the Existing HTC List box unless you wish to erase the list of all of the controllers already installed in the GCC!

Repeat the above steps for each GCC that you wish to install.

**IMPORTANT:** If you wish to install the GCC in Offline mode, refer to 12.7.6.

### 3.11.4 INSTALLING HTCS

Once the GCCs are configured into RAYCHEM Supervisor, you may load any HTCs that are already installed one-by-one or have them loaded automatically.

To manually load each individual controller’s configuration, select the desired controller from the list and click the **Configure** icon, or select the HTC selection from the top menu bar, and choose the Configure menu item.

To have RAYCHEM Supervisor load all of the HTC configurations automatically, select the Load Device Configurations under the System drop-down menu.

The window will display any controllers loaded in the GCC(s) that have not been added to the RAYCHEM Supervisor database. You can select unloaded controllers or all controllers in the list. Once you have pressed start, the program will upload and store the latest configuration settings for each controller. This may take a few minutes, as the program will request a large block of data from each selected controller. Once this operation has been completed for each GCC, the RAYCHEM Supervisor software will store a copy of each controller configuration in its database.
3.11.5 INSTALLING AN HTC USING A DIRECT CONNECTION

To install the HTC-direct or NGC-20 direct controllers, do the following:

1. Select the **EHT System** icon on the tree view window.
2. Click the **Add Device** button, (you can also use the Device drop-down item).
3. Select **Add HTC Direct** or **Add NGC-20 Direct**. The appropriate configuration window is displayed. (refer to or Figure 3-15 Figure 3-15 Add a New HTC Direct window or Figure 3-16Figure 3-16 Add a New NGC-20 Device with Direct Connection window).
4. Enter the information for the first controller that you wish to install.

 **IMPORTANT:** From a RAYCHEM Supervisor perspective, an Elexant or NGC series direct controller are very similar to an HTC-direct controller. Therefore, throughout this manual, references to HTC-direct functionality can be assumed to apply to Elexant 4010i/4020i direct and NGC-20 direct, unless noted otherwise.

![Add a New HTC Direct window](image)

Figure 3-15 Add a New HTC Direct window

![Add a New NGC-20 Device with Direct Connection window](image)

Figure 3-16 Add a New NGC-20 Device with Direct Connection window

 **IMPORTANT:** Two controllers using direct connections may have the same Modbus address and Sub-Address combination as long as they are connected to different COM ports.
Enter a unique tag name for the controller you are installing (to a maximum of 40 characters). You may enter a unique tag name or have RAYCHEM Supervisor use the tag name in the HTC (you must enter at least one character in the tag name field to enable the OK button).

Select the server for this controller, and then choose a COM port, Modbus Address. When you click OK to install, RAYCHEM Supervisor will check if the current tag name exists in the database. If the new tag name is unique, RAYCHEM Supervisor will communicate with the controller to read its tag name. If the tag name in the controller does not match the new tag name, the system will prompt you with the following dialog box.

![Mismatch Tag Names](image)

Figure 3-17 Mismatch Tag Names Message

You can use the new tag name that was entered, or the one that already exists in the controller, or you may cancel the current installation.

- If you select Yes, the system will use the tag name in the controller as the tag name identifying this controller in the database.
- If you select No, the system will use the new tag name you entered to identify this controller in the database. RAYCHEM Supervisor will automatically update the tag name in the controller to the tag name you selected.

After the installation confirms that the new tag name is valid, the controller configuration is read and stored into the RAYCHEM Supervisor database. The installation is now complete for this controller.

Repeat the above steps for each direct connection controller you wish to install. Once you have completed the installation(s), you can configure or monitor them using RAYCHEM Supervisor.

**IMPORTANT:** The tag name for a direct connection controller must match the tag name of the installed controller in the system. If it doesn't, RAYCHEM Supervisor will display a warning and will not allow you to configure or monitor the controller.

### 3.11.6 INSTALLING AN AC 2000+ CONNECTED TO AN ETHERNET LAN

If you have AC 2000+s that are connected to an Ethernet network, you can follow the installation procedure as outlined in Section 3.11.3 *Installing a 780 Series/GCC-9000 or an AC 2000+* to install them into the RAYCHEM Supervisor database.

However, when you select the COM Port, you will need to select TCP/IP. Once you select TCP/IP, the system enables the IP address field. You must fill in the Modbus Address and IP Address fields. The Modbus Address field and IP Address field must match the RTU Address and IP Address settings in the AC 2000+. Refer to the RAYCHEM T2000 user’s manual on how to set up the AC 2000+ Ethernet port.

**IMPORTANT:** Each AC 2000+ must have a unique IP address. See your Network Administrator for assignment of IP addresses.

Once you enter the information, click the OK button. The program will initiate communications to the AC 2000+, and install it into the database.

After installation, RAYCHEM Supervisor displays the combined address for this AC 2000+ as IP/RTU Address (i.e.: 10.10.10.4/3) in all of its windows and reports.
IMPORTANT: Do NOT select the Clear the Existing HTC list box, unless you wish to erase all of the controllers already installed in the AC2000+!

Repeat the above steps for each AC 2000+ you wish to install.

3.11.7 INSTALLING A GCC CONNECTED TO A SERIAL/ETHERNET GATEWAY

A Serial/Ethernet gateway forms a bridge between a serial network and an Ethernet network.

One example of this type of device is the Lantronix CoBox, which translates serial data in Modbus format into Modbus/TCP format and vice versa. The CoBox must be configured by the user. Refer to your Lantronix CoBox user’s manual for setup details. Once the gateway is set up and running, its operation will be transparent to RAYCHEM Supervisor.

To install a GCC that is connected on the serial side of a gateway device, you can follow the installation procedure as outlined in Section 3.11.3 “Installing a 780 Series/GCC-9000 or AC 2000+” to install your GCC(s).

When you select the COM Port, you will need to select TCP/IP. Once you select TCP/IP, the system enables the IP address field. You must fill in the Address and IP Address fields. The Address field is the RTU address of the GCC, and the IP Address field is the IP address of the gateway.

Once you enter the information, click the OK button. The program will initiate communications to the GCC, and install it into the database.

After installation, RAYCHEM Supervisor displays the combined address for this GCC as IP/RTU Address (i.e.: 10.10.10.4/3) in all of its windows and reports.

IMPORTANT: Do NOT select the Clear the existing HTC list box, unless you wish to erase all of the controllers already installed in the GCC!

Repeat the above steps for each GCC you wish to install.

3.11.8 INSTALLING AN HTC-DIRECT CONNECTION TO AN ETHERNET GATEWAY

Modbus-capable RAYCHEM controllers with proper communication interfaces can connect directly to an RS-485 network. Using a gateway device (such as a Lantronix CoBox), the connectivity of these devices can be extended to Ethernet TCP/IP. To install controllers through this type of connection, you can use the same procedure as described in Section 3.11.5 “Installing an HTC using a Direct Connection.” When you select the COM Port, you will need to select TCP/IP. Once you select TCP/IP, the system enables the IP address field. You must fill in the Modbus Address and IP Address fields. The IP Address field is the IP address of the gateway. The Modbus Address is the address of the controller or a mapped address in the gateway that is defined for a controller.

3.11.9 INSTALLING AN NGC-UIT

To install an NGC-UIT, do the following:

1. From the Device drop-down menu, select NGC-UIT, then Add UIT. The window (as shown in Figure 3-18 Figure 3-18 Add a New UiT) allows you to enter the information for the UIT you wish to install.
2. Select the appropriate Server for the UIT you are installing and enter a tag name for the UIT (to a maximum of 40 characters). You may use the existing tag, or enter a new one. If you enter a new one, it will overwrite what is already stored in the UIT.

3. Enter the COM port to which the UIT is connected. You may use multiple COM ports on your computer to connect to different groups of UITs. Finally, enter the Modbus address of the UIT you are adding.

**IMPORTANT:** Two UITs may have the same address as long as they are connected to different COM ports on your computer.

4. Once you have entered the information, click on the **OK** button. The program will initiate communications to the UIT, and add it into the database.

Repeat the above steps for each UIT that you wish to install.

### 3.11.10 INSTALLING AN NGC-UIT CONNECTED TO AN ETHERNET LAN

If you have NGC-UI Ts that are connected to an Ethernet network, you can follow the installation procedure as outlined in Section 3.11.9 "Installing an NGC-UIT" to install them into the RAYCHEM Supervisor database.

However, when you select the COM Port, you will need to select TCP/IP. Once you select TCP/IP, the system enables the IP address field. You must fill in the Address and IP Address fields. The Modbus Address field and IP Address field must match the RTU Address and IP Address settings in the NGC-UIT. Refer to the **NGC-30 Programming Guide** (H58186) for details of how to set up the NGC-UIT Ethernet port.

**IMPORTANT:** Each NGC-UIT must have a unique IP address. See your Network Administrator for assignment of IP addresses.

Once you enter the information, click the **OK** button. The program will initiate communications to the NGC-UIT and install it into the database.

After installation, RAYCHEM Supervisor displays the combined address for this NGC-UIT as: IP/RTU Address (i.e.: 10.10.10.4/3) in all of its windows and reports.

Repeat the above steps for each NGC-UIT you wish to install.

**IMPORTANT:** If you wish to install the NGC-UIT in Offline mode, refer to 12.7.6.
3.11.11 INSTALLING AN NGC-40 BRIDGE

To install an NGC-40 Bridge, do the following:

1. From the Device drop-down menu, select NGC-40, then Add NGC-40 Bridge Direct. The window (as shown in Figure 3-20 Add a New NGC-40 Bridge with Direct Connection) allows you to enter the information for the NGC-40 Bridge you wish to install.

![Figure 3-19 Add a New NGC-40 Bridge with Direct Connection](image)

2. Select the appropriate Server for the NGC-40 Bridge you are installing and enter a tag for the Bridge (to a maximum of 40 characters). You may use the existing tag or a new one. If you enter a new one, it will overwrite what is already stored in the Bridge.

3. Enter the COM port to which the NGC-40 Bridge is connected. You may use multiple COM ports on your computer to connect to different groups of NGC-40 Bridge. Finally enter the Modbus address of the Bridge you are adding.

**IMPORTANT:** Two NGC-40 Bridges may have the same address as long as they are connected to different COM ports on your computer.

Once you have entered the information, click on the OK button. The program will initiate communications to the NGC-40 Bridge, and add it to the database.

Repeat the above steps for each NGC-40 Bridge you wish to install.

3.11.12 INSTALLING A NGC-40 BRIDGE CONNECTED TO AN ETHERNET LAN

If you have NGC-40 Bridges that are connected an Ethernet network, you can follow the installation procedures as outline in Section 3.11.11 Installing an NGC-40 Bridge.

However, when you select the COM port, you will need to select TCP/IP. Once you selected TCP/IP, the system enables the IP address field. You must fill in the Address and IP Address fields. The Modbus Address field and IP Address field must match the RTU Address and IP Address settings in the NGC-40 Bridge. Refer to the NGC-40 Programming Guide for details of how to set up the NGC-40 Bridge Ethernet port.

**IMPORTANT:** Each NGC-40 Bridge must have a unique IP address. See your Network Administrator for assignment of IP addresses.

Once you enter the information, click the OK button. The program will initiate communications to the NGC-40 Bridge and install it into the database.
After installation, RAYCHEM Supervisor displays the combined address for this NGC-40 Bridge as: IP/RTU Address (i.e.: 10.10.10.4/3) in all of its windows and reports.

Repeat the above steps for each NGC-40 Bridge you wish to install.

**IMPORTANT:** If you wish to install the NGC-40 Bridge in Offline mode, refer to 12.7.6

### 3.11.13 SEARCH NETWORK FOR DEVICES

The Search Network for devices function can assist you in locating your Heat Trace controllers connected on the serial or Ethernet network. This function is available in the Add a New NGC-40 Bridge With Direct Connection and Add a New NGC-10 with Direct Connection screens. When you click the Search for NGC-10 or Search for NGC-40 Bridge button, the Search for NGC Device screen will appear.

![Search Network for NGC-40 Bridge Direct](image)

**Figure 3-20 Search for NGC-40 Bridge Direct**

To locate devices that are connected on the Ethernet network, do the following:

1. For the COM Port selection field, select TCP/IP.
2. Click the Discover Devices button to start the search.

To locate devices that are connected on the serial network, do the following:

1. For the COM Port selection field, select the appropriate COM port.
2. Click the Scan Network button to start the search.

To locate devices that are connected through an Ethernet to Serial gateway, do the following:

1. For the COM Port selection field, select TCP/IP.
2. Check the Enable Scan Network using TCP/IP option
3. Click the Scan Network button to start the search

A list of devices that are found will be displayed in the List of Devices Found list box. You would need to identify the device and select it. Use the Select & Close button to complete the selection. You will be returned to the previous screen which has the necessary information already filled in for you.
The RAYCHEM Supervisor Client software provides the user interface to the RAYCHEM Supervisor Master and Slave servers. Alarm monitoring, data trending and collection, etc. are processed by the Master and Slave servers. All device and plant data information is stored in the database accessed by the Master Server.

The RAYCHEM Supervisor Client software is responsible for retrieving this information from the servers and presenting it to the user. The layout of the main window in RAYCHEM Supervisor Client is therefore critical to providing easy access to system information.

The left side of the main window consists of a Windows Explorer style tree view, where you can expand or collapse a tree node to display the sub-devices (children) of the node. The right side of the main window consists of a Windows style List View, where rows of text items are arranged and sorted by column headings.

The text colors for a node located on the left-hand side tree have a specific significance as shown in the table below:

<table>
<thead>
<tr>
<th>Device Status</th>
<th>Text color of the tree node</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device has new alarms</td>
<td>Bold Red</td>
</tr>
<tr>
<td>Device has acknowledged alarms only</td>
<td>Red</td>
</tr>
<tr>
<td>Device is online and has no alarms</td>
<td>Black</td>
</tr>
<tr>
<td>Device is offline</td>
<td>Grey</td>
</tr>
<tr>
<td>Device is not available</td>
<td>Blue</td>
</tr>
</tbody>
</table>

The main window has a number of “icons” that, when selected, activate specific functions.

Figure 4-1 Client Main window
These functions include:

**Add Devices**
Use this function to install a device into the RAYCHEM Supervisor and GCC databases.

**Configure**
Use this icon to configure the selected item (i.e.: GCC, or HTC).

**Monitor**
Use this icon to monitor the selected HTC.

**Drawings**
Use this icon to bring up the View Drawings window for the selected item (i.e.: GCC, or HTC).

**Copy Configuration**
When you press this icon, the Copy Device Configuration window will display. You can copy an HTC configuration to another HTC or to a template, and vice versa using this feature.

### 4.1 RAYCHEM SUPERVISOR AND MULTI-USER ACCESS

The RAYCHEM Supervisor Master server can service multiple requests from different RAYCHEM Supervisor Clients. In a multiple client installation, it is likely that more than one user will try to change the settings on the same device (i.e.: a GCC or a HTC) at the same time. To manage this type of situation, RAYCHEM Supervisor implements a first come/first served locking mechanism. The first user that accesses a device will obtain a lock on the device. Once this user obtains the lock, RAYCHEM Supervisor will allow only this user to make changes to the device until it is unlocked.

RAYCHEM Supervisor also enforces the rule that a device can only be locked by one user at any given time. The user that owns the lock on a device must release it when they are finished with the device so other users can have access. This locking/unlocking mechanism is managed by RAYCHEM Supervisor automatically and requires no user interaction.

When a conflict occurs (such as when two users try to configure the same HTC at the same time), a warning will display to one of the users that someone has already obtained the lock, and therefore he/she cannot make changes. This Locking/Unlocking mechanism is used in Device Configuration, Trend Group, Batches/Recipes, Scheduled Tasks, and Device Templates.

RAYCHEM Supervisor provides a manual unlock function. The unlock function is meant to be used in special situations when it is necessary to force unlocking (i.e.: changes must be made to an HTC but it is already locked by another user that is not available.). The unlock function should be used carefully since unlocking someone else’s lock on a device can cause that user to lose their changes. The unlock function is found in the function windows that support locking, such as the Trend Groups, Batches/Recipes, Copy Device Configuration windows, or from the Device drop-down menu in the main window.

**IMPORTANT:** To unlock a device, a user must have the Unlock device permission.
4.2 SETTING UP SERVERS

The Server Setup window displays a list of servers installed in your EHT System. The list will have at least one entry, which is the Master server. On this window the following function buttons are available: Ping, Re-Init, Start, Stop, Add, Edit, Remove, and Exit.

1. Ping – This button is used to ping (test the connection to) a server. RAYCHEM Supervisor sends out a ping message to the selected server. If the server is running and it receives the message, it will send back a response. Pinging is used mainly for troubleshooting.

2. Re-Init – This button is used to re-initialize a Slave server. Normally the Master server will automatically synchronize with a Slave server when it starts. If a Slave server is shut down, it will automatically synchronize itself with the Master Server when it restarts. If for any reason you need to manually force a re-synchronization process, this button can be used.

   **IMPORTANT:** You must run the RAYCHEM Supervisor Client on a slave server computer in order to use the Start, Stop, Re-Init buttons for that slave server.

   **IMPORTANT:** By using Remote Desktop on a Slave server, an Administrator can perform maintenance (i.e.: Start, Stop, and Re-init) on the Slave server remotely. This can be useful when the Slave server is in a remote location away from the Master server. The ability to host a Remote Desktop session is only available in Window XP Pro versions.

3. Start – This button is used to start a server. You can start a Slave server manually using this button. After starting a server, you should use the Re-initialize button to re-synchronize the slave server with the master server.

4. Stop – This button is used to stop a server. You can stop a server manually using this button. It is not advisable to stop a Master server since this will stop the entire RAYCHEM Supervisor EHT system.

5. Add – This button is used to add a new slave server. Before you can add a new slave server to your EHT system, the RAYCHEM Supervisor Slave Server software must be installed and running on the slave server computer. If a slave server is not running, you can still add it to your EHT system but you must use the Offline mode for the new slave. Once the Add Slave Server window is displayed, you can edit the fields for the new slave server. Use the browse button to browse for the slave server computer, or if you know the IP address of the slave server computer, enter it in the IP Address field. When you are done with the edits, click OK to save and exit.
IMPORTANT: When using IP addresses instead of a Slave Computer's name, ensure that the IP address is a static IP and not a dynamic IP address. Otherwise, the system connections will have to be re-configured every time the Slave computer establishes a network connection or is restarted.

IMPORTANT: If a slave server is added in offline mode, it must be running and connected to the network before you can place online and access it. To start a slave server, you can use the Start button in the Server Setup window.

6. **Edit** – This button is used to edit a server. You can use it to edit the server name and description.

7. **Remove** – This button is used to remove a slave server. When you remove a slave server, the slave server is removed from your RAYCHEM Supervisor EHT system only. The slave server software still exists in the slave server computer. You can add the slave server back to your EHT system some time later if necessary.

8. **Exit** – This button exits the Server Setup window.

### 4.3 ADD GCC, ADD NGC-UIT AND ADD NGC-40 BRIDGE WINDOWS

Refer to Section 3.11.3 “Installing a 780 Series/GCC-9000 or an AC 2000+” or Sections 3.11.9 to 3.11.10 for a discussion regarding the use of GCC, NGC-UIT and NGC-40 Bridge windows.

### 4.4 ADD HTC WINDOW

To add a new HTC:

1. Click the **Add Device >> Add HTC** button. A window is displayed that allows you to add a new HTC to the 780 Series/GCC-9000 or AC 2000+ you have selected.

   ![Add a New HTC](image)

   Figure 4-3 Add a New HTC

2. Enter an alphanumeric tag in the HTC Tag field to allow easier reference to the controller. The GCC port is the actual port (A - D) to which the controller is physically wired (780 Series/GCC-9000 only – the AC 2000+ supports only port A). Consult the 780 Series/GCC-9000 or the AC 2000+ user's manual for a more detailed discussion of GCC ports.

   The HTC address is the communications address that the program uses to communicate to the controller. Each controller has its own unique address, which may be found on the front label of the controller being installed.

3. Once you enter all of the information, click **OK** to complete the operation or **Cancel** to exit without saving.
4.5 VIEW ALARMS WINDOW

Clicking the View Alarms tab displays a window that lists any alarms. Depending on what you have selected on the left-hand side, alarms are listed for the entire system, a particular device. Also shown is an indication of whether or not the alarms have been acknowledged, and the time when they were logged by the RAYCHEM Supervisor software.

![View Alarms window](image)

Figure 4-4 View Alarms window

When RAYCHEM Supervisor detects a new alarm, it adds the alarm to the list and provides a description of the alarm, the tag name of the device that detected it, the HTC tag of the controller, and the value that triggered the alarm. The software also displays whether it is an alarm or warning, its status, and the time it was detected.

You can acknowledge or reset alarms in two ways. You can use the Alarms drop-down menu, and select Acknowledge or Reset, or you can click on the right mouse button. This will pop up a dialog box giving you the option of Acknowledging or Resetting alarms. Once you have reset the alarm, it is cleared off the list. As in Windows, holding the Shift key down while you select a range of alarms will allow you to reset a whole group at once.

4.6 CONFIGURATION WINDOWS

Clicking the Configure button displays a window that allows you to configure the device you have highlighted. Various tabs allow you to view and change similar parameters.

4.6.1 GCC CONFIGURATION

Consult the 780 Series/GCC-9000 or the RAYCHEM T2000 user’s manual to familiarize yourself with the different alarm and setup parameters to be programmed.
The GCC Tag name displays at the top of the window. To change the tag, click on the Edit Tag button and type in the desired changes. If you wish to switch to a different GCC on the system, click the Down Arrow button, and a drop box will display a list of all installed GCCs. Click on the one you wish to configure.

Figure 4-5 GCC Configuration window

The different tabs allow you to access different setup parameters for the GCC. These include: alarms, global alarm priorities, contact input setup, load shedding, miscellaneous settings, and documentation. For an explanation of load shedding, please consult the 780 Series/GCC-9000 or the RAYCHEM T2000 user’s manual.

The GCC Alarms section allows you to set up the alarms for each GCC. You can toggle between Enable/Disable and Alarm/Warning for each parameter. Refer to the 780 Series/GCC-9000 or the RAYCHEM T2000 user’s manual for an explanation and the use of each alarm.

Select the Global Alarm tab when you wish to define how alarms are processed globally. You may define whether each controller has individual alarm priorities (HTC specific) or global alarm priorities.

Use Individual alarming when you have controllers with requirements that are different than your defined standard.

Use the Global alarming function to define a set of alarming standards, and have these priorities used to process the alarms of any controller designated as global. Any change in the global setting (i.e.: alarm to warning or vice versa) will immediately broadcast to all controllers whose alarm priorities are set as global. Note that this only affects alarm priorities (alarm vs. warning) and not the alarm status (i.e.: enabled or disabled). The status for each alarm can be different for every controller, however the priorities will be predetermined if the controller is set to use the global setting. To change the priority, click on the existing setting and it will toggle to the other state (alarm/warning).

The Contact Inputs tab allows you to configure the operation of the contact inputs located on the back of the 780 Series/GCC-9000. There are four pairs of terminals (for inputs 1 to 4) that you can configure.

You can specify a tag name for each contact by clicking on the tag and typing in the desired name.

For each input alarm you can toggle between enabled and disabled. If you enable an input alarm, you can select the contact for alarm or warning, depending on the priority that you want to place on the event.

You can also specify the normal state of the contact: either normally open or normally closed.
The Load Shedding tab allows you to select whether to enable or disable the load shedding feature.

Click the Load Shed Control box to toggle Load Shedding Control between enable and disable. If you disable the load shedding, the setup for each contact is not available, and you will not be able to program its parameters.

Each of the 780 Series/GCC-9000’s contact inputs may be individually designated for use with load shedding control. Click the “Used For Load Shed” box to toggle the status between enable and disable.

Once you enable the contact, you can configure the alarm setup to either enable or disable. If you enable the alarm, it may be designated as either an alarm or a warning.

The Miscellaneous tab lets you configure the remaining parameters of the 780 Series/GCC-9000, including speaker control, the temperature units displayed on the local display, and the printer port settings. This tab also lets you set both the Alarm and Relay Return Times.

Once you have made the desired changes, click the Apply button to write the changes to that particular controller. There is no “Undo” button, so make sure of the changes before you apply them. The OK button will also write the changes to the device, and then return you to the main window.

![GCC Configuration Report](image)

Figure 4-6 GCC Configuration report

The main window has three buttons that allow you to print reports or view alarms:

The Print button will print a current configuration setup for the selected GCC. If there are multiple sheets, the report window allows you to step through the different pages of the report. You may also zoom in and out, print to the default Windows printer, or export to a file in multiple formats.

The Installed HTCs button will print a complete list of the controllers installed on a selected GCC, including the tag name, communications address, and the physical GCC port to which it is connected.

The Active Alarms button will print a complete list of current GCC alarms.
4.6.2 HTC CONFIGURATION

Consult the appropriate HTC user’s manual for details regarding a controller’s specific features.

The HTC Tag name displays at the top of the window. To change the tag, click the Edit Tag button and type in the desired changes. If you wish to switch to a different HTC on the system, click the Down Arrow button, and a drop box will display a list of all HTCs connected to that GCC. Click the one you wish to configure.

GCC Connected Controllers

The information on the top left section of the window shows you the GCC to which the HTC is connected, the Model and the firmware version for that particular controller.
HTC-Direct Controllers

For HTC-direct connected controllers, the window displays the same information as the GCC Connected Controllers, with the exception of the GCC Tag field. The GCC tag field will show "n/a."

Various tabs allow you to access various setup parameters of the HTC. These include temperature settings, temperature alarm settings, electrical settings, other alarms settings, miscellaneous and documentation parameters.

The **Temperature Settings** tab allows you to configure all of the parameters that relate to temperature (i.e.: Setpoint, TS Control Mode, Switch Control Mode, etc.).

The **Temperature Alarm Settings** tab allows you to configure all of the parameters that relate to temperature alarms. You can enable the temperature alarms that are relevant to your particular application, and toggle between alarm and warning settings.

The **Electrical Settings** tab allows you to configure the parameters that relate to the heater operation (i.e.: voltage and current). You may enable the desired alarms, and program an alarm value for each of these parameters.

The **Other Alarm Settings** tab allows you to enable the balance of the alarms that pertain to the operation of the controller.

The **Miscellaneous** tab allows you to access the auto-cycle and load shedding features.

Once you have made the desired changes, click the **Apply** button to write the changes to that particular controller. There is no "Undo" button, so make sure of the changes before you apply them. The **OK** button will also write the changes to the device, and then return you to the main window.

The main window has three buttons that allow you to:

- Print alarms
- View alarms
- Jump to the Monitor HTC window

The **Print Report** button will print a current configuration setup for the selected controller. If there are multiple sheets, the report window allows you to step through the different pages, zoom in and out, send to the default Windows printer, or export to a file in multiple formats.

The **Active Alarms** button will print out a report showing all of the active alarms for that particular HTC.

The **Monitor** button allows the user to jump directly to the Monitor HTC window.

**TEMPBUS Mode Configuration**

The TEMPBUS Mode parameter is located next to the TS Control Mode parameter in the Temperature Settings tab. This parameter is a drop box with three selections: 'Not Used', 'Master', and 'Slave'. Please consult the RAYCHEM 920 Series HTC user's manual for details on the operation of these modes.

**IMPORTANT:** The TEMPBUS Mode parameter is enabled only if the controller you are configuring supports the TEMPBUS feature. If the controller is connected to a GCC, the GCC firmware must be version V3.12 or higher.

If your particular application does not require TEMPBUS Mode operation, you should set the TEMPBUS Mode parameter to 'Not Used'. Whenever you change the TEMPBUS Mode parameter, RAYCHEM Supervisor will automatically update the External Input Setup and External Output Setup fields. These fields display in the Miscellaneous tab.
**IMPORTANT:** The External Input Setup and External Output Setup are common parameters for a 2 point 920 Series controller. Changing these parameters may affect the operation of the other control point!

**ATC Mode Configuration**

The ATC Mode parameter is located next to the TS Control Mode parameter in the Temperature Settings tab. This parameter is a drop box with three selections: 'Process', 'Master', and 'Slave'. Please consult the RAYCHEM T2000 controller technical manual for details on the operation of these modes.

**IMPORTANT:** The ATC Mode parameter is available only if the controller you are editing supports the ATC features and the GCC firmware is version V2.19 or higher. Controllers that support ATC operation include the RAYCHEM CM2000 and CM2000+ controllers with firmware version V2.35 or higher.

If your particular application does not require ATC Mode operation, you should set the ATC Mode field to 'Process'.

### 4.6.3 NGC-UIT CONFIGURATION

Consult the NGC-30 Programming Guide (H58186) to familiarize yourself with the different alarm and setup parameters that may be programmed.

The UIT Tag name is displayed at the top of the window. To change the tag, click the Edit Tag button and type in the desired changes. If you wish to switch to a different UIT on the system, click the Down Arrow button, and a drop box will display a list of all installed UITs. Click on the one you wish to configure.

![NGC-UIT Configuration window](image)

Figure 4-9 NGC-UIT Configuration window

The parameter list on the left-hand side of the window allows access to different setup parameters for the UIT. These include configuration of the output relays, the time/date, and various alarm filter time settings.

### 4.6.4 NGC-30-CRM/CRMS CONFIGURATION

The UIT allows the user to create individual control circuits by connecting an output device (NGC-30 or 5GF-C output for example) and temperature sensing devices (RMMs, NGC-30 RTD inputs, etc.) together to form a "control circuit." This mechanism replaces the traditional hard-wiring of
RTDs to controllers, and allows the user to connect the inputs and outputs of various devices together using software configuration.

![Figure 4-10 NGC-30-CRM/CRMS Configuration](image)

The parameter list on the left-hand side of the window allows you to access different settings for the NGC-30-CRM/CRMS controllers. These include: circuit and RTD setup, Temperature alarms and set points, heater current and ground fault set points, use of inputs, maintenance data, and PASC configuration. Refer to the *NGC-30 Programming Guide* (H58186) for details regarding the use of each feature and its valid ranges.

Once you have made the desired changes, click the **Apply** button to write the changes to that particular controller. There is no “Undo” button, so make sure of the changes before you apply them. The **OK** button will also write the changes to the device, and then return you to the main window.

![Figure 4-11 Circuit Configuration report](image)

The main window has three buttons that allow you to print reports or view alarms:
The Print Report button prints a current configuration setup for the selected UIT control circuit. If there are multiple sheets, the report window allows you to step through the different pages of the report. You may also zoom in and out, print to the default Windows printer, or export to a file in multiple formats.

The Active Alarms button prints a complete list of current UIT Circuit alarms.

![Image of UIT Device List report]

**Figure 4-12 UIT Device List report**

### 4.6.5 NGC-20 CONFIGURATION

Additional information regarding the different alarm and setup parameters that may be programmed can be found in the NGC-20 Handheld Programming Guide.

The NGC-20 Tag name is displayed at the top of the window. To change the tag, click on the **Edit Tag** button and type in the desired changes. If you wish to switch to a different UIT on the system, click the Down Arrow and select another NGC-20.
The parameter list on the left-hand side of the window allows you to access different settings for the NGC-20 controllers. These include: Temperature Settings, Temperature Alarm Settings, Other Alarm Settings, Electrical Settings, Miscellaneous Settings and Safety Limiter Settings.

Once you have made the desired changes, click the **Apply** button to write the changes to that particular controller. There is no "Undo" button, so make sure of the changes before you apply them. The **OK** button will also write the changes to the device, and then return you to the main window.

### 4.6.6 NGC-40 BRIDGE CONFIGURATION

Consult the NGC-40 Programming Guide to familiarize yourself with the different alarm and setup parameters that may be programmed.

The Bridge Tag name is displayed at the top of the window. To change the tag, click the **Edit Tag** button and type in the desired changes. If you wish to switch to a different NGC-40 Bridge on the system, click the Down Arrow button, and a drop box will display a list of all installed NGC-40 Bridge. Click on the one you wish to configure.
The parameter list on the left-hand side of the window allows access to different setup parameters for the NGC-40 Bridge.

**4.6.7 NGC-40 HTC/HTC3 CONFIGURATION**

Additional information regarding the different alarm and setup parameters that may be programmed can be found in the NGC-40 Programming Guide.

The NGC-40 HTC/HTC3 Tag name is displayed at the top of the window. To change the tag, click on the **Edit Tag** button and type in the desired changes. If you wish to switch to a different NGC-40 HTC/HTC3 on the same CAN network click the Down Arrow and select another NGC-40 HTC/HTC3.

The parameter list on the left-hand side of the window allows you to access different settings for the NGC-40 HTC/HTC3 controllers. These include: Temperature Settings, Temperature Alarm Settings, Other Alarm Settings, Electrical Settings, Miscellaneous Settings and Alarm Latching Settings.
Once you have made the desired changes, click the **Apply** button to write the changes to that particular controller. There is no “Undo” button, so make sure of the changes before you apply them. The **OK** button will also write the changes to the device, and then return you to the main window.

### 4.6.8 NGC-40 IO CONFIGURATION

Additional information regarding the different alarm and setup parameters that may be programmed can be found in the NGC-40 Programming Guide.

The NGC-40 IO Tag name is displayed at the top of the window. To change the tag, click on the **Edit Tag** button and type in the desired changes. If you wish to switch to a different NGC-40 IO on the same CAN network, click the Down Arrow and select another NGC-40 IO.

![NGC-40 IO Configuration](image)

Figure 4-16 NGC-40 IO Configuration

The parameter list on the left-hand side of the window allows you to access different settings for the NGC-40 IO modules. These include: Temperature Settings, Temperature Alarm Settings, Other Alarm Settings, Electrical Settings, Miscellaneous Settings and Safety Limiter Settings.

Once you have made the desired changes, click the **Apply** button to write the changes to that particular controller. There is no “Undo” button, so make sure of the changes before you apply them. The **OK** button will also write the changes to the device, and then return you to the main window.

### 4.6.9 ELEXANT 4010I/4020I CONFIGURATION

Additional information regarding the different alarm and setup parameters that may be programmed can be found in the Elexant 4010i/4020i Programming Guide.

The Elexant 4010i/4020i Tag name is displayed at the top of the window. To change the tag, click on the **Edit Tag** button and type in the desired changes. If you wish to switch to a different Elexant 4010i/4020i on the system, click the Down Arrow and select another Elexant 4010i/4020i.
The parameter list on the left-hand side of the window allows you to access different settings for the Elexant 4010i/4020i controller. These include: Temperature Settings, Temperature Alarm Settings, Other Alarm Settings, Electrical Settings, Miscellaneous Settings and Safety Limiter Settings.

Once you have made the desired changes, click the Apply button to write the changes to that particular controller. There is no "Undo" button, so make sure of the changes before you apply them. The OK button will also write the changes to the device, and then return you to the main window.

4.7 MONITOR BUTTON

RAYCHEM Supervisor Client provides monitoring functions to allow viewing of current and maintenance data from your field device(s) in real time. You can monitor a single device or you can monitor multiple devices at once.

4.7.1 MONITORING A SINGLE DEVICE

Clicking the Monitor icon displays a window showing the present operating parameters of the particular HTC or NGC-20 that you have selected. Tabs allow you to quickly jump to different groupings of real-time data. The data is displayed both in scaled bar graph format as well as numerically. The numeric reading will be in red if the value is in alarm (i.e.: above or below the alarm setpoints). A small bitmap in the upper right corner provides a visual display of the type of controller you are communicating with (i.e.: NGC-20, 910, 920, etc.). Click the OK button to return to the main window.

The Monitor Interval field controls how often the software polls the controller for new data. The smaller the number, the more often the software will communicate with the HTC, and the more time will be used requesting data that may not change very often. A typical number would be around 10 seconds.
The Monitor window also allows you to change the tag of the selected controller by clicking on the **Edit** button. The upper left portion of the window indicates which GCC port the controller is connected to, its address, firmware version and how many active alarms are present.

The Monitor window includes four buttons that allow you to:

Print an active alarm report

Test the tracing

Jump to the appropriate Configuration window

Print a Monitor report

Figure 4-17 HTC Monitor window

The **Active Alarms** button prints out a report showing all of the active alarms.

The **Test Trace** button allows you to temporarily override the temperature control, and turn the tracing on for a specified time period. This will allow you to monitor the heater current, voltage, etc., while the test is being conducted.

The **Configure** button allows you to jump directly to the configuration window for that controller.

The **Print Report** button prints out a report showing the process variable, max/min temperature, and maintenance values for this HTC.

### 4.7.2 Monitoring Multiple Devices

You can monitor several controllers at once. The Monitor Devices window provides this functionality. In the Client’s main window, use the Device drop-down menu and select **Monitor Multiple Devices**. Once the Monitor Multiple Devices window is displayed, you can use the **Add** button to add devices you want to monitor to this window, or if you have saved a previous monitor session, you can use the **Load** button to load it to the window.
Adding Devices to Monitor

You must select devices to monitor each time you bring up the Monitor Multiple Devices window. To select devices, click the Add button on the Monitor Multiple Devices window. Once the Add Monitor Multiple Devices window displays select the device(s) to monitor.

Each device can have a different scan interval. You can set the scan interval with the Default Interval drop-down box. When you select a device, the Default Interval will be assigned to this device. In any case, you can always change the scan interval at a later time.

Once you have completed your selection, click OK to exit the Add Monitor Multiple Devices window. This will bring you back to the Monitor Multiple Devices window. Depending on the scan interval for each device, you will not see an update until the assigned interval has elapsed.

Removing Devices to Monitor

To remove a device from the Monitor Multiple Devices window, select the device to remove. Click the Remove button. You will be prompted to confirm your action. Click Yes to continue with the remove otherwise click No.

Loading a Monitor Device Session

You must have saved a Monitor Device session before you can use the Load button to reload a session. Clicking the Load button will cause the Load Monitor Session dialog box to display. Select the previously saved monitor session then click Load to load and exit this window.
Figure 4-19 Load Monitor Devices Session

**Saving a Monitor Device Session**

Once you have added devices to your Monitor Multiple Devices Window, you can save the current list to the system database for later use. Clicking the **Save** button will cause the Save Monitor Session dialog box to display. Enter a name for the monitor session then click **Save** to save and exit.

Figure 4-20 Save Monitor Device Session

**Test Trace, Setpoint change, Reports, and Resets**

To perform any of these functions: Test Trace, Setpoint change, Reports, or Resets, you must select a device. After you have selected a device, use the right mouse click to bring up the context menu. Select the function to perform.

**4.8 DATABASE SYNCHRONIZATION**

Since a controller may be added into the EHT System from the RAYCHEM Supervisor program, from the front panel of a GCC, or by using an NGC-UIT, it is possible that a discrepancy can occur in RAYCHEM Supervisor’s list of installed devices.

Every time RAYCHEM Supervisor starts up, it compares its database to that of any installed GCCs or NGC-UIts, or NGC-40 Bridges. Should a mismatch occur, the system generates a “Mismatch HTC list” error. To correct this problem, select the Compare HTC Lists option under the Device->GCC or Device->NGC-UIT or Device->NGC-40 menu (top menu bar). The program will
then compare its installed HTC list with the GCC or NGC-UIT or NGC-40 Bridge. This action should also be selected periodically if you never shut down your program, or run it for extended periods of time to ensure synchronization between RAYCHEM Supervisor and any installed GCCs, NGC-UITs and NGC-40 Bridges.

If the software detects a difference between the lists, it will automatically update its database. RAYCHEM Supervisor will notify you that it has performed an update using a notification balloon.

![Main window with Notification balloon.](image)

The best way to prevent this condition from occurring is to make sure that all HTC additions and deletions are performed from the RAYCHEM Supervisor program rather than from another device.

### 4.8.1 DATABASE SYNCHRONIZATION FOR AN AC 2000+

The AC 2000+ alarm/communications interface card keeps track of changes that occur on any individual port. For example, you make changes to an AC 2000+ through the Local port; the changes will be reflected at the AC 2000+ Remote port.

If RAYCHEM Supervisor is connected to the Remote port, it will periodically poll the AC 2000+ to get the status of any changes. If changes are identified, RAYCHEM Supervisor will automatically perform a database synchronization sequence to ensure that all devices have the same information.

Automatic database synchronization manages synchronization due to the following events:

- New HTC(s) added to the AC 2000+
- HTC(s) deleted from the AC 2000+
- Configuration change to a AC 2000+
- Configuration change to an HTC in a AC 2000+

When these events occur, RAYCHEM Supervisor will reload its HTC installation list, GCC configuration data, or HTC configuration data and update its database. RAYCHEM Supervisor will notify the user when this occurs.

These synchronization events are recorded in the history log database. To view history logs, refer to Section 5.2 “Viewing History Logs.”

The following popup message will also display when the GCC Configuration window displays and a change to the AC 2000+ was detected by RAYCHEM Supervisor. A similar message box displays for HTCs as well. When this occurs, select “Use the current changes and overwrite the data in the device” to have RAYCHEM Supervisor resynchronize (recommended).
In cases where controllers have been deleted in the AC 2000+ but they still exist in the RAYCHEM Supervisor database, RAYCHEM Supervisor will automatically replace the first character of the device tag with a "?". To remove these completely from the RAYCHEM Supervisor database, use the "Remove HTC" function.

### 4.8.2 DATABASE SYNCHRONIZATION FOR AN NGC-UIT AND NGC-40 BRIDGE

An NGC-UIT and NGC-40 Bridge keeps track of changes that occur internally. If RAYCHEM Supervisor is connected to a NGC-UIT or NGC-40 Bridge, it will periodically poll the NGC-UIT or NGC-40 Bridge for the status of changes. If changes are identified, RAYCHEM Supervisor will automatically perform a database synchronization sequence.

Automatic database synchronization manages synchronization due to the following events:
- New Circuits or NGC-40 modules added to the NGC-UIT or NGC-40 Bridge
- Circuit(s) or NGC-40 module(s) deleted

When these events occur, RAYCHEM Supervisor will attempt to synchronize its database with the NGC-UIT or NGC-40 Bridge. RAYCHEM Supervisor will notify the user when this occurs.

These synchronization events are recorded in the history log database. To view history logs, refer to Section 5.2 “Viewing History Logs.”

### 4.9 USING THE DEVICE CONFIGURATION LOADER

The Device Configuration Loader is used to retrieve configuration settings for all of the field devices such as HTCs. If you run the Device Configuration Loader and it completes successfully, RAYCHEM Supervisor will have a copy of the current settings for each field device stored in its database.

#### 4.9.1 LOAD HTC CONFIGURATIONS

Use the System drop-down menu in the Client’s main window and select Load Device Configurations. The Load HTC Configuration window will display. On this window, a list of Host Devices (i.e.: GCCs, NGC-UITs, or NGC-40 Bridges) display in the left window pane. If you select a host device, the right window pane shows any subordinate (child) devices belonging to the host device (i.e.: HTCs, Circuits, NGC-40 Modules). If you check the Load Unloaded Device Only checkbox then only the child devices that are not loaded will display in the list. If you check the All
Devices in User’s Group checkbox, then all host devices displayed will be selected. The device list on the right window pane will include all child devices for each of the host devices.

To start the configuration loader, click the Start button. A configuration loader task is created in the RAYCHEM Supervisor EHT system, and is assigned to run on the Master and Slave Servers. At any time, the user can view the running status of this configuration loader task using the View Device Configuration Loaders window. If this task is completed, then it is removed from the task list and will no longer display on the View Device Configuration Loaders window. When a configuration loader task is running, you can choose to cancel this task with the cancel button.

**IMPORTANT:** A configuration loader task will continue to run until all selected devices are loaded. If there are devices that cannot be loaded, you may stop the configuration loader task manually. Otherwise, RAYCHEM Supervisor will continue to attempt to load any unloaded devices up to 10 times.

**IMPORTANT:** An unloaded device will have its device model and firmware versions displayed as 0.

### 4.9.2 VIEW DEVICE CONFIGURATION LOADERS

To view currently running configuration loader tasks, use the System drop-down menu in the Client’s main window and select View Device Configuration Loaders. Once the View Configuration Loader window displays, you can select a configuration loader task and view the list of the loaded/unloaded devices. On this window you can stop a configuration loader task using the Stop button, or you can refresh the window with the Refresh button. To exit this window, use the Close button.

### 4.10 DEVICE COMPARE FUNCTION

Every time RAYCHEM Supervisor starts up, it compares the list of HTCs stored in its database with that of any installed in connected GCC(s), NGC-UIT(s) and NGC-40 Bridge(s). Should a mismatch occur, the system generates a "Mismatch HTC list" error. To correct this problem, select the Compare HTC list option under the Device, GCC drop-down menu, or the Compare UIT option under the Device, NGC-UIT drop-down menu, or the Compare Bridge option under the Device, NGC-40 Bridge drop-down menu. RAYCHEM Supervisor will then compare its installed HTC/Circuit/Module list with the GCCs or NGC-UITs or NGC-40 Bridges. This action should also be selected periodically if you never shut down your EHT system, or run it for extended periods of time to ensure synchronization between RAYCHEM Supervisor and any installed GCCs, NGC-UITs, and NGC-40 Bridges.

If the software detects a difference between the lists, it will bring up a window showing these differences, and allow you to select which source you wish to use as the correct one (refer to Figure 4-23 Compare Installed HTC List). The information will then be copied over to the incorrect or incomplete list. If you are copying from the GCC or NGC-UIT or NGC-40 Bridge, and the program is adding more controllers to the RAYCHEM Supervisor database, you will need to run the Load Device Configuration to copy the configuration of the new controllers(s) into RAYCHEM Supervisor database.
4.10.1 COMPARE HTC CONFIGURATIONS

The Compare HTC Configurations screen can be used to identify differences between the configuration settings in the system database and the field device that it represents. The differences are displayed in the list on the screen. The browse button beside the Device Tag field can be used to select a different device, for example if the compare is between a selected device in the system database and a different field device that are of the same device type. This compare tool can only identify differences. The onus will be for the user to update and synchronize the 2 configurations if discrepancies are found.
4.11 COPY HTC CONFIGURATIONS

Clicking the **Copy Configuration** icon will display the “Copy Device Configuration” dialog box. Use this dialog box to copy the configuration of an HTC to another HTC or to another group of HTCs.

The “Copy Device Configuration” may also be used to backup an HTC configuration to a database template. You can then copy the template back to the HTC in the future as required. Once you create a template, it can also be edited. The template includes all of the configuration information such as Temperature, Temperature Alarm, Electrical, Alarm, Miscellaneous, and Drawing settings.

**IMPORTANT:** You can only copy the configuration of an HTC to another if the destination HTC is the same model and its firmware version is the same or higher. This applies to copying a template to an HTC as well. RAYCHEM Supervisor will only display a list of valid destination HTCs when using the copy configuration function.

![Copy Device Configuration window](image)

**Figure 4-25 Copy device Configuration window**

The Device Copy Configuration window allows you to perform the following:

- Copy HTC to HTC
- Copy HTC to Template
- Copy Template to HTC
- Edit Templates

4.11.1 COPYING DEVICE TO TEMPLATE

Use this when you want to save a copy of an HTC configuration to a template file for future use.

1. Select the Copy Device to Template operation.
2. Select an HTC in the Device Selection box. Use the **Browse** button to display the Device selection window.
3. In the Template Selection box, type in the desired template name or select an existing template.
4. Click the **Start** button to start the copy process.
4.11.2 COPYING DEVICE TO DEVICE
Use this when you want to copy an HTC configuration directly to one or more HTCs.

1. Select the Copy Device to Device operation.
2. Select an HTC in the Copy From Device Selection box. Use the Browse button to display the Device selection window.
3. In the Copy To Device Selection box, use the Add button to add in an HTC. Use the Remove button to remove an HTC from the list.
4. Click the Start button to start the copy process.

4.11.3 COPYING TEMPLATE TO DEVICE
Use this when you want to copy an HTC configuration that was previously saved as a template to one or more HTCs.

1. Select the Copy Template to Device operation.
2. Select a Template from the Copy From Template Selection box.
3. In the Copy To Device Selection box, use the Add button to add in one or more HTCs. Use the Remove button to remove an HTC from the list.
4. Click the Start button to start the copy process.

**IMPORTANT:** The template name is not case sensitive.

4.11.4 EDITING A TEMPLATE
Once you create a template, you may edit it and save the changes to the same or to a different template.

1. Select the Template operation.
2. Select a template.
3. Click the Edit button. The HTC Configuration window displays. You may edit the configuration fields as you would for any HTC.
4. To save the configuration, click the OK button.

4.11.5 REMOVING A TEMPLATE
When you no longer require a template, you can remove it from the database.

1. Select the Template operation.
2. Select a template.
3. Click the Remove button. You will be prompted to confirm the operation. Click Yes to continue with the deletion.

**IMPORTANT:** Once you removed a template, it cannot be recovered. Before you remove a template, make sure that it is safe to do so.

4.12 MISCELLANEOUS FEATURES
RAYCHEM Supervisor provides many more features in addition to the core features. This section describes these features in detail.

4.12.1 DEVICE DRAWINGS
You can associate any number of drawings with a device. You can then view these drawings with the viewer you have specified.

**Associate Drawing with a Device**
Select a device. From the Device drop-down menu, select Drawings. The Device Drawings window will display. Click the Add button to associate a drawing with the selected device. You should
specify a type for the drawing so that you can identify a specific viewer that will display that type of drawing. You can set up drawing types in the System Preference window (refer to “Specifying Drawing Views,” which follows).

![Device Drawings](image)

**Figure 4-26 Device Drawings**

**Add Device Drawing**

<table>
<thead>
<tr>
<th>Drawing Type:</th>
<th>Use Windows File Association</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Path:</td>
<td></td>
</tr>
</tbody>
</table>

*Note: For viewing from different PCs, drawings should be in a network shared folder.*

![Add device drawings](image)

**Figure 4-27 Add device drawings**

**Specifying Drawing Viewers**

You can specify a specific viewer for each type of drawing. Each RAYCHEM Supervisor Client has its own drawing viewer settings. The viewer should be installed at the local computer.

To specify a viewer, do the following:

1. Select Drawing Viewers from the Client drop-down menu. The Drawing Viewer Setup window will display.
2. Select a drawing type and click the **Set Viewer** button. The Specify Drawing Viewer window displays.
3. Give a descriptive name to your viewer, and specify the path in the details box beneath the subject.
4. Click **OK** to save and exit.
4.12.2 EMAIL NOTIFICATION

RAYCHEM Supervisor may be configured to send out an email when an alarm occurs. Before you decide to use this feature, you must first ensure that an SMTP mail server is available in your office or plant, as this is required for this feature to work.

If an SMTP mail server is available, you can proceed to set up a user account that may be used by RAYCHEM Supervisor. You do not have to set up a user account if your RAYCHEM Supervisor is sending email within the company's intranet. If RAYCHEM Supervisor is required to send email outside the company's intranet, then you will need a user account and password. Contact your IT department for details.

To setup the SMTP Server settings in RAYCHEM Supervisor, bring up the System Preferences window (refer to Section 3.5.1 "Setting System Preferences – General Settings"). Enter the SMTP Server, SMTP user, and password fields that were given to you by your IT department. Save the settings with the Apply or OK button.

To setup the Alarm Notification Email addresses, bring up the Alarm Notification window (refer to Section 3.5.2 "Setting System Preferences – Alarm Email Notification Settings"). Follow the instructions in Section 3.5.2 to add the appropriate email addresses.

4.12.3 AUTO ALARM ACKNOWLEDGEMENT

In some situations (such as during Plant startup), you may want to ignore alarm notifications from RAYCHEM Supervisor until the system is commissioned. You can have RAYCHEM Supervisor automatically acknowledge alarms for you so that you will not be bothered with Alarm notifications. Enable the Auto Alarm Acknowledgement feature and enter the duration for this feature to remain active. Refer to Section 3.5.3 "Setting System Preferences – Other Alarm Settings" for details on how to set up Auto Alarms Acknowledgement.

4.12.4 STEAM OUTS

Steam out is a special feature in RAYCHEM Supervisor that applies to HTC and HTC-direct devices only. The Steam out feature raises the control setpoint of a device to a preset value for a specified period of time. After the time has expired, the control setpoint is returned to its previous value. This steam out period is preset by the user. Refer to Section 3.5.7 "Setting System Preferences – Steam Out Settings" for details on how to set up Steam outs.

Before you can set steam out parameters for an HTC or HTC-direct device, you must enable the Steam out setting for the device. This setting can be found in the Device Properties – refer to Section 4.12.7 "Device Properties" for more information.
Once an HTC or HTC-direct device is enabled for Steam out, you can start a Steam out using the Tools drop-down menu and selecting Steam out. Navigate the Device Selection tree and select the device. Click the **Click to steam out/reset** checkbox to start. Once the steam out has started, you can do a reset by clicking the **Click to steam out/reset** checkbox again. Resetting a steam out returns the control setpoint of the HTC to the previous value. To close the Steam Out windows, click the **Close** button.

RAYCHEM Supervisor maintains a list of all the Steam outs currently running. You can view or reset a steam out using the Current Steam Out window. In the Client’s main window, use the Tools drop-down menu and select the Current Steam Outs menu item. Choose the steam out you want to reset and click on the **Click to steam out/reset** checkbox.

![Steam Out Window](image)

**Figure 4-29 Steam Out**

### 4.12.5 USER MESSAGES

RAYCHEM Supervisor supports a simple user messaging system that can send a warning message to all users when it is about to shut down. A RAYCHEM Supervisor user can also send and receive messages to other RAYCHEM Supervisor users. The user messaging system provides the foundation for the User Reminders which is described in Section 4.12.6 “Operator Notes.”

To send a message to another user, use the View drop-down menu and select Message Window. Once the Message Window is displayed, type your message in the Message box, select a user with the Send to drop-down box. Finally, click the **Send** button to send the message.

Note that the Send to drop-down box will display a list of users that are presently logged in.
OPERATOR NOTES

RAYCHEM Supervisor allows you to create notes for each device such as a GCC or HTC. Similar to alarms, each note is linked to a specific device. Each note has a status that indicates if it is active or not. This status provides a way to organize and display them to the user. All notes that are active require further attention, and all notes that are not active are considered closed.

IMPORTANT: When you delete a device such as a GCC or an HTC, all notes linked to that GCC or HTC are deleted as well.

Generally, all users may view and print notes. To create a new note, modify the active status, or add comments to a note, the user must have Create Notes permission. To delete notes, a user must have Delete Notes permission.

Creating a New Note

A note consists of:

- A subject
- A tag
- The date time the note was created
- The note creator’s user name
- Note details

When you create a new note, RAYCHEM Supervisor will automatically add the device tag, the current date time, and your user name to the note. You must fill in the subject and note details.

To create a note, do the following:

1. Select a device then right click on the mouse to display a pop-up menu.
2. Select the Create Note option. The Create Device Note window displays (refer to Figure 4-31 Create a New Note).
3. Type in a subject for the note and fill in the details box beneath the subject. If you need to send a Reminder to other users click the Reminder button.
4. Select the user to send the reminders to (for more information on User Reminders, refer to "User Reminders," which follows).
5. Click OK to save and exit.
User Reminders

User Reminders in RAYCHEM Supervisor uses the functionality of both the User Messaging system and Operator Notes. User Reminders are useful in situations when you want to create a note for several users, and you want to notify them immediately to read the note.

To accomplish this, you have to create a new note. Once you’ve completed your edits, click the Reminders button and select the users that you want to remind. Finally, click the OK button to save the note and send the reminders.

Once the note is saved, a reminder will be sent to the selected users. If the selected users are currently logged in, the Message Window will pop up on their window immediately. If the selected users are not logged in, the next time they log in, the Message Window will pop up immediately and they will be notified to view the note.

After the user has viewed a reminder, the user should dismiss the reminder to remove it from the database. If a reminder is not dismissed, then the user will be notified each time they log in.

Viewing a Note

Once you create a note, other users can view it and/or add comments to it.

To view a note

1. Bring up the notes list by clicking the View Notes tab.
2. Once the note list is displayed, double click on the note using the mouse to view it. In the list, all notes linked to the currently selected device are displayed. The display will be blank if no notes are linked to the particular device that is selected.
3. Double click the left mouse button on the note you want to view to display a pop-up menu.
4. Select the View Note option. The View Note window will display allowing you to update the active status, add comments to the note, print the note, or create a new note.

5. To save your changes, click the OK button. To exit without saving, click the Cancel button.

Removing a Note

You must have Delete Notes permission to delete notes.

To delete a note

1. Bring up the notes list by clicking the View Notes tab.
2. Select the note(s) to delete and right click on the mouse to display a pop-up menu (to select multiple notes, use the Shift or Ctrl key and use the mouse to select multiple notes).
3. Select the Delete option – you will be prompted to confirm the deletion.
4. Click Yes to continue with the delete or Cancel to abort.

IMPORTANT: Once a note is removed, it cannot be recovered.

4.12.7 DEVICE PROPERTIES

The Device Properties window provides general and internal status information for a device.

The Plant documentation tab includes the plant documentation. The user can edit the Breaker Panel, Breaker Number, Controller Panel and Controller Number for a device if the user owns the lock for this device (Refer to Section 4.1 “RAYCHEM Supervisor and Multi-user Access”).

In the Miscellaneous tab, the user can set the drawings, Device Priority, enable Steam out, and change Device Communications settings. The user must own the lock before he/she can save the changes.

The Device Communication Settings provide some flexibility for the Administrator to control the behavior of how RAYCHEM Supervisor communicates to field devices. These parameters include the number of retries and the transmit delay. Under normal circumstances, the number of retries and transmit delay already defined for each COM port is sufficient for most device communications. However in some cases where wireless devices are used, these settings may need to be modified. A unique combination of settings may be configured for each device.

Figure 4-33 Device Properties
4.128 ADMINISTRATIVE TOOLS

The Administrative Tools contains a variety of useful functions, for example an administrator can view which devices are currently locked and by whom, the list of currently logged in users, and all devices that are currently offline. In addition there are system maintenance functions such as setting all the devices in the system either Offline or Online, and importing plant documentation from an Excel spreadsheet. Setting the EHT system Offline may be useful in situations when the communication port needs to be free so that other applications can access them. This is because RAYCHEM Supervisor takes control of the communication ports while it runs in the background as in a Windows Service. Unless the Service is shut down, Supervisor remains running at all times. The Import plant documentation from an Excel spreadsheet may be useful when working with Plant documentation. This allows you to create plant documentation with Excel then import them into Supervisor.

Locked Devices

In the Client’s main window, use the Tools drop-down menu and select Administrative, then Locked devices. The Locked Devices window displays and shows the currently locked devices.

Logged In Users

In the Client’s main window, use the Tools drop-down menu and select Administrative, then Logged in users. The Logged in Users window displays and shows the list of users that are presently logged in.

Set EHT System Offline and Online

If RAYCHEM Supervisor is setup to connect to field device(s) via a COM port, this COM port will be used by RAYCHEM Supervisor and it will not be available for other applications until RAYCHEM Supervisor stops running. The Set EHT System Offline function will tell RAYCHEM Supervisor to release the COM port, by first setting all devices in the system to Offline. The Set EHT System Online function will reverse this operation thus returning the devices back Online. This eliminates the need to shut down RAYCHEM Supervisor in situations where the user lacks permission to stop a Windows Service or have access to the Master Server computer where RAYCHEM Supervisor is currently running on.

In the Client’s main window, use the Tools drop-down menu and select Administrative, then Set EHT System Offline or Online. A confirmation prompt displays and you must confirm your action before the operation is carried out.

Import Excel File

The Import Excel file will import plant documentation from a CSV file into RAYCHEM Supervisor. In the Client’s main window, use the Tools drop-down menu and select Administrative, then Import Excel File. The Import Excel file screen displays. Follow the on-screen instructions to complete the import.
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DeviceTag</td>
<td>This is the tag of the Circuit or device. This column MUST exist since it is used as the key for matching the Excel data row to a device in the RAYCHEM Supervisor system database.</td>
</tr>
<tr>
<td>Location</td>
<td>The name of the Location this DeviceTag is assigned to.</td>
</tr>
<tr>
<td>LineEquipNum1</td>
<td>The name of the Line Equipment Number this DeviceTag is assigned to. There can be up to 5 different Line Equipment Numbers assigned to a DeviceTag.</td>
</tr>
<tr>
<td>LineEquipNum2</td>
<td>The name of the Line Equipment Number this DeviceTag is assigned to. There can be up to 5 different Line Equipment Numbers assigned to a DeviceTag.</td>
</tr>
<tr>
<td>LineEquipNum3</td>
<td>The name of the Line Equipment Number this DeviceTag is assigned to. There can be up to 5 different Line Equipment Numbers assigned to a DeviceTag.</td>
</tr>
<tr>
<td>LineEquipNum4</td>
<td>The name of the Line Equipment Number this DeviceTag is assigned to. There can be up to 5 different Line Equipment Numbers assigned to a DeviceTag.</td>
</tr>
<tr>
<td>LineEquipNum5</td>
<td>The name of the Line Equipment Number this DeviceTag is assigned to. There can be up to 5 different Line Equipment Numbers assigned to a DeviceTag.</td>
</tr>
<tr>
<td>ControllerPanel</td>
<td>The name of the Controller Panel this DeviceTag is assigned to.</td>
</tr>
<tr>
<td>ControllerPosition</td>
<td>The name of the Controller Position this DeviceTag is assigned to.</td>
</tr>
<tr>
<td>BreakerPanel</td>
<td>The name of the Breaker Panel this DeviceTag is assigned to.</td>
</tr>
<tr>
<td>BreakerNumber</td>
<td>The name of the Breaker Number this DeviceTag is assigned to.</td>
</tr>
<tr>
<td>DrawingType</td>
<td>The name of the Drawing Type. If the Drawing type is blank, no changes are made.</td>
</tr>
<tr>
<td>DrawingPath</td>
<td>The path of the drawing including the name of the drawing file. If the DrawingPath is empty, no changes are made.</td>
</tr>
<tr>
<td>SteamoutEnable</td>
<td>This option enables or disables steamout for this deviceTag. The value can be Yes/No or True/False. If the SteamoutEnable is empty, no changes are made.</td>
</tr>
<tr>
<td>DevicePriority</td>
<td>This option sets the device priority for this device Tag. The value is a number from 0 to 7. If the DevicePriority is empty, no changes are made.</td>
</tr>
</tbody>
</table>

4.12.9 AUTOMATIC LOGOUT

The Client software is programmed to detect mouse or keyboard activity. A timer is set to automatically log off the current user if there is no activity for a specific period of time. Once mouse or keyboard activity is detected, the timer is reset and the interval restarts.
The default timeout is set for 30 minutes, and this may be changed by using the System menu selection, choosing the Preferences..., then selecting the Miscellaneous tab and modifying the "Auto Logout Interval" parameter. To disable the Auto Logout feature, set the time out interval to zero. Note that this is a global parameter and applies to all users.

![Auto Logout Interval Setting](image1)

If a specific computer always needs to be logged into the system (for example a monitoring workstation in a control room), the Auto logout feature may be disabled by creating a user with the appropriate permissions and disabling the "PerformAutoLogout" permission. This will cause the Auto Logout to be ignored when the timer expires. It is highly recommended that only a restricted set of permissions be allowed on any permanently connected user.

![User Account Information Settings](image2)

**4.12.10 DIAGNOSTIC FUNCTIONS**

The Diagnostics options are intended for troubleshooting purposes. The options available are logging of communication activities and alarm filter for NGC-40 Devices.

In the Client's main window, use the Tools drop-down menu and select **System Preferences**, then navigate to the Miscellaneous tab. The Diagnostic options can be accessed from this screen.
Log Communications Activities

This option enables the communication activities logger in RAYCHEM Supervisor. The communication activities are saved to a file in the c:\temp folder of the Master Server computer (i.e. c:\temp/SupervisorCommLog.txt). The recorded data include a time stamp and the communication messages used. This can be a query message send from RAYCHEM Supervisor or a Response message received from a field device. The contents of the log file is shown in the picture below. The data that is enclosed in RED contains the device Tag following by the device Address. The data that is enclosed in BLUE is the actual Modbus data, with Tx at the end indicating a Transmit message and a Rx indicating a Response message. At the end of a Rx message, is the status of the operation as enclosed in GREEN (i.e. it took 80.5 milli-Seconds to receive the response with no errors). The Tx and Rx messages are the Modbus data captured by the communication activities logger. More detail explanation of Modbus messages can be found in the Modbus map for NGC and legacy controllers.

Note:

New data are always appended to the log file therefore in order to limit the size of the file, only the first 10 bytes of data per message will be saved. The system will create a new log file if it’s missing. The Communication Activities Logger settings are reset if Supervisor or the computer is restarted. There is a 5 day limit of continuous operation for the logger, Supervisor is programmed to disables the communication activities logger automatically.

Figure 4-37 Contents of communication log file

Figure 4-38 System Preferences - Miscellaneous tab
There are 3 Log options available. None, Log All and Log by Server.

<table>
<thead>
<tr>
<th>Log Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>This option disables the Communication Activities Logger, and is the default mode.</td>
</tr>
<tr>
<td>Log All</td>
<td>This option enables the Communication Activities Logger. This option applies to all Supervisor Server including the Master Server and any Slave Servers.</td>
</tr>
<tr>
<td>Log by Server</td>
<td>This option enables the Communication Activities Logger to be active only on the selected Supervisor Server.</td>
</tr>
</tbody>
</table>

Enable Alarm Filter for NGC-40 Devices:

The Alarm Filter option for NGC-40 Devices are specific to NGC-40 systems. If this option is enabled, RAYCHEM Supervisor will allow Device Communication Failure alarms to occur for a period of time before they are reported as alarms. The purpose is to filter out Device Communication failure alarms that occurs momentarily and is reset automatically shortly after. Due to the nature of these alarms they do not affect the operation of the Heat trace system. If this type of alarm is a nuisance in your heat trace system, you can explore this option further.

4.12.11 COMMON ALARM OUTPUT

The Common Alarm Output feature provides remote alarm annunciation through RAYCHEM Supervisor. One or more Remote Output modules are required for turning On/Off relays that are connected to annunciator panels. The Remote Output module must support the Modbus communications protocol.

The Common Alarm Output Configuration includes a set of screens to allow a RAYCHEM Supervisor administrator to setup the Common Alarm Outputs for their system. When the user selects the Common Alarm Output Configuration menu, the following screen is displayed.

![Figure 4-39 Common Alarm Output Configuration](image)

On this screen, the user can setup any one of the 16 alarm outputs. By selecting an Alarm Output on the Alarm Outputs Tree, the screen is updated to allow changes to each individual field for a Common Alarm Output.
For each Common Alarm Output, the following fields are relevant.

- **Plant Group** (Filtering alarms from devices belonging to a specific Plant Group)
- **Alarm Types** (Type of alarms that will activate a Common Alarm Output)
- **Common Alarm Module** (Associate an Output Module Type used for a Common Alarm Output)
- **Channel** (Output Module Type Channel used for a Common Alarm Output)
- **Alarm Mode** (Steady or Toggle Mode)
- **Toggle Duration** (Duration used with Alarm Mode set for Toggle)
- **Email Address** (Email notification when a Common Alarm Output is activated)

Most of these fields are self-explanatory; however, the Common Alarm Module may need further explanation. Instead of using devices such as what is currently used with the LoadShedding feature, we use a more flexible scheme. This scheme allows the user to define as many Common Alarm Module as they need, with each Common Alarm Module associated with a predefined Output Module. The Output Module contains the hardware related information. This is simply the Output Module Type and Communication Settings such as COM port and/or a Modbus address associated with the Output Module. Currently RAYCHEM Supervisor supports 2 Output Module types; this includes the MoniTrace RMC and ADAM 4000 Series Output Modules. Each Common Alarm Module has a name which is user defined. Therefore if there are several RMCs and/or ADAM Output Modules used, each will have its own name and they can be referenced by the Common Alarm Outputs.
To edit the Alarm Types or Common Alarm Module fields, click on the Edit button on that field.

Figure 4-40b Edit Common Alarm Module
A Test function is available to test the Common Alarms Module if it's on-line to verify its operation.

Figure 4-40c Test Common Alarm Module

The user can view the Common Alarm Output Status anytime by using Tools pull down menu in the RAYCHEM Supervisor Client main screen.

Figure 4-41 Common Alarm Output Status

The details of each Alarm Output can be viewed by selecting a Common Alarm Output in the Alarm Output tree.

Figure 4-42 Common Alarm Output Status with Alarm Output details
At all times during RAYCHEM Supervisor operation (either foreground or background operation), the alarm scanner continuously monitors for any alarm that may appear in any device installed in the system. If a new alarm is detected, a warning window will pop up in the upper right corner of the window indicating how many new (unacknowledged) alarms or warnings are present in the system.

Figure 5-1 Alarm Warning window

If the Beep on Alarms checkbox is selected in the System Configuration, the computer will continuously beep until all new alarms are either reset or acknowledged. If you click the Silence button, it will suspend the beeping until the next new alarm or warning is detected.

Clicking the Details button will display details regarding the new alarms that have been detected.

Figure 5-2 Detailed Alarm Warning window

The alarms are displayed in reverse chronological order, as they are received. Clicking a column heading (GCC Tag, HTC Tag, etc.) will sort the information alphanumerically.

To acknowledge or reset an alarm, click the desired alarm and press the right mouse button. This will pop up an action box that will allow you to acknowledge or reset the alarm (or warning). As in Windows, if you click the top alarm, hold the Shift key down and click the last alarm, all the alarms will be highlighted. Clicking the right mouse button will give you the option of resetting or acknowledging all of the selected alarms.

Once you have acknowledged an alarm, it is removed from the list and placed in the alarm queue (Refer to Section 4.5, “View Alarms Window”). Once all of the alarms are either reset or acknowledged, the window will disappear, and reappear the next time a new alarm is detected. If the alarm is reset, it is removed from both the unacknowledged alarm list as well as the alarm queue.
5.1 SHOW PLANT DOCUMENTATION OPTION

The Alarm Warning Window can display the Plant documentation along with each alarm. The Plant documentation is the Location, Line Equipment Number, Controller Panel or Breaker Panel of the alarming device. Click on the drop down portion of the Details button to bring up the plant documentation selection menu. Once selected, a column containing the plant documentation is displayed.

![Plant documentation selection menu](image)

Figure 5-3 Detailed Alarm Warning window

---

**History Logger**

The History Logger runs in the background while RAYCHEM Supervisor servers are operating. Alarm, Warning, Administrative, and System activities are passed to the History Logger for storage in the system’s database.

The maximum number of log records that will be stored is user configurable, and the default is set at 3000. When this limit is reached, the oldest records can be either overwritten by the latest data or saved to a compressed archive file depending on the system preference settings. The user can view either the current logs in the database, or the archived logs.

5.2 VIEWING HISTORY LOGS

To view history logs, use the System drop-down menu and select View History Logs, then select **Current Logs**. By default, the history logs are sorted based on date and time. You may click a column header to sort the data on that column.

The History Log window does not refresh automatically. Use the **Refresh** button to refresh the display if new alarms and warnings have arrived.

You can resize the History Log window to fit your desktop. To resize the window, use the mouse and click the bottom right corner of the window and drag it to the desired dimension.
Figure 5-3 Current History logs

To exit the History Log window, click the **Close** button.

To view Archived History Logs, use the System drop-down menu, and select **View History Logs**, then select ** Archived Logs**. Use the archived log drop down box and select an Archived History log to view.

Figure 5-4 Archived History Logs

5.3 **SETTING HISTORY LOGS ARCHIVING OPTIONS**

You can set the maximum number of history log records that the system keeps in its database. When the maximum number is reached, you can decide whether to overwrite the oldest records, or to archive them to a file. If you choose to archive the oldest records, you can set the percentage of records to archive, and the maximum number of archive files that you want to keep.

For details on history log settings, please refer to Section 3.5.4 “History Log Settings.”
Multi-level, user configurable security is an integral part of RAYCHEM Supervisor. This section describes the basic theory behind the RAYCHEM Supervisor Security system and the relationships between plant Groups, Roles and Users.

6.1 OVERVIEW

RAYCHEM Supervisor’s security is based on plant Groups, Users, and Roles.

Users identify the people that will be using RAYCHEM Supervisor.

Roles define a set of permissions that allow or disallow a user access to certain RAYCHEM Supervisor functions.

Groups allow one or more devices to be combined together in a logical group. This would normally be used to divide a plant’s operations into functional areas, allowing only information and devices that are relevant to the current user to be displayed. Group along with Role defines the access permission for a user.

There are three types of permissions: user, system and device. The system and device permissions are defined as part of a user’s Role. The user permission is defined for a user.

User permissions are assigned to a specific user, and users have their own set of user permissions. User permissions affect system-wide functions. These include permissions to: Setup System Preferences, Roles/Users/Plant Documentation, Scheduled Tasks, Transfer Licenses, Backup the System Database, Copy Device Configurations, Install New Devices, Run the Configuration Loader, Setup Trend Groups, Setup Batches/Recipes, Steam Out Devices, and Setup Servers.

System Permissions controls the following RAYCHEM Supervisor functions: Replace Device, Remove Device, and Run Batches.

Device Permissions controls the following RAYCHEM Supervisor functions: Configure Device, Change Device Configuration, Edit Device Tag, Perform Device Maintenance, Set Device Date/Time, Perform Device Compare, Change Limiter Parameters, Reset Limiter Alarms, Delete Note, Create Note, and Unlock Devices.

In a typical plant, workers have unique skill sets each having their areas of responsibility. For example: Operators, Engineers, Electricians, Technicians, Managers, etc. In RAYCHEM Supervisor, roles, users and groups are used to represent the plant hierarchy. Groups sub-divide the user’s work boundary and roles determine what a user can or cannot do. Groups, roles, and users are the building blocks that define security in RAYCHEM Supervisor.

The basic concept behind the use of groups, users, and roles is quite simple. Given a specific device in a plant, various users may need a different level of access to the device (for example, some users should be allowed to change settings, while others should only be allowed access to view settings).

To accomplish this, we can create different roles and assign each user a role in that particular group. As an example:

For Group #1, User A is assigned a Technician role, User B is assigned an Engineering role, and User C is assigned a Manager role. Each user will have a different level of access to any devices assigned to Group #1, since each of their roles is different.
When a device such as a GCC, NGC-UIT, or HTC is installed, it will be automatically assigned to the Default Group by RAYCHEM Supervisor. The Default Group is a placeholder for all new devices. Any device in the Default Group inherits full System and Device permissions, and will be accessible to all users.

In order to restrict access to some of these devices, you must create a new Group and move the devices into it. For each user that needs access to these devices, assign them a role in this new plant Group that will give them the desired permissions. Finally, remove these devices from the Default Group.

If the devices are not removed from the Default Group, then they will belong to multiple groups. In this case, the default group permissions will override the permissions of the other group(s). This will void the security mechanism, since all users have full access to devices in the default group. If the devices are removed from the Default group, then only users assigned to the new group will be able to access these devices (i.e.: another user will not be able to see them on the selection window).

**IMPORTANT:** There are no restrictions on the number of plant Groups and Roles allowed in RAYCHEM Supervisor. Many different combinations can be created and used, however over-using them can create a complex system which is difficult to maintain. It is highly recommended that the RAYCHEM Supervisor Administrator perform adequate system planning before implementing their security hierarchy. Planning ahead will help create a robust foundation for future upgrades and maintenance. (Refer to Section 3.1 “Planning Your System”).

**IMPORTANT:** A device can belong to more than one Group. The effective permissions for devices belonging to more than one Group are the sum of the permissions for all those Groups.

**IMPORTANT:** All devices in the Default Group will have full System and Device permissions. Therefore, any devices that are assigned specifically to a Group must also be removed from the Default Group.

### 6.2 SETTING UP ROLES

Before you can set up roles, you must have user permission to Setup Roles/Users/Plant Documentation.

![Set Up Roles](image)

Figure 6-1 Set Up Roles
6.2.1 ADDING A NEW ROLE

To add a new role, do the following:

1. In the Client’s main window, use the Security drop-down menu and select Roles.
2. Once the Set up Roles window is displayed, click the Add Role button.
3. In the Add a New Role window, enter the role name and its description. Note that the maximum length for the role name is 20 characters, and the maximum length for the role description is 50 characters.
4. Edit the System and Device permissions.
5. When you have completed your edits, click OK to save and exit.

Figure 6-2 Add a New Role

6.2.2 EDITING A ROLE

To edit a role, do the following:

1. In the Client’s main window, use the Security drop-down menu and select Roles.
2. Once the Set up Roles window is displayed, click the Edit Role button.
3. Using the Edit Role window, edit the role name, description, System permissions, or Device permissions.
4. When you have completed your edits, click OK to save and exit.
6.2.3 DELETING A ROLE

To delete a role, do the following:

1. In the Client’s main window, use the Security drop-down menu and select Roles.
2. Once the Set up Roles window is displayed, click the Remove Role button.
3. When you are prompted to confirm the removal, click Yes to remove the role, otherwise click No.

**IMPORTANT:** The Default Role cannot be deleted.

6.3 SETTING UP GROUPS

Before you can set up users, you must have user permission to Setup Roles/Users/Plant Documentation.

6.3.1 ADDING A NEW GROUP

To add a new group, do the following:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Group.
2. From the Configure Group window, click the Add Group button. The Add a New Group window is displayed.
3. From the Add a New Group window, fill in the group name and description. The maximum length for the group name is 50 characters. The maximum length for the description is 50 characters.
4. When you have completed your edits, click OK to save and exit.
6.3.2 EDITING A GROUP

To edit a group:

1. In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Group**. Once the Configure Group window is displayed, click the **Edit Group** button.
2. From the Edit Group window, edit the group name and description.
3. When you have completed your edits, click **OK** to save and exit.

6.3.3 REMOVING A GROUP

To remove a group:

1. In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Group**. Once the Configure Group window is displayed, click the **Remove Group** button.
2. When prompted to confirm the removal, click **Yes** to remove the Group, otherwise click **No**.

**IMPORTANT:** If you are deleting a Group and this Group has been assigned to Trend Groups or Batches (i.e.: Group specific Trend Group and Batches), devices assigned to this Group will be removed from those Trend Groups and Batches as well.
6.3.4 ASSIGNED Devices TO A GROUP

To assign devices to a group:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Group.
2. Once the Configure Group window is displayed, click the Assign Devices button.
3. From the Assign Devices to Group window, add and/or remove devices.
4. When you have completed your edits, click OK to save and exit.

![Assign Devices to Group](image)

Figure 6-6 Assign Devices to Group

6.3.5 ADDING USERS TO A GROUP

To add users to a group:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Group. Once the Configure Group window is displayed, click the Assign Users button.
2. From the Add Users to Group window, add and/or remove users.
3. When you have completed your edits, click OK to save and exit.

![Add Users to Group](image)

Figure 6-7 Add Users to Group
6.4 SETTING UP USERS

Before you can set up users, you must have permission to Setup Roles/Users/Plant Documentation.

![Setup User Window]

Figure 6-8 Setup Users

6.4.1 ADDING A NEW USER

To add a new user:

1. In the Client’s main window, use the Security drop-down menu and select Users.
2. Once the Set up User window is displayed, click the Add User button.
3. From the Add a New User window, fill in the user name, Full name, and password fields. The maximum length for the user name is 15 characters. The maximum length for the full name is 30 characters. The maximum length for the password is 15 characters.
4. Edit the user’s permission levels.
5. Select Group and User Role. When you have completed your edits, click the OK to save and exit

⚠️ IMPORTANT: The user name is case sensitive (i.e.: “JOE-M”, “Joe-M”, or “joe-m” refer to different users).

⚠️ IMPORTANT: All users have access to the Default Group, and all users have full permission for devices in the Default group.
6.4.2 EDITING A USER

To edit a user:

1. In the Client’s main window, use the Security drop-down menu and select Users.
2. Once the Set up User window is displayed, select the user to edit then click the Edit User button.
3. From the Edit User window, edit the user name, Full name, password, update the user permissions, and/or user Groups and Roles. To edit the password, you must check the Reset Password option.
4. When you have completed your edits, click the OK to save and exit.

6.4.3 REMOVING A USER

To remove a user:

1. In the Client’s main window, use the Security drop-down menu and select Users.
2. Once the Set up User window is displayed, select the user to Remove then click the Remove User button.
3. When prompted to confirm the removal, click Yes to remove the user, otherwise click No.
RAYCHEM Supervisor supports numerous printed reports that you can access from the top menu selections or from individual windows.

7.1 PRINTING EHT SYSTEM REPORTS

The System drop-down menu includes a Reports menu that allows you to print different system reports as shown in Figure 7-1.

![Figure 7-1 System Reports](image)

**Roles**
The Roles report prints all of the roles and their permissions as defined in the system.

**User – Summary**
The User – Summary report prints all of the users defined in the system. Only user names and user full names are printed.

**User – Group Role**
The User – Group Role report prints all of the system users and their roles in the various groups.

**User – Permissions**
The User – Permissions report prints all of the users and their permission settings.

**Location – Summary**
The Location – Summary report prints all of the plant locations and their descriptions.

**Location – Devices**
The Location – Devices report prints a list of all devices and their locations.

**Communications Setup**
The Communications Setup report prints the setup for the serial ports (COM ports) that are used to communicate with field devices. The report includes port configuration details for each Server computer.

**Group – Summary**
The Group – Summary report prints all of the groups and their descriptions.
Group – Devices
The Group – Devices report prints a list of all of the groups and the devices that belong to them.

Group – Users
The Group – Users report prints all of the groups, along with the users and roles that have been assigned to them.

Line/Equipment Number – Summary
The Line/Equipment Number – Summary report prints all of the Line/Equipment numbers and their descriptions.

Line/Equipment Number – Devices
The Line/Equipment Number – Devices report prints all of the Line/Equipment numbers and the devices that have been assigned to them.

Controller Panel – Summary
The Controller Panel – Summary report prints a list of all of the controller panels and their descriptions.

Controller Panel – Devices
The Controller Panel – Devices report prints all of the controller panels and the devices that belong to them.

All GCC Configurations
This selection will print a configuration report for each installed GCC. If you want to print the configuration for a specific GCC, use the GCC Reports feature found in the Device menu (see Section 7.2).

All HTC Configurations
This selection will print a configuration report for each HTC installed in the system. Note that in a system with a large installed base of HTCs, this report may be very large. If you want to print the configuration for a specific HTC, use the HTC Reports feature found in the Device menu (see Section 7.3).

7.2 PRINTING GCC REPORTS

GCC reports can be accessed as shown in Figure 7-2 GCC Active Alarms and Figure 7-3 GCC Configuration.

Active Alarms
This report will print the active alarms for the particular GCC selected.

Children Active Alarms
This report prints the active alarms for all of the HTCs installed on the selected GCC.
Figure 7-2 GCC Active Alarms Menu

Configuration
This report prints the configuration information for the selected GCC. (In the GCC configuration window, click Print Report).

Installed HTCs
This report will print a list of all of the HTCs installed on the selected GCC. (In the GCC configuration window, click Installed HTCs).

Figure 7-3 GCC Configuration
7.3 PRINTING HTC REPORTS

HTC reports can be accessed as shown in Figure 7-4 HTC Active Alarms menu and Figure 7-5 HTC Configuration.

Active Alarms

This report will print any active alarms for the selected HTC.

Configuration

This report will print detailed configuration information for the selected HTC. (Click the Print Report button).

Figure 7-4 HTC Active Alarms menu

Figure 7-5 HTC Configuration
7.4 PRINTING HISTORY LOGS AND DEVICE NOTES REPORTS

History Logs
The History Logs report prints all logged alarms and warnings saved in the RAYCHEM Supervisor database.

To print reports, click the Report button in the View Current Logs window or in the View Archived Logs window.

Device Notes
The Device Notes report prints all of the notes and comments for the selected device.

![Figure 7-6 Current History Logs](image)

![Figure 7-7 Notes Report Selection](image)
Section 8 – TRENDING AND DATA LOGGING

RAYCHEM Supervisor supports the trending and logging of HTC parameters. Trend Groups are used to organize trend settings and trend data. A Trend Group consists of one or more HTC(s) for which trend data is to be logged. It also contains other settings such as how often to scan the HTC(s) for data, the types of data to read, etc.

RAYCHEM Supervisor supports multiple Trend Groups and trend data collected is stored in the database. The Trend Data Viewer can be used to view the trended data. For more information on use of the Trend Data Viewer, refer to Section 8.3 “Trend Data Viewer.”

**IMPORTANT:** Before a user is allowed to setup Trend Groups, the user must have user permission to set them up. Refer to Section 6 “Security” for details on how to setup user permissions.

8.1 SETTING UP TREND GROUPS

To display the Device Trending window from the main window, click the Tools drop-down menu and select Device Trending. The Device Trending Window will display (refer to Figure 9-1 Device Trending Window).

Figure 8-1 Device Trending window

8.1.1 USING A GLOBAL GROUP OR A TREND GROUP FOR A SPECIFIC PLANT GROUP

RAYCHEM Supervisor allows a Trend Group to be assigned to a particular plant Group, or assigned to all plant Groups (i.e.: a Global).

A Trend Group that is assigned to a specific plant Group is visible to users that have permission to that plant Group. Users without permission to that plant Group will not be able see or select these trend groups. You can create this type of Trend Group if it is intended only for specific users in your plant.

Trend Groups assigned to the Global plant Group are visible and accessible to all users. If you want to allow all users to access a Trend Group, then set the plant Group as Global for the Trend Group.
8.1.2 TREND GROUP PARAMETERS

The set of parameters for each Trend Group is explained in detail below.

**Trend Group Name**

Each Trend Group must have a unique alphanumeric name. The maximum length for a Trend Group name is 50 characters, and can include both upper and lower case characters.

**Read/Logging Interval**

The time interval for which to scan and save trend data for all selected HTCs in this Trend Group.

**Maximum Number of Reads**

The Maximum Number of Reads is used to limit the amount of data stored in the database. The size of each data record is dependent of the number of selected HTCs to trend. One data record is approximately 1600 bytes, multiplied by the number of HTCs being trended. For example, if the Maximum number of Reads is 1440, and there are 20 HTCs to trend, then the total amount of data stored in the database is approximately:

\[
1600 \text{ bytes} \times 20 \text{ HTCs} \times 1440 = 46 \text{ MBytes}
\]

For more information on requirements, please see Appendix E - System Requirements and Guidelines for Data Trending in Supervisor.

**Action When Maximum Number of Reads Is Reached**

RAYCHEM Supervisor keeps track of the number of reads performed for a Trend group. When the number of read exceeds the maximum, the data logging will stop or the logged data will be archived and RAYCHEM Supervisor will continue to log data using a new data table. Once the maximum number of reads has been reached, the user may set the action to one of these options:

- Stop data logging for this trend group
- Continue data logging but archive old data
- Continue data logging but overwrite oldest data

**Enable Data Logging**

This parameter enables the data logging for this Trend Group. This field must be ENABLED for trending and data logging to run.

**Assign Devices**

The Assigned Devices window is used to include devices for the Trend Group. User can select devices with the device selection window on the left window pane and move them to the selected device window pane on the right window pane.

**IMPORTANT:** Only devices that a user has access to will be displayed in the device selection window.

**Trend Options**

The trend options are enabled by default and cannot be disabled by the user.
8.1.3 ADDING A NEW TREND GROUP

To add a new Trend Group:

1. From the Device Trending window, click the New button. The Choose plant Group for Trend Group window is displayed.
2. Select one of the plant Groups listed for your Trend Group.
3. Select Global if this new Trend Group is to be used by all users, otherwise select a specific plant Group. After you’ve selected a plant Group, the New Trend Group window is displayed.
4. Fill in the information in the Trend Group Settings tab.
5. Click the Assigned Devices tab and assign devices to this Trend Group.
6. When you have completed your selection, click the OK button to save and exit.

**IMPORTANT:** The Data Logging Enabled checkbox must be checked to start the trending and data logging.

![Figure 8-3 New Trend Group](image)

8.1.4 EDITING A TREND GROUP

To edit a Trend Group:

1. From the Device Trending window, select a Trend Group then click the Edit button.
2. From the Edit Trend Group window, make changes to the Trend Group as desired.
3. When you have completed your changes, click the OK button to save and exit, or the Apply button to save.

![Figure 8-4 Edit trend group](image)
8.1.5 DELETING A TREND GROUP

To delete a Trend Group:

1. From the Trend Groups box in the HTC Trending window, select a Trend Group from the Trend Group List then click the **Delete** button.
2. When prompted with a confirmation window, click **Yes** to confirm the deletion or click **No** to cancel as the following example indicates.

![Confirmation Window](image)

Figure 8-5 Delete Trend Group Confirmation

**IMPORTANT:** Once you delete the saved data, it cannot be recovered.

8.1.6 VIEWING TREND GROUP DATA

Once the Device Trending window is displayed, select a Trend Group from the Trend Group List. Then click the **View** button. The Trend Data Viewer window is displayed. Refer to Section 9-3 “Trend Data Viewer” for more information on how to use the Trend Data Viewer.

8.1.7 EXPORTING A TREND GROUP

A trend group’s data can be exported to a Comma Separated Value (CSV) file for use with another program.

To export a Trend Group:

1. From the Device Trending window, select a trend group to export then click the **Export** button. You will be prompted to enter a name for the exported file.
2. Select a path and enter a file name, then click **OK** to start the export.

8.2 ARCHIVED TREND GROUPS

Archived Trend Groups can be viewed or exported to a CSV file. To display the Archive Trend Groups window, use the Tools drop-down menu and select **View Archived Trend Data**.

![Archived Trend Groups](image)

Figure 8-6 Archived Trend Groups
8.2.1 REMOVING AN ARCHIVED TREND GROUP

From the Archived Trend Group window, select an Archived Trend group to delete then click the Remove button. The delete will remove the Archived Trend group from the database.

**IMPORTANT:** Once the archived trend group is deleted from the database, it cannot be recovered.

8.2.2 VIEWING A ARCHIVED TREND GROUP

From the Archived Trend Group window, select an archived trend group to view then click the View button. The Trend Data Viewer window is displayed. Refer to Section 8.3 “Trend Data Viewer” for more information on how to use the Trend Data Viewer.

8.2.3 EXPORTING A ARCHIVED TREND GROUP

An Archived Trend group can be exported to a Comma Separated Value (CSV) file for use with another program. From the Archived Trend Group window, select an Archived Trend group to export then click the Export button. You will be prompted to enter a name for the exported file. You can select a path and enter a file name, then click OK to start the export.

8.3 TREND DATA VIEWER

The Trend Data Viewer can be used to display trend data as a Value versus Time plot(s). Multiple trend data points can be displayed simultaneously as multiple plots on the plot window. Each trend data point is identified as “Channel X” where X is a number from 1 to 999. This number is automatically assigned by Trend Data Viewer and should not be changed. Relevant information for each data point is displayed in the Trend Group Data Point box (the bottom window panel on the Trend Data Viewer Window).

The trend data for a Trend Group or archived Trend Group contains many data points for each HTC, so when the Trend Data Viewer window is initially shown, the window will NOT display any data points. You must use the Add button to add the data elements that you wish to view on the window. Customization of the Data Viewer window can be accomplished for each Trend Group. Refer to Section 8.3.4 “Using the Trend Graph Window” for more details.

![Trend Data Viewer Window](image)

Figure 8-7 Trend Data Viewer Window

8.3.1 ADDING DATA POINTS TO DISPLAY

In the Trend Data Viewer window, click the Add button. Once the Trend View Add Device window is displayed, select a device from the Trend Devices box then select the data points to include for this device. Repeat this selection until you have selected all necessary devices.
8.3.2 DELETING DATA POINTS

In the Trend Data Viewer window, select the Data Point(s) to delete, then click the Delete button. The Delete button will remove the data points from the Trend Graph Window as well as from the list.

IMPORTANT: Delete data points will only remove the selected data point(s) from the Trend Data Viewer window - no change is made to the trend group database. You may always add and view the data points at some later time.

8.3.3 DELETING ALL DATA POINTS

In the Trend Data Viewer window, click the Clear button. The Clear button will remove all the data points from the Trend Graph Window as well as from the list.

IMPORTANT: Deleting all data points will remove all of the selected data point(s) from the Trend Data Viewer window only - no change is made to the trend database. You may always add and view the data points at some later time.

8.3.4 USING THE TREND GRAPH WINDOW

The Trend Graph Window consists of the Toolbar, X and Y-axis, Plot Window and Legend areas. The Toolbar at the top of the Trend Graph Window is used to manipulate the displayed graphs. The functionality of each Toolbar button is as follows:

Resume

Use the Resume button to restart or reset the Plot Window that you have previously paused.

Pause

Use the Pause button to stop the Plot Window from being updated with new data. Once the Plot Window stops, you can scroll the X or Y-axis by clicking, holding and moving the mouse left and right or up and down.

Axis Scroll Mode

Use the Axis Scroll Mode button to control the scrolling of the X or Y-axis. Click the mouse on the X or Y-axis then drag the mouse left or right or up or down.
**Axis Zoom Mode**

Use the Axis Zoom Mode button to expand or shrink the scale of the X or Y-axis. Click the mouse on the X or Y-axis then drag the mouse left or right or up or down.

**Zoom In**

Use the Zoom In button to expand the X or Y-axis. Click the mouse on the X or Y-axis, and then click the Zoom In button.

**Zoom Out**

Use the Zoom Out button to shrink the X or Y-axis. Click the mouse on the X or Y-axis, and then click the Zoom Out button.

**Zoom Box**

Use the Zoom Box button to expand both the X and Y-axis simultaneously. Click the Zoom Box button, and then use the mouse to create a box around the area to expand and release the mouse button.

**Hair-line Cursor**

Use the Hairline Cursor button to create a hair-line cursor that can be moved on the Plot Window. As the hair-line cursor is moved, the X and Y values will display near the hair-line. Start by clicking the Cursor button to display a hairline cursor. Use the mouse to drag and move the hair-line or hold the Control key down and use the Left of Right arrow key to scroll through the data. You can also select a different channel for the hair-line cursor to focus on. To select a channel, click a channel in the Legend area (text located on right portion of the Plot Window).

**Edit Properties**

Use the Edit Properties button to edit the properties of the X and Y-axis, the Legend, and the Plot Window. You can completely customize the Trend Graph Window through the Edit Properties button. There are many properties for the Plot Window, and you are encouraged to experiment with these. For more information on the use of the various properties in the Trend Graph Window, refer to the "PlotPackUserManual.pdf" document included in the "User Documents" folder on the RAYCHEM Supervisor CD.

Changes to any properties are saved and they will be used the next time the Trend Group data is viewed.

By using the Edit Properties button, you can customize the Trend Graph Window for your application. As the following example shows, you can add multiple Y-axes to display multiple graphs with true scaling for each.
Figure 8-9 Example of a Customized Trend Graph window

**Copy**

Use the Copy button to copy an image of the Trend Graphs Window to the clipboard.

**Save**

Use the Save button to save the collected data to an ASCII text file.

**Print**

Use the Print button to output the current image of the Plot Window to a printer.
Section 9 – BATCHES AND RECIPES

A Recipe is a predefined template of device configuration parameters. These parameters include control setpoints, alarm enables, alarm setpoints, etc. You can create as many Recipes as desired.

A Batch is a collection of Recipes and each Recipe can be associated with one or more device(s). In other words, a Recipe is nothing more than a template and is not useful until it is defined in a Batch.

Once a recipe is defined in a Batch, this Batch can be run manually by the user or automatically by the Scheduler. When a Batch is run, the device configuration parameters defined in each Recipe will be written to the device(s). The use of Batching can be very useful for automating plant operation.

Normally the following steps are taken to use Batches and Recipes:

1. Creation of the recipe(s)
2. Creation of a batch
3. Assigning recipes and devices to the batch

A Batch may have one or more Recipes, and each Recipe can be assigned to one or more devices.

9.1 SETTING UP RECIPES

Before you can set up Recipes, you must have the Setup Batches & Recipes permission. Refer to Section 6 “Security” for details on how to configure permissions.

From the main window, use the Tools drop-down menu and select Batches and Recipes. The Batches and Recipes window is displayed:

![Batches and Recipes window](image)

Figure 9-1 Batches and Recipes window

9.1.1 ADDING A NEW RECIPE

To create a new Recipe, click the Recipes tab, then click the Add button. The Choose Recipe Type window is displayed. Presently, only one recipe type is supported – the HTC Recipe. Select HTC Recipe type and click OK to display the New Recipe window. In this window, the HTC configuration parameters are divided into several tabs.
These tabs are:

1. Temperature Control
2. Temperature Alarm
3. Voltage and Current
4. GFI and Resistance
5. Other Alarms
6. Miscellaneous

Click on the individual tabs to access the configuration parameters required. The configuration parameters in each tab are grouped together based on their functionality. Associated with each configuration parameter are the following optional fields: Enable, Value, Use Incremental, and Incremental Step.

**Enable**

If you enable this field, this parameter in an HTC will be updated to the value defined in the Value field.

**Value**

This is the predefined value written to the HTC if the Enable field is checked.

**Use Incremental**

For some parameters, it may be desirable to write an incremental value instead of an absolute value. These include Temperature Setpoint, Proportional band, and Deadband parameters. If the Use Incremental Value is enabled, the parameter in an HTC will be incremented by the amount defined in the Incremental Value field.

**IMPORTANT:** There can only be one enable selection for each parameter, use either the Value or use the Incremental Value.

**Incremental Value**

This is the predefined value used to update the HTC if the Enable Incremental Value field is selected. Note that a parameter may be decremented by placing a minus sign (−) in front of the value.

![Recipe window](image)

Figure 9-2 Recipe window
9.1.2 EDITING A RECIPE

To make changes to an existing Recipe, choose a Recipe then click the Edit button or double click on the recipe. Edit as desired then click Apply to save without exiting or OK to save and exit.

9.1.3 REMOVING A RECIPE

To delete an existing Recipe, click the Remove button. You will be prompted to confirm your action. Click Yes to continue with the deletion or No to cancel the operation.

9.1.4 RENAMING A RECIPE

After you create a Recipe, you can change its name if required. To rename a Recipe, bring up the Edit Recipe window. Refer to Section 9.1.2 “Editing a Recipe” for details.

9.1.5 MAKING A COPY OF A RECIPE

Use the Copy button to make a copy of an existing Recipe. You will be prompted to enter a name for the new Recipe. After you’ve entered a new name, click OK to save.

9.2 SETTING UP BATCHES

Before you can set up Batches, you must have permission to Setup Batches and Recipes. Refer to Section 6 “Security” for details on how to configure permissions.

From the main window, use the Tools drop-down menu and select Batches and Recipes. The Batches and Recipes window is displayed.

9.2.1 CREATING A NEW BATCH

To create a new Batch, click the Batches tab, then click the Add button and the Choose Batch Group window is displayed. You can choose to create a Global batch or a plant Group specific batch. All users can see and run a Global batch, but only users in the same plant Group as a batch can see and run the plant Group specific batch.

![Choose plant Group for Batch]

Figure 9-3 Assign the Batch to a Plant Group

After you have chosen Group or Global, click OK and the New Batch window displays. To set up a Batch, you must provide a name of up to 50 characters.

You may add Recipe(s) to this Batch by using the Add button in the Recipe List group. Once a Recipe is added to this Batch, you can add device(s) to this Recipe by using the Add button in the Device List for the Selected Recipe group. You can assign as many device(s) to a Recipe as required.

You can also assign one or more Recipe(s) to a Batch. Recipes are run in the order they appear in the list. The top-most Recipe will run first, followed by the second Recipe, then the third, etc. You can change the order in which a Recipe will run by selecting it and using either the Up arrow or Down arrow buttons to raise or lower its position (priority) in the list. When you’ve finished your setup, click the OK button to save and exit.
Figure 9-4 New Batch window

Figure 9-5 Adding Recipes to Batch window
9.2.2 EDITING A BATCH

To make changes to an existing Batch, choose a Batch then click the Edit button or double click on the batch. Edit the Batch then click Apply to save without exiting or OK to save and exit.

9.2.3 REMOVING A BATCH

To delete an existing Batch, choose a Batch then click the Remove button. You will be prompted to confirm your action. Click Yes to continue or No to cancel the operation.

9.2.4 RENAMING A BATCH

After you created a Batch, you can change its name if required. To rename a Batch, choose a Batch then click the Edit button. Refer to Section 9.2.2 “Editing a Batch” for more information.

9.2.5 RUNNING A BATCH

There are two ways to run a Batch operation. The first is to manually run a Batch by using the Run button. The second is to create a scheduled event in the Scheduler. Refer to Section 11 “Scheduled Events” for more information on how to set up a scheduled event.

To manually run a Batch, you must choose a Batch first then click the Run button — the Run Batch window will display. Click the Start button to start the operation. The Run Batch operation can take some time to complete, depending on the number of devices that have been assigned to a Batch. The Run Batch window displays a running status during this operation, and you can stop it at any time by using the Stop button.

IMPORTANT: Interrupting a Batch part of the way through its execution will result in some HTCs having been modified according to the Recipes in the Batch and others left unchanged.

You can click the Close button to close the Run Batch window and come back to view the batch status later. Refer to Section 9.2.6 for more information on how to view the status of a batch that is running.
9.2.6 VIEWING RECENTLY RUN BATCHES

You can view recently run Batches and/or the status of Batches that are still running.

To view recently run Batches, use the **Tools** drop-down menu and select **Recently Run Batches**. The Recently Run Batches window displays. From here you can check the status of a Batch that is running, stop a running Batch, run the Batch again, or retry the Batch for failed devices. Click the Run button to fully run the selected Batch. Click the Retry button to run the selected Batch, but only process devices that failed during the last attempt.

---

Figure 9-7 Run Batch window

![Run Batch window](image)

Figure 9-8 Recently Run Batches

![Recently Run Batches](image)
Starting with version 2.2, RAYCHEM Supervisor can act as a load shedding master when used with NGC-20 controllers (either NGC-20 direct or NGC-20 with NGC-UIT). There are two ways to initiate load shedding. One way is to manually direct RAYCHEM Supervisor to start load shedding for specified zones (Referred to as "User-Initiated" or "RAYCHEM Supervisor-Initiated"). A Zone is a grouping of controllers. The other is to configure RAYCHEM Supervisor to initiate load shedding based on the state of specified digital inputs (Referred to as "Remotely Activated"). When this feature is enabled, RAYCHEM Supervisor will monitor one or more digital inputs for an ON state, then broadcast a message instructing the controllers to activate their load shedding algorithm. The ON state must be provided by a user supplied device, such as an RMC. nVent supplied an RMC-direct device that provides up to 40 digital inputs. The RMC must be added to the RAYCHEM Supervisor system as described below. In addition, there are two new user permissions that enable a user to Configure Load Shedding, and to Start/Stop Load Shedding. A user must have the appropriate permissions in order to perform Load Shedding configurations and/or Start/Stop Load Shedding in RAYCHEM Supervisor.

10.1 ADDING AN RMC-DIRECT DEVICE

In order for RAYCHEM Supervisor to know when to initiate load shedding actions, it needs to detect an ON state signal from one or more digital inputs of an RMC device (contact your local nVent representative for more information regarding available RMC configurations.). Therefore, to setup and use the Remotely Activated Load Shedding features, you must add at least one RMC-direct device to the RAYCHEM Supervisor system and establish the proper Modbus communication parameters.

To add an RMC-direct device, choose Device from the main menu, then select Add RMC Direct. The following window is displayed:

![Add a New RMC Device with Direct Connection](image)

Figure 10-1 Add a new RMC Device with Direct Connection
As you can see, this step is very similar to adding an HTC-direct controller.
10.2 MONITORING AN RMC-DIRECT DEVICE

Once the RMC has been added, you may monitor its operational states (basically, the on/off states of each digital channel.) In order to do this, in the RAYCHEM Supervisor main tree view, right-click on the RMC and then select Monitor. The RMC Monitor window is displayed as in the following example.

![RMC Monitor window](image)

Figure 10-2 RMC Monitor window

10.3 LOAD SHEDDING CONFIGURATION

Setting up Load Shedding for operation, consists of mapping individual digital inputs to “Zones” (a Zone is simply a grouping of controllers) and specifying load shedding communications channels. Each digital input may be mapped to one or more zones. In addition, each controller needs to be configured to belong to one or more zones. Once a digital input has been mapped to a Zone(s), if the state of that digital input is ON, RAYCHEM Supervisor will broadcast a load shedding command message to all devices on the appropriate communications channels.

If a controller had been previously configured to be a member of the appropriate Load Shedding zone, then it would process the broadcast message and begin Load Shedding action accordingly.

10.3.1 ZONE SETTINGS

A controller of the NGC series can be assigned to one or more zones, with a maximum of up to 16 different zones. As part of the setup for Load Shedding, each controller in your Heat Trace system that needs to perform load shedding must be configured to their proper zones (see Section 10.3.4 Assign controllers to Zones for more information).

The Zone Settings in RAYCHEM Supervisor defines the mapping of Zones to physical digital inputs of one or more RMC devices. The layout of the Zone Settings in RAYCHEM Supervisor is displayed in the following example.
Each Zone can be assigned to a specific digital input of an RMC device. For example, the window above shows Zone 1 is assigned to RMC_1A and digital input 1 of RMC_1A is to be monitored for an ON state. As well Zone 5 is assigned to RMC_1A and digital input 5 of RMC_1A is to be monitored for an ON state. In other words, for that particular setup RAYCHEM Supervisor will do the following:

1. When the state of digital input 1 of RMC_1A is ON, send out a Load Shedding command to each of the communication channels (See section 10.3.2 Channel Settings) to activate Load Shedding for Zone 1.
2. When the state of digital input 5 of RMC_1A is ON, send out a Load Shedding command to each of the communication channels (See section 10.3.2 Channel Settings) to activate Load Shedding for Zone 5.

When a controller receives a Load Shedding command from RAYCHEM Supervisor and it has been configured such that it belongs to either Zone 1 and/or Zone 5, and there are no restrictions preventing it from load shedding, it will go into Load Shedding mode.

If there are one or more Slave Servers in your RAYCHEM Supervisor systems, you must setup the Zone Settings for each Slave Server as well. In case where only one setting is required for all Servers, then the Use For All button can be used. The Use For All button forces the current Zone Settings to all the Servers in your RAYCHEM Supervisor system.
10.3.2 CHANNEL SETTINGS

The Channel Settings contain the definitions of where RAYCHEM Supervisor will send out the Load Shedding commands. They are physical communication medium such as a COM port or a TCP/IP address. The following example shows the Channel Settings:

![Channel Settings](image)

Figure 10-4 Load Shedding Configuration

There are nine communications channels available to be assigned for Load Shedding. Normally you should only assign channels that will be used such as COM port 1 and set the other channels to [None], which helps improve the overall performance of the Load Shedding functionality.

If there are one or more Slave Servers in your RAYCHEM Supervisor system, you must setup the Channel Settings for each Slave Server as well. In case where only one setting is required for all Servers, then the Use For All button can be used. The Use For All button forces the current Channel Settings to all the Servers in your RAYCHEM Supervisor system.

10.3.3 OTHER SETTINGS

There are two other important settings that must be setup for Load Shedding. They are the Broadcast Interval and the Load Shedding Enabled fields. The Broadcast Interval tells RAYCHEM Supervisor how often to re-send the Load Shedding command out each of the Channels once it has started Load Shedding. This is required because a Controller such as an NGC-20 will stop Load Shedding if it fails to receive a Load Shedding command from RAYCHEM Supervisor within a certain period of time (i.e. Load Shed Communications Time out). This is a safety mechanism pre-programmed in the controller. The Load Shedding Enabled field enables or disables the Load Shedding function. This field must be set to Enabled for Load Shedding to work in RAYCHEM Supervisor. The following window example shows the Other Settings window.
If there are one or more Slave Servers in your RAYCHEM Supervisor systems, you must setup the Other Settings for each Slave Server as well. In case where only one setting is required for all Servers, the Use For All button can be used. The Use For All button forces the current Other Settings to all the Servers in your RAYCHEM Supervisor system.

10.3.4 ASSIGN CONTROLLERS TO ZONES

For a controller to Load Shed, it must be configured to use the correct Load Shed Zone Settings. To setup Load Shedding for an NGC-20, open its Configuration window and edit the Load Shed Zone fields.

It is important to note that some planning and a general strategy should be created before you begin configuring each controller. The general strategy should include organizing and grouping the necessary controllers in your Heat Trace system to Load Shed Zones, acquiring RMC devices and mapping the different digital inputs of each RMC device to Load Shed Zones. If Slave Servers are used in your system, you must take into consideration those Slave Servers as well.

Since there are only nine load shedding channels for each server, it is important that you group your load shedding controllers properly so that they can be all connected to the available channels and use as few channels as possible.
10.4 MONITORING LOAD SHEDDING STATUS

To see the on/off status of all Load Shedding zones, you need to select the Tools drop-down menu, then Load Shedding Status, which will display the Load Shedding Status window as shown below. In this window, the tree view portion shows all the Servers that are available in your RAYCHEM Supervisor system. The example shows a system with only the Master Server. The right portion of the window shows the Load Shed ON/OFF status of the Master Server, with each column representing a Zone. The status of each Zone will be indicated by a colored dot. The dot color has the following meaning:

- **Red** = Load Shedding is NOT active
- **Green** = Load Shedding is remotely activated
- **Blue** = Load Shedding is activated by user initiated action.

In this example, no active Load Shedding zone exists.

![Load Shedding Status Window](image)

Figure 11-7 Load Shedding Status Window

In this window, the user can use the toolbar buttons to Start, Stop, and Restart Load Shedding, or to view the Load Shedding Configurations. When a user selects the EHT System on the tree view as shown on the example window, the **Start**, **Stop**, or **Restart** toolbar buttons apply to the entire RAYCHEM Supervisor system (i.e. Load Shedding for the Master Server as well as the Slave Servers if they are available).

When Load Shedding is remotely activated, this implies that RAYCHEM Supervisor has successfully detected that a digital input from an RMC is in the ON state, and this digital input is assigned to a Load Shed Zone. When Load Shedding is user initiated, this implies that a user has manually started the Load Shedding for this Zone.

To manually activate Load Shedding (i.e. User initiated), you must use the Toolbar on the Load Shedding Status window. The toolbar allows a user to Start, Stop, and Restart Load Shedding, as well as to view the Load Shedding Configurations.

The Start Load Shedding window appears when a user clicks the **Start** button. In this window, the user must select the Zones that are to Load Shed, and select how long this Load Shedding will last. Once the **Start** button is clicked, RAYCHEM Supervisor will begin the Load Shedding process and will automatically stop the Load Shedding process after the specified period has expired.
Note that during the time when a Zone is remotely activated for Load Shedding, if a user starts a user initiated Load Shedding for the same Zone, the user initiated load shedding will take priority for this Zone. The remotely activated Load Shedding will start again when the user initiated Load Shedding expires.

The Load Shedding Status of the Master Server or a Slave Server can be viewed by selecting the appropriated node from the tree view. The following window shows the Load Shedding Status for the Master Server. The right portion of the window shows the status including the Zone, Control Status, Start, Duration, and Initiator. The Start column shows the time when the Load Shed begins. The Duration column indicates the time frame this Load Shedding will last, and the Initiator column is the user that started this Load Shedding activity.

Figure 10-8 Start Load Shedding

Figure 10-9 Load Shedding Status
Section 11  – SCHEDULED EVENTS

The Scheduler automatically runs scheduled events based on the recurrence patterns specified by the user. Presently, three types of scheduled events are supported: Batch, Email Trend Data, and System Database Backup.

11.1 SETTING A SCHEDULED EVENT

Before Scheduled Events can be set up, the user must have permissions to Setup Scheduled Events. Refer to Section VII “Security” for details on how to configure permissions.

To bring up the Scheduler Main window, use the Tools drop-down menu and select Scheduled Events.

Figure 11-1 Scheduler Main window

11.1.1 EVENT TYPES

There are three types of scheduled events: the Batch event, an Email Trend Data event, and a System Database Backup event.

⚠️ IMPORTANT: A Batch or Trend Group must already have been created before you can set up a Batch or Email Trend Data event.
1. **Batch Event**

   When this type of event is selected, you must specify the Batch name that you want the Scheduler to run.

2. **Email Trend Data Event**

   When the Scheduler runs this type of event, it compresses the trend data from the selected Trend Group and emails the compressed file to the destination email address.

   **IMPORTANT:** A Trend Group must already be set up before you can use this type of event.

3. **Backup System Event**

   A Backup System event requires a destination path for the backup file. You can enable the option to append the date/time to the backup file name if you want to create a unique backup file each time. When the Scheduler runs this type of event, it will backup all the files in the ...\DB folder to the backup file. The files are compressed (Zipped) before they are backed up.

**Recurrence Patterns**

Each scheduled event can run in one of the five recurrence patterns. These are Hourly, Daily, Weekly, Monthly, and Once only.

1. **Once Only**

   A Once Only Recurrence Pattern can be set for any time in the future but will only run once.
Figure 11-3 Event with Once Only Occurrence Pattern

2. Hourly

An hourly Recurrence Pattern can be set to every hour or every N hours. N is a number between 1 and 24. A scheduled event with this type of recurrence pattern will repeat one or more times during the day.

Figure 11-4 Event with Hourly Recurrence Pattern
3. **Daily**

A Daily Recurrence Pattern can be set to once a day or once every N days. N is a number between 1 and 31.

![Figure 11-5 Event with Daily Recurrence Pattern](image)

4. **Weekly**

A Weekly Recurrence Pattern can be set to one or more days of every week.

![Figure 11-6 Event with Weekly Recurrence Pattern](image)
5. Monthly

A Monthly Recurrence Pattern can be set for a certain day of the month for one or more months.

![Edit Scheduled Event](image)

**Figure 11-7 Event with Monthly Recurrence Pattern**

**IMPORTANT:** The Start time defines when the scheduled event will become active, not necessarily when it will run. This allows the user to set up an event some time into the future.

The actual run time of the event occurs when all conditions have been met. For example, referring to Figure 12-7, the Backup event becomes active on Dec. 21, 2004, but will not run until the 26th day of December at 12:49PM, since these are the recurrence conditions.

### 11.1.2 Creating a New Scheduled Event

To create a new Scheduled Event:

1. Click the **Add** button and the New Event window is displayed.
2. Fill in the Name field and the Event Type parameters field. The event Name can have up to 50 characters.
3. After you have completed your edits, click the **OK** button to save and exit.

### 11.1.3 Editing a Scheduled Event

To edit a Scheduled Event, click the **Edit** button and the Edit Event window will display. Make your changes, and then click **OK** button to save and exit.

### 11.1.4 Deleting a Scheduled Event

To delete a scheduled event, choose a scheduled event then click the **Remove** button. You will be prompted to continue with the delete or cancel the operation. Select **Yes** to continue or **No** to cancel.

**IMPORTANT:** Once a scheduled event is deleted, it cannot be recovered.

### 11.1.5 Running a Scheduled Event Immediately

To force a scheduled event to run immediately, select the desired event, and then click the **Run** button. You will be prompted to continue with the run or to cancel the operation. Select **Yes** to continue or **No** to cancel.
11.2 RUNNING THE EVENT SCHEDULER

The Scheduler is automatically invoked when RAYCHEM Supervisor Master Server is started, and any scheduled events will run automatically. To view the status of the Scheduler, use the Tools drop-down menu and select **Scheduled Events**. The Scheduled Events window is displayed.

![Scheduler window](image)

**Figure 11-8 Scheduler window**

The All Scheduled Events window shows all of the scheduled events that are configured in the scheduler database. Each scheduled event includes a Name, Event Type, Next Run Time, Scheduled Time, Last Run Time, and Last Run Status column. To sort on a column, click on that column with your mouse.

In this window the user can Add, Remove, Edit, Run or Refresh scheduled events. The **Run** button allows the user to force an event to run before its scheduled time has elapsed. The Today's Events window shows all of the scheduled events that are to be run today. The columns for this window are similar to the columns in the All Scheduled Events window.

Using this window, you can view the details of an event, refresh the window, or skip an event. If clicked, the **Skip** button allows the user to stop an event from running as scheduled. However, if an event to be cancelled is a recurring event (such as an event that is triggered hourly), then it will skip to the next scheduled time (i.e.: 2 hours later).
RAYCHEM Supervisor provides several types of documentation parameters to allow you to link additional information to your Plant or devices. These include plant Group, Location, Line Equipment Number, Breaker Panel, and Controller Panel. Among these documentation types, Group is the most important since it is used in combination with the Users and Roles to provide security as mentioned in Section 6 “Security”.

Section 12.1 “Definitions and Terminology” describes in detail each type of documentation parameter. For a user to configure the plant documentation, the user must have Edit Roles/Users/Plant Documentation permission. This is a user permission and by default is granted to the ‘admin’ user.

It is important to plan ahead before implementing plant documentation for your EHT system. The selection windows in the Client software use plant documentation to convey the plant information to the user. If the documentation fields are clear, concise and well organized, the end users will benefit from the additional information provided.

12.1 DEFINITIONS AND TERMINOLOGY

This section describes the definition and terminology for the different types of documentation available in RAYCHEM Supervisor.

12.1.1 GROUP

A plant Group is a logical grouping used to represent a specific area of a plant. Devices such as GCCs and HTCs are assigned to Groups. Users assigned to a plant Group will have access to devices in that Group. The user’s level of access will be determined by the Role permissions assigned to the user for that Group.

Both the Group name and Group description can be up to 50 characters in length.

12.1.2 LOCATION

A Location can be used to represent a physical location, such as a particular part of the plant. Devices such as GCCs and HTCs are assigned to a Location. RAYCHEM Supervisor enforces the rule that a device can only be assigned to one Location. If the same device is assigned to another Location then it is automatically removed from the previous Location.

Both the location name and location description can be up to 50 characters in length.

12.1.3 LINE/EQUIPMENT NUMBER

A Line/Equipment Number can be used to represent a length of heater or section of pipe in the field. Devices such as HTCs are assigned to Line/Equipment Numbers. An HTC can be assigned to multiple Line/Equipment Numbers, and a Line/Equipment number can be assigned to multiple HTCs.

Both the Line/Equipment Number name and Line/Equipment description can be up to 50 characters in length.

12.1.4 BREAKER PANEL

A Breaker Panel can be used to represent the Breaker Panel that feeds power to GCCs and HTCs in the field. A device can be assigned to only one Breaker Panel. If a device is re-assigned to another Breaker Panel, it will be removed from the previous Breaker Panel.

Both the Breaker Panel name and Breaker Panel description can be up to 50 characters in length.
12.1.5 BREAKER NUMBER

A Breaker Number can be used to identify the specific branch circuit breaker in a breaker panel that provides power to the device. A Breaker Number can be up to 20 characters in length.

12.1.6 CONTROLLER PANEL

If the HTC (controller) is mounted in a control panel, the Controller Panel parameter can be used to represent the physical Controller Panel in the plant. Devices such as HTCs are assigned to Controller Panels and can be assigned to only one Controller Panel. If the same device is reassigned to another Controller Panel, then it is removed from the previous Controller Panel.

Both the Controller Panel name and Controller Panel description can be up to 50 characters in length.

12.1.7 CONTROLLER POSITION

A Controller Position can be used to represent the controller’s physical position in the controller panel. A Controller Position can be up to 15 characters long.

12.2 SETTING UP GROUPS

Before a user is allowed to set up Plant Documentation, he/she must have user permissions to Setup Roles/Users/Plant Documentation. Refer to Section 6 “Security” for details on how to set up user permissions.

![Group Setup Figure](image)

Figure 12-1 Group Setup

12.2.1 ADDING A NEW GROUP

Refer to Section 6.3.1 “Adding a New Group” for details.

12.2.2 EDITING A GROUP

Refer to Section 6.3.2 “Editing a Group”.

12.2.3 REMOVING A GROUP

Refer to Section 6.3.3 “Removing a Group” for details.

12.2.4 ASSIGNING DEVICES TO A GROUP

Refer to Section 6.3.4 “Assigning Devices to a Group” for details.

12.2.5 ASSIGNING USERS TO A GROUP

Refer to Section 6.3.5 “Adding Users to a Group” for details.
12.3 SETTING UP LOCATIONS

Before you can set up Locations, you must have user permission to Setup Roles/Users/Plant Documentation.

![Configure Locations](image1)

**Figure 12-2 Configure Locations**

**12.3.1 ADDING A NEW LOCATION**

To add a new location:

1. In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Location**.
2. From the Location window, click the **Add** button.
3. When the Add Location window is displayed, fill in the Location name and Location description. The maximum length for the Location name is 50 characters. The maximum length for the description is 50 characters.
4. When you have completed your edits, click the **OK** to save and exit.

![Add Location](image2)

**Figure 12-3 Add Location**

**12.3.2 EDITING A LOCATION**

To edit a location:

1. In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Location**.
2. From the Location window, click the Edit button.
3. When the Edit Location window displays, edit the Location name and description.
4. When you have completed your edits, click the OK to save and exit.

![Edit Location Window]

**Figure 12-4 Edit Location**

### 12.3.3 REMOVING A LOCATION

To remove a location:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Location.
2. From the Location window, click the Remove button.
3. When prompted to confirm the remove, click Yes to remove the Location otherwise click No to cancel.

### 12.3.4 ASSIGNING DEVICES TO A LOCATION

To assign devices to a location:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Location.
2. From the Location window, click the Assign Devices button.
3. When the Assign Devices to Location window is displayed, add and/or remove devices.
4. When you have completed your edits, click OK to save and exit.

![Assign Devices to Location Window]

**Figure 12-5 Assigning Devices to a Location**

### 12.4 SETTING UP LINE/EQUIPMENT NUMBERS

Before you can set up Line/Equipment Numbers, you must have user permissions to Setup Roles/Users/Plant Documentation.
12.4.1 ADDING A NEW LINE/EQUIPMENT NUMBER

To add a new line/equipment number:

1. In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Line/Equipment**.
2. From the Line/Equipment window, click the **Add** button.
3. When the Add Line/Equipment Number window is displayed, fill in the Line/Equipment name and Line/Equipment description. The maximum length for the Line/Equipment name is 50 characters. The maximum length for the description is 50 characters.
4. When you have completed your edits, click **Add** to save and exit.

12.4.2 EDITING A LINE/EQUIPMENT NUMBER

To edit a line/equipment number:

1. In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Line/Equipment**.
2. From the Line/Equipment Number window, click the **Edit** button.
3. When the Edit Line/Equipment window displays, edit the Line/Equipment name and description.
4. When you have completed your edits, click **OK** to save and exit.
12.4.3 REMOVING A LINE/EQUIPMENT NUMBER

To remove a line/equipment number:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Line/Equipment.
2. Once the Line/Equipment window is displayed, click the Remove button.
3. When prompted to confirm the remove, click Yes to remove the Line/Equipment otherwise click No to cancel.

12.4.4 ASSIGNING DEVICES TO A LINE/EQUIPMENT NUMBER

To assign devices to a line/equipment number:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Line/Equipment Number.
2. Once the Line/Equipment Number window is displayed, click the Assign Devices button.
3. When the Assign Devices to Line/Equipment window displays, add and/or remove devices.
4. When you have completed your edits, click OK to save and exit.

Figure 12-8 Edit Line/Equipment Number

Figure 12-9 Assigning Devices to a Line/Equipment Number
12.5 SETTING UP BREAKER PANELS

Before you can set up Breaker Panels, you must have user permission to Setup Roles/Users/Plant Documentation.

![Breaker Panel Window](image1.png)

**Figure 12-10 Breaker Panel**

### 12.5.1 ADDING A NEW BREAKER PANEL

To add a new breaker panel:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Breaker Panel.
2. Once the Breaker Panel window is displayed, click the Add button.
3. When the Add Breaker Panel window is displayed, fill in the Breaker Panel name and Breaker Panel description. The maximum length for the Breaker Panel name is 50 characters. The maximum length for the description is 50 characters.
4. When you have completed your edits, click Add to save and exit.

![Add Breaker Panel Window](image2.png)

**Figure 12-11 Add Breaker Panel**
12.5.2 EDITING A BREAKER PANEL

To edit a breaker panel:

1. In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Breaker Panel**.
2. From the Breaker Panel window, click the **Edit** button.
3. When the Edit Breaker Panel window displays, edit the Breaker Panel name and description.
4. When you have completed your edits, click **OK** to save and exit.

![Figure 12-12 Edit Breaker Panel](image-url)

12.5.3 REMOVING A BREAKER PANEL

To remove a breaker panel:

In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Breaker Panel**.

From the Breaker Panel window, click the **Remove** button.

When prompted to confirm the removal, click **Yes** to remove the Breaker Panel otherwise click **No** to cancel.

12.5.4 ASSIGNING DEVICES TO A BREAKER PANEL

To assign devices to a breaker panel:

1. In the Client’s main window, use the System drop-down menu and select **Plant Documentation**, then **Breaker Panel**.
2. From the Breaker Panel window, click the **Assign Devices** button.
3. When the Assign Devices to Breaker Panel window displays, add and/or remove devices.
4. When you have completed your edits, click **OK** to save and exit.

![Figure 12-13 Assigning Devices to a Breaker Panel](image-url)
12.6 SETTING UP CONTROLLER PANELS

Before you can set up Controller Panels, you must have user permission to Setup Roles/Users/Plant Documentation.

12.6.1 ADDING A NEW CONTROLLER PANEL

To add a new controller panel:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Controller Panel.
2. Once the Controller Panel window is displayed, click the Add button.
3. When the Add Controller Panel window is displayed, fill in the Controller Panel name and Controller Panel description. The maximum length for the Controller Panel name is 50 characters. The maximum length for the description is 50 characters.
4. When you have completed your edits, click Add to save and exit.

12.6.2 EDITING A CONTROLLER PANEL

To edit a controller panel:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Controller Panel.
2. Once the Controller Panel window is displayed, click the Edit button.
3. When the Edit Controller Panel window displays, edit the Controller Panel name and description.
4. When you have completed your edits, click OK to save and exit.
12.6.3 REMOVING A CONTROLLER PANEL

To remove a controller panel:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Controller Panel.
2. From the Controller Panel window, click the Remove button.
3. When prompted to confirm the remove, click Yes to remove the Controller Panel otherwise click No.

12.6.4 ASSIGNING DEVICES TO A CONTROLLER PANEL

To assign devices to a controller panel:

1. In the Client’s main window, use the System drop-down menu and select Plant Documentation, then Controller Panel.
2. From the Controller Panel window, click the Assign Devices button.
3. When the Assign Devices to Controller Panel window is displayed, add and/or remove devices.
4. When you have completed your edits, click OK to save and exit.

Figure 12-16 Edit Controller Panel

Figure 12-17 Assigning Devices to Controller Panel
RAYCHEM Supervisor allows you to display seven different plant views. Each plant view shows the relationship between the devices and the Plant Documentation for your EHT System. The seven plant views are: View by Devices, View by Groups, View by Servers, View by Locations, View by Line/Equipment Number, View by Breaker Panel, and View by Controller Panel.

To select a Plant View, click the desired tab on the tree view window located on the left hand side of the display.

12.7.1 VIEWING BY DEVICES

The View by Device displays a list of GCCs and/or HTCs in the list window. The tree view window on the left of the main window will display the hierarchy of all of the GCCs and HTCs. Any devices that have no children (subordinate devices) are placed in the More Devices group (i.e.: HTC-direct devices, and GCCs with no children).

On the View by Device screen, there is an option to include Plant documentation along with the rest of the device data. One of the following Plant documentation can be added such as Location, Line Equipment Number, Controller Panel or Breaker Panel. This option is available when you use the mouse and right click on the header of the empty column near the end of screen.
12.7.2 VIEWING BY GROUP

A Group is a user-defined label for grouping GCCs and HTCs in a plant. Each GCC and HTC can be assigned to a unique or a common Group.

For this view, the window on the left of the main window displays a tree representation of the Groups configured in your EHT System. Each Group node can be expanded to show all of the GCCs and HTCs associated with this particular Group. The window on the right will display a list of Groups if the System node in the tree view is selected, or a list of GCCs and HTCs if a Group node in the tree view is selected.

![Figure 12-21 Plant View by Group](image)

12.7.3 VIEWING BY SERVER

For this view, the window on the left of the main window displays a tree representation of the Servers configured in your EHT System. Each server node can be expanded to show all of the GCCs and HTCs associated with this particular server. The window on the right will display a list of servers if the System node on the tree view is selected, or a list of GCCs and HTCs if a server node on the tree view is selected.

![Figure 12-22 Plant View by Server](image)
12.7.4 VIEWING BY LINE/EQUIPMENT NUMBER

A Line/Equipment Number is a user-defined label for grouping devices in the plant. Each device can be identified with one or more Line/Equipment Numbers.

For this view, the window on the left of the main window displays a tree representation of the Line/Equipment Numbers configured in your EHT System. Each Line/Equipment Number node can be expanded to show all of the GCCs and HTCs associated with this particular Line/Equipment Number. The window on the right will display a list of Line/Equipment Numbers if the System node on the tree view is selected, or a list of GCCs and HTCs if a Line/Equipment Number node on the tree view is selected.

Figure 12-23 Plant View by Line/Equipment Number

12.7.5 VIEWING BY LOCATION

A Location is a user-defined label for grouping GCCs and HTCs in a plant. Each GCC and HTC can be assigned to a unique or to a common Location.

For this view, the window on the left of the main window displays a tree representation for all of the Locations configured in your EHT System. Each Location node in the tree view can be expanded to show all of the GCCs and HTCs associated with this particular Location. The window on the right will display a list of Locations if the System node in the tree view is selected, or a list of GCCs and HTCs if a Location node in the tree view is selected.

Figure 12-24 Plant View by Location
12.7.6 VIEWING BY BREAKER PANEL

A Breaker Panel is a user-defined label for grouping devices in the plant. Each device can be identified with one Breaker Panel.

For this view, the window on the left of the main window displays a tree representation of the Breaker Panels configured in your EHT System. Each Breaker Panel node can be expanded to show all of the GCCs and HTCs associated with this particular Breaker Panel. The window on the right will display a list of Breaker Panels if the System node on the tree view is selected, or a list of GCCs and HTCs if a Breaker Panel node on the tree view is selected.

Figure 12-25 Plant View by Breaker Panel
12.7.7 VIEWING BY CONTROLLE R PANEL

A Controller Panel is a user-defined label for grouping devices in the plant. Each device can be identified with one Controller Panel.

For this view, the window on the left of the main window displays a tree representation of the Controller Panels configured in your EHT System. Each Controller Panel node can be expanded to show all of the GCCs and HTCs associated with this particular Controller Panel. The window on the right will display a list of Controller Panels if the System node on the tree view is selected, or a list of GCCs and HTCs if a Controller Panel node on the tree view is selected.

Figure 12-26 Plant View by Controller Panel
WORKING WITH OFFLINE DEVICES

With the Offline feature, you can install and configure a RAYCHEM Supervisor EHT system without the presence of any field devices. However, you should have documentation for the actual hardware that will be used in the field available.

The Offline feature can be useful in situations where the EHT system is designed and the RAYCHEM Supervisor software will be configured prior to connection to a live system. When an EHT system is created using the Offline feature, RAYCHEM Supervisor does not perform alarm monitoring or data trending on any GCCs, NGC-UITs, or HTCs that are in Offline mode. Changes to Offline devices are saved to the RAYCHEM Supervisor database only, rather than to the actual field devices when a device is Online.

A Set Online function is available to synchronize the configuration of the field device hardware with the configuration in the database. The Set Offline and Set Online functions are available for different device levels, such as System, GCC, NGC-UIT, or HTC. In addition, the Set Online function has the option “Update select device(s) with the offline settings.” This option is explained in detail in the following sections.

13.1 SETTING DEVICES OFFLINE

This section describes the various ways to make GCCs, NGC-UITs, and HTCs offline. To display the Set Device(s) Offline window, you need to use the Device drop-down box and select the Set Offline menu item.

13.1.1 SETTING EHT SYSTEM OFFLINE

Selecting the EHT system on the tree view and proceeding to display the Set Devices(s) Offline window will show a list of parent devices (such as GCCs) that are currently in Online mode. You must use the Select check box to select one or more device(s) to set to Offline mode. After you've completed your selections, click the Start button to start the operation. While the operation is running, you will see the status of each device in the Progress window. If you choose you can stop the operation using the Stop button.

Figure 13-1 Set EHT System Offline

IMPORTANT: Setting a parent device such as a GCC to Offline will cause all of its children to be set to Offline as well.

IMPORTANT: When a GCC, NGC-UIT, or HTC is set Offline, no changes are made to the field hardware. RAYCHEM Supervisor recognizes that the GCC, NGC-UIT, or HTC is Offline and it will disable alarm monitoring or data trending for the device.
13.1.2 SETTING A GCC OR NGC-UIT OR NGC-40 BRIDGE OFFLINE

Once you have selected a GCC or NGC-UIT or NGC-40 Bridge on the tree view and displayed the Set Devices(s) Offline window, this GCC or NGC-UIT or NGC-40 Bridge will be included on the list if it is currently in Online mode. You must use the Select check box to select the GCC or NGC-UIT or NGC-40 Bridge. After you’ve checked the selection, click the Start button to start the operation. While the operation is running, you will see the running status on the Progress window. All children of the GCC or NGC-UIT or NGC-40 Bridge will be set to Offline as you will see in the Progress window. If you choose you can stop the operation using the Stop button.

Figure 13-2 Set a GCC Offline

**IMPORTANT:** When a GCC, NGC-UIT, or NGC-40 Bridge or any of the children devices is Offline, no changes are made to the settings in the field device hardware. RAYCHEM Supervisor recognizes that the GCC, or NGC-UIT, or NGC-40 Bridge or any of the children devices is Offline and it will disable alarm monitoring or data trending for this device.

13.1.3 SETTING AN HTC-DIRECT OR NGC-20 DIRECT OFFLINE

If you have selected the More Devices node on the tree view and you display the Set Devices(s) Offline window, a list of HTC-direct (including NGC-20 direct) devices that are currently in Online mode will be shown. You must use the Select check box to select one or more device(s) to set to offline mode. After you’ve made your selection, click the Start button to start the operation. While operation is running, you will see the status on the Progress window. If you choose, you can stop the operation using the Stop button.

Figure 13-3 Set HTC-direct Offline
**IMPORTANT:** When an HTC-direct is Offline, no changes are made to the settings in the field device. RAYCHEM Supervisor recognizes that the HTC is Offline and it will disable alarm monitoring or data trending for this HTC.

**IMPORTANT:** The More Devices tree node includes HTC-Direct as well any parent devices with no children (i.e.: GCCs with no HTCs).

### 13.1.4 SETTING AN HTC OFFLINE

If you have selected an HTC on the tree view and you display the Set Devices(s) Offline window, this HTC will display on the list of devices if it is currently in Online mode. You must use the Select check box to select this HTC. After you’ve checked the selection, click the Start button to start the operation. While operation is running, you will see the status on the Progress window. If you choose you can stop the operation using the Stop button.

![Figure 13-4 Set HTC Offline](image)

**IMPORTANT:** When an HTC is Offline, no changes are made to the settings in the field device. RAYCHEM Supervisor recognizes that the HTC is Offline and it will disable alarm monitoring or data trending for this HTC.

### 13.2 SETTING DEVICES ONLINE

This section describes the various ways to make GCCs, NGC-UITs, NGC-40 Bridges and HTCs Online.

#### 13.2.1 SETTING THE EHT SYSTEM ONLINE

If you have selected the EHT system on the tree view and display the Set Devices(s) Online window, a list of parent devices such as a GCC that are currently in Offline mode will be shown. You must use the Select check box to select one or more devices(s) to set to Offline mode. You can also select the option to Update selected device(s) with Offline settings if you want RAYCHEM Supervisor to update your field devices with the settings from the database.

After you’ve completed your selections, click the Start button to start the operation. While operation is running, you will see the status of each device on the Progress window. If you choose you can stop the operation using the Stop button.
IMPORTANT: Setting a parent device such as a GCC to Online will cause all of its children to be set to Online as well. If the Update selected device(s) with Offline settings is checked then each HTC device will be updated with the RAYCHEM Supervisor database settings as well.

IMPORTANT: If the Using the Update selected device(s) with Offline settings is checked, the set Online operation can take some time to complete. Depending on the device and the number of children it has, it can take more than an hour to finish.

13.2.2 SETTING A GCC OR NGC-UIT OR NGC-40 BRIDGE ONLINE

If you have selected a GCC or an NGC-UIT or an NGC-40 Bridge on the tree view and you display the Set Devices(s) Online window, the GCC or NGC-UIT or NGC-40 Bridge will be shown in the list if it is currently in Offline mode. You must use the Select check box to select this device. You can also select the option to Update selected device(s) with Offline settings if you want RAYCHEM Supervisor to update the GCC or NGC-UIT or NGC-40 Bridge settings with the information stored in the RAYCHEM Supervisor database. After you've checked the selection, click the Start button to start the operation. While operation is running, you will see the status in the Progress window.

All children of the GCC or NGC-UIT or NGC-40 Bridge (i.e.: all HTCs, Circuits, NGC-40 Modules, RMMs, NGC-30s, etc.) will be set to Online as well. If you choose you can stop the operation using the Stop button.

13.2.3 SETTING AN HTC-DIRECT ONLINE

If you have selected the More Devices node on the tree view and display the Set Devices(s) Online window, a list of HTC-Direct devices that are currently in Offline mode will be shown. You must use the Select check box to select one or device(s) to set online. You can also select the option to Update selected device(s) with Offline settings if you want RAYCHEM Supervisor to update your
field devices with the settings from the database. After you’ve made your selection, click the **Start** button to start the operation. While operation is running, you will see the status in the Progress window. If you choose, you can stop the operation using the **Stop** button.

![Figure 13-7 Set HTC-direct Online](image)

### 13.2.4 SETTING AN HTC ONLINE

If you have selected an HTC on the tree view and you display the Set Devices(s) Online window, this HTC will be included in the list if it is currently in Offline mode. You must use the **Select** check box to select this HTC. You can also select the option to Update selected device(s) with Offline settings if you want RAYCHEM Supervisor to update your field devices with the settings from the database. After you’ve checked the selection, click the **Start** button to start the operation. While operation is running, you will see the status in the Progress window. If you choose, you can stop the operation using the **Stop** button.

![Figure 13-8 Set HTC Offline](image)

### 13.3 WORKING WITH OFFLINE DEVICES

RAYCHEM Supervisor manages all devices such as GCCs, NGC-UIT, NGC-40 Bridges, etc. in Offline mode in the same way as when they are Online. The only difference is that all communications to the devices are disabled. Most of the functions that apply to a GCC, NGC-UIT, NGC-40 Bridge, etc. will work in the same fashion. Functions such as installing or configuring a GCC, NGC-UIT, NGC-40 Bridge, etc. use the same display window for either mode.

To distinguish a device in Offline mode, the color used to display the tag on the tree view is grey. The **Offline** icon is placed in the lower left-hand corner of the configuration windows to identify offline devices.

![Offline Icon](image)
13.3.1 INSTALLING A GCC OR NGC-UIT OR NGC-40 BRIDGE OFFLINE

To add a GCC or NGC-UIT or NGC-40 Bridge Offline, use the Device drop-down menu and select GCC, then Add GCC, or select NGC-UIT and then Add UIT, or select NGC-40 then Add NGC-40 Bridge Direct. Another way is to select the EHT System node on the tree view and use the right mouse click to bring up the context menu, and then select Add GCC or select Add UIT or Add NGC-40 Bridge Direct from the context menu.

When the Add Device window displays, you will notice a checkbox labeled Set GCC Offline or when adding an NGC-UIT or NGC-40 Bridge, a checkbox labeled Set Offline. You must enable this checkbox in order to add a GCC or NGC-UIT or NGC-40 Bridge in the Offline mode. Once you have edited the fields in the Add Device window, click the OK button to save and exit. When adding an offline GCC, RAYCHEM Supervisor will automatically create a GCC with the device model set to GCC-780. If you want to change the device model, you can use the Configure GCC function (refer to Section 13.3.4 “Editing a GCC Offline” for more details).

13.3.2 INSTALLING AN HTC OFFLINE

To install an HTC Offline:

1. Select a parent GCC in the tree view.
2. Click the Add HTC toolbar button (or use the Device drop-down menu).
3. Select GCC, then select Add HTC.
4. When the Add a New HTC window is displayed, edit the fields for the new HTC.
5. When you have completed your edits, click OK to save and exit. RAYCHEM Supervisor will automatically create an HTC with its device model set to 920. If you want to change the device model type, you can use the Configure HTC function (refer to Section 14.3.5 “Editing an HTC Offline” for more details).
IMPORTANT: When adding a NGC-UIT Circuit or NGC-40 module offline, select the appropriate NGC-UIT or NGC-40 Bridge then click the Add Device toolbar menu. Fill in the information on the screen and click OK to save.

13.3.3 INSTALLING AN HTC-DIRECT OFFLINE

To install an HTC-Direct Offline:

1. Select the EH'T system node on the tree view.
2. Click the Add HTC toolbar button (or use the Device drop-down menu), select HTC, then Add HTC-Direct.
3. When the Add a new HTC with Direct Connection to the Server window displays, edit the fields for the new HTC.
4. When you have completed your edits, click OK to save and exit. RAYCHEM Supervisor will automatically create an HTC with device model set to 920. If you want to change the device model, you can use the Configure HTC function (refer to Section 13.3.5 “Editing an HTC Offline” for more details).
13.3.4 EDITING A GCC OR NGC-UIT OR NGC-40 BRIDGE OFFLINE

The configuration of a GCC, an NGC-UIT or an NGC-40 Bridge in Offline mode can be edited using the GCC, or the NGC-UIT or the NGC-40 Bridge configuration windows. To bring up the appropriate configuration window, click on the desired device, and then select the Configure option in the right click menu or click the Configure toolbar button. This window is identical to the regular device configuration window except that you can change the device model and firmware field.

After you have completed your edits, use the Apply button to save without exiting or the OK button to save and exit.

**IMPORTANT:** When you are changing the device model, some fields will get disabled or enabled depending on the device model selected. Make sure that the device model and firmware version settings agree with the actual device that will be installed later.

![Figure 13-12 Configure GCC in Offline Mode](image)

13.3.5 EDITING AN HTC OFFLINE

The configuration of an HTC or HTC-Direct in Offline mode can be edited using the HTC Configuration window. To edit the HTC configuration, click the desired HTC, then select the Configure option in the right click menu or click the Configure toolbar button. This window is identical to the regular HTC configuration window except that you can change the HTC device model and firmware fields.

After you have completed your edits, use the Apply button to save without exiting or the OK button to save and exit.

**IMPORTANT:** When you are changing the HTC device model, some fields will get disabled or enabled depending on the device model selected. Make sure that the device model and firmware version settings agree with the actual device that will be installed later.
13.3.6 REMOVING A GCC, AN NGC-UIT OR AN NGC-40 BRIDGE OFFLINE

To remove a GCC, or an NGC-UIT or an NGC-40 Bridge in offline mode:

1. Click the desired device, and then select the Remove Device option from the right-click menu. The Remove an existing device window is displayed.
2. Click the OK button to complete the remove.

13.3.7 REMOVING AN HTC OR HTC-DIRECT OR NGC-UIT CIRCUIT OR NGC-40 MODULE OFFLINE

To remove an HTC, or HTC-direct, or NGC-UIT Circuit or NGC-40 module in Offline mode:

1. Click the desired device, then select the Remove Device option from the right-click menu. You will be prompted to confirm the remove.
2. Click Yes to continue with the remove or No to cancel.

13.3.8 CHANGING GCC, NGC-UIT, OR NGC-40 BRIDGE COMMUNICATIONS OFFLINE

To change the GCC, NGC-UIT or NGC-40 Bridge communications settings for a device in Offline mode, select the desired device on the tree view, then use the Device drop-down menu, click on the device, and finally click the Change Communications menu item. The Change Communication window is displayed. Make the desired changes and click the OK button to save and exit.
13.3.9 CHANGING AN HTC OR HTC-DIRECT COMMUNICATIONS OFFLINE

To change the HTC communications settings for a HTC or HTC-direct in Offline mode:

1. Select the desired HTC on the tree view, then from the Device drop-down menu, click on the HTC.
2. Click the Replace HTC menu item. The Replace HTC window is displayed.
3. Make the desired changes and click the OK button to save and exit.

Figure 13-15 Change HTC-direct Communication

Figure 13-16 Change HTC Communications
RAYCHEM Supervisor provides several useful tools to convert, export, import, back up, and restore RAYCHEM Supervisor database files.

14.1 EXPORT AND IMPORT

The Export function allows the user to export system devices and plant documentation, and save the data in an XML-format file or a CSV data file. The user can use the Import function to import data from an XML-format file or a CSV data file.

14.1.1 EXPORT

Using the Export function, the user can choose to export system devices or system plant documentation. The data can be saved in an XML file or a CSV file.

**IMPORTANT:** The Export function is used mainly for exchanging basic information between RAYCHEM Supervisor systems. To back up all system data, use of the system back up function is recommended, since this will capture all system database information.

To use the Export function, click the File drop-down menu and select Export.

14.1.2 IMPORTING

The user can use the Import function to import system devices, device drawings, operator notes/comments, plant documentation, batches, recipes, trend groups, templates, and scheduled
events. The data file must be in the proper format in order for RAYCHEM Supervisor to detect the types of data and import correctly.

**IMPORTANT:** Some data elements are dependent on others. For example, trend groups refer to devices, so you cannot import trend groups without importing the devices.

To use the Import function, click the File drop-down menu and select **Import**.

In the import window, choose a data file to import. The data file will be parsed and the contents shown in the Items to be imported window, as shown in Figure 14-4 Map to Existing Server.

The user can expand the tree view nodes to see the data items that will be imported.

**IMPORTANT:** Before clicking the **Import** button to import the data, the user must map the devices to an existing Server. The imported data file contains Server IP addresses and ports, which are shown in the import windows in IP:Port format.

In a target system that only has a single Server (the Master Server), all imported devices will automatically be mapped to the Master Server. In a multi-Server target system, each Server to be imported from the source file must be mapped to a corresponding Server already present in the target system. To do this, right click on the imported Server tree nodes in red text to choose an existing Server from the Map To list, as shown in Figure 14-4 Map to Existing Server.

This process defines to which Server the actual devices will be physically connected in the target system.
The following list includes rules that the Import function follows:

The Replace duplicates with imported items option only applies to devices and plant documentation.

Batches are imported as global batches.

Trend groups are imported as global trend groups.

Imported trend groups are disabled automatically.
If a device has no plant group information, it will be imported to the default plant group, otherwise the device will be imported to its specified group. If those groups do not exist in the system, they will be created automatically.

If a device has no location information, it will be imported to the default location, otherwise the device will be imported to its specified location. If the location does not exist in the system, it will be created automatically.

If a device has no controller panel information, it will be imported to the default controller panel; otherwise the device will be imported to its specified controller panel. If the controller panel does not exist in the system, it will be created automatically.

If a device has no breaker panel information, it will be imported to the default breaker panel, otherwise the device will be imported to its specified breaker panel. If the breaker panel does not exist in the system, it will be created automatically.

If a device has line/equipment numbers which do not exist in the system, they will be created automatically.

14.2 BACK UP AND RESTORE THE SYSTEM DATABASES

To back up a SQL Express system database, use the RAYCHEM Supervisor Database Backup function.

To restore from a SQL Express backup file, use the RAYCHEM Supervisor Master Server Configuration utility. Refer to the Sections below for additional details.

**IMPORTANT:** The internal RAYCHEM Supervisor Database Backup feature cannot be used with Multi-User/Server (SQL Server-based) systems. For these installations, use the Database Maintenance Plan Wizard in the Microsoft SQL Server Enterprise Manager (see Appendix D for more information).

14.2.1 BACK UP THE SYSTEM DATABASE

The user can use the Database Backup function to back up the system database. The backup file is saved in the Backup folder under the master server installation folder. The backup file is named as RAYCHEM SupervisorDB2012-11-23-12h04m55s.bak, with the date time information being the moment of the backup.

To use the Database Backup function, use the System menu drop-down list and choose Database Backup.

14.2.2 RESTORE THE SYSTEM DATABASE

To restore RAYCHEM Supervisor backup database, the Master Server Configuration Utility can be used. This utility can be run directly from the Master Server installation folder or using the Start\Program menu. Follow the on screen instructions to restore your RAYCHEM Supervisor database. This utility will automatically stop your Master Server, then restart your Master Server when the restore procedure is completed.
14.3 CONVERTING RAYCHEM SUPERVISOR DATABASES

Users upgrading from RAYCHEM Supervisor 1.3X (referred to as RAYCHEM SupervisorV1) can use the RAYCHEM SupervisorConvert.exe Database Conversion Utility to convert their RAYCHEM SupervisorV1 databases into an XML-format data file. The data file can be imported into the system using the Import function (refer to Section 14.1.2 for use of the Import feature).

It is recommended that you set up plant documentation first on RAYCHEM SupervisorV1 before converting the RAYCHEM SupervisorV1 database.

Please refer to the “RAYCHEM Supervisor Database Conversion Utility” instructions in Appendix C of this document for more information.

14.4 CONVERTING TRACEMASTER DATABASES

Users upgrading from TraceMaster must first use the TraceMaster DB Conversion Utility to convert their TraceMaster databases into the RAYCHEM Supervisor 1.3X database format, after which instructions in Section 14.3 can be followed to convert the database to the RAYCHEM Supervisor XML-format.

To start the TraceMaster DB Conversion Utility:

1. Select the TraceMaster DB Conversion Utility from the RAYCHEM Supervisor 1.3X Program file folder or use the Start button and navigate to the RAYCHEM Supervisor program folder. The TraceMaster DB Conversion Utility window is displayed. A set of default paths are assigned to the TraceMaster and RAYCHEM Supervisor Database Path fields.
2. If the paths are different for your computer, use the Browse button to select the TraceMaster and/or RAYCHEM Supervisor databases.
3. Click OK to start the operation.

**IMPORTANT:** Due to differences in functionality, some information will not be converted. These include Batches and Data Trend Setups.

After the conversion is complete, you must use the RAYCHEM Supervisor HTC Configuration Loader function to synchronize the database information with the field device.
14.5 CONVERTING PYROMASTER DATABASES

Users upgrading from PyroMaster must first convert their PyroMaster database into the RAYCHEM Supervisor 1.3X database format, and then follow the steps outlined in Section 14.3.

When RAYCHEM Supervisor 1.3X is installed, it will automatically detect the PyroMaster databases, and convert them into the RAYCHEM Supervisor 1.3X database format.
When you first install RAYCHEM Supervisor software on to your computer it will run in DEMO time restricted mode. In this mode, the software will limit the number of simultaneous users to four and no Slave servers will be supported.

The software will run continuously for 14 days, after which it will expire. When the system has expired no user will be allowed to login and you must stop and start the Master Server Service to reset the expiry timer.

To eliminate the expiry timer, you must:

1. Register your software with nVent.
2. Get a free activation code to activate your software. This free activation sets your copy of RAYCHEM Supervisor to a non-time restricted, fully operational mode.

There are two versions of RAYCHEM Supervisor software available:

1. The Standard version of the software includes licenses for up to four Users and no Slave servers.
2. RAYCHEM Supervisor with Multi-user/server Capability will be limited to the number of users and Slave Server connections that you have purchased. Along with your purchase of a licensed copy of RAYCHEM Supervisor, you will receive a Configuration (Config) Code. This Config code will be used to generate a Request code, and subsequently activate your software.

**IMPORTANT:** The Standard version of RAYCHEM Supervisor supports only Microsoft SQL Express databases. If Microsoft SQL Server is required due to your system’s size or configuration, you must purchase a licensed version of RAYCHEM Supervisor with Multi-User/Server Capability.

### 15.1 ACTIVATE SOFTWARE LICENSE

Using a Client computer’s main window, click the Help drop-down menu and select *Software License*, then *Activate*. The License Activation window will be displayed.

You can perform three types of activation using the Activate Software License window.

#### 15.1.1 ACTIVATE A DEMO VERSION

If you did not purchase your copy of the RAYCHEM Supervisor software and would like to activate it:

1. Select *Activate DEMO to Standard Version* from the Activation Type drop-down box. This process will convert your copy from DEMO time-restricted mode into non-time restricted Standard mode.
2. A set of Configuration (Config) Codes will be filled in for you in the Config Code boxes, and you may click the *Generate Request Code* button to generate a Request Code.
Once you have the Request Code, you can use it to get an Activation Code from nVent. To activate using the Internet, go to the nVent Website at nVent.com and follow the links to the Supervisory Software section of the Website. Use the RAYCHEM Supervisor Registration selection to start the activation process. You must have your Request Code available as you will be asked to provide it.

1. Once you have obtained your Activation Code, enter it into the Activation Code boxes and click the Activate Now button. If there are no errors, you will see a message indicating a successful activation.

15.1.2 ACTIVATE A NEW LICENSE

If you have purchased your copy of RAYCHEM Supervisor with Multi-User/Server Capability and you need to activate it, locate the Configuration (Config) Code label located on the case of your RAYCHEM Supervisor CD.

To activate a new license:

1. Select Activate New License from the Activation Type drop-down menu.
2. Enter the Config Code on the label into the Config Code boxes.
3. Click the Generate Request Code button. If the Config Code is valid, the Request Code text boxes will be filled in with a Request Code.
4. Once you have the Request Code, you can use it to get an Activation Code from nVent. To activate using the Internet, go to the nVent Website at nVent.com and follow the links to the Supervisory Software section of the Website. Use the RAYCHEM Supervisor Registration selection to start the activation process. You must have your Request Code available as you will be asked to provide it.
5. Once you have obtained your Activation Code, enter it into the Activation Code boxes and click the Activate Now button. If there are no errors, you will see a message indicating a successful activation.

15.1.3 ACTIVATE AN UPGRADE

When upgrading the number of Server and/or User licenses for an existing copy of RAYCHEM Supervisor software with Multi-User/Server Capability, you will need to activate the additional licenses. Locate the Configuration (Config) Code label located on the case of your RAYCHEM Supervisor Upgrade CD.

To activate an Upgrade:

1. Select Activate License Upgrade from the Activation Type drop-down menu.
2. Enter the Config Code on the label into the Config Code boxes.
3. Click the **Generate Request Code** button. If the Config Code is valid, the Request Code text boxes will be filled in with a Request Code.

4. Once you have the Request Code, you can use it to get an Activation Code from nVent. To activate using the Internet, go to the nVent Website at nVent.com and follow the links to the Supervisory Software section of the Website. Use the RAYCHEM Supervisor Registration selection to start the activation process. You must have your Request Code available as you will be asked to provide it.

5. Once you have obtained your Activation Code, enter it into the Activation Code boxes and click the **Activate Now** button. If there are no errors, you will see a message indicating a successful activation of your upgrade.

You may verify the upgraded number of Server and/or User licenses by logging into RAYCHEM Supervisor and using the Help → About window to display the total number of licenses.

![Figure 15-2 About RAYCHEM Supervisor](image)

### 15.1.4 UPGRADE SQL SERVER LICENSES

Once you have completed the upgrade process, increment the number of SQL Server licenses that you are approved to use. Make note of the total number and type of SQL Server 2000 Client Access Licenses (CALs) that you now own by looking at the summary in the RAYCHEM Supervisor Help → About window (See Figure 14-1-3: in this example, there are a total of 2 Device + 9 User CALS for a total of 11 SQL Server CALs).

1. On the computer where you have installed SQL Server, click **Start → Control Panel → SQL Server 2000 Licensing Setup.**
Figure 15-3 SQL Licensing Mode

1. When prompted to choose the Licensing Mode, select the Per Seat mode and enter the total number of CALs (devices) that you noted on the RAYCHEM Supervisor Help → About window.

15.1.5 UPGRADE WINDOWS SERVER LICENSES

Upgrading the number of Slave Servers or Users in a RAYCHEM Supervisor system will also require that you increase the number of Microsoft Windows® 2003 Server or Windows® 2000 Server licenses that you own.

The user is responsible for ensuring that the proper licensing following the latest requirements is obtained from Microsoft for legal use of Windows® Server and User or Device connections.

A number of options for Windows Server Client Access Licenses (CALs) are available from Microsoft. For a detailed description of the various options, see the Microsoft Website at www.microsoft.com/resources/sam/lic_cal.mspx.

Typical RAYCHEM Supervisor systems will use a mix of Device and User CALs. You will need to purchase a separate Windows Server Device CAL for each Master and Slave Server and a separate Windows Server User CAL for each User in your RAYCHEM system. You can verify the number of each type of Windows Server CAL that you require by looking at the summary in the RAYCHEM Supervisor Help → About window (See Figure 15-2 About RAYCHEM Supervisor).

15.2 REGISTERING ONLINE

Click “Register” under the Help pull down menu in the RAYCHEM Supervisor Client main screen to complete the registration form online.

15.3 TRANSFERRING A LICENSE TO ANOTHER COMPUTER

A Software License may be transferred from one computer to another. In order to transfer the license to a different computer, you must have a valid license in the computer presently running the RAYCHEM Supervisor Master software.
Use the following steps to transfer a license:

1. Install the RAYCHEM Supervisor Master Server and Client software onto the new computer. This computer should be connected to your plant or office network.
2. On the new computer, start the Master Server service (refer to Section 4.2 "Starting Your RAYCHEM Supervisor Master or Slave Server"), then start the Client software. Log in to the Master server using the default user 'admin'.
3. Insert a blank floppy disk or a removable disk (also known as a memory stick, flash or USB drive) into the new computer.
4. On the new computer’s Client main window, use the Help drop-down menu and select **Software License** and **Transfer**. Once the Software Transfer window displays, select the ‘Create a blank software license on to a removable disk’ option and select the drive letter that corresponds to the removable disk that you have installed in step 3 above.
5. Click the **OK** button to start the process.

![Software License Transfer](image)

Figure 15-4 Create a Blank Software License

6. Insert the blank software license removable disk created in the previous step into the existing Master Server computer. Again, use the Help drop-down menu and select **Software License** and **Transfer**. Select the ‘Transfer license from computer to a removable disk’ option and click the **OK** button to transfer the software license to the removable disk. The old Master Server computer will be updated to DEMO mode.
Finally, install the removable disk from step 6 into the drive on the new computer and select **Software License** and **Transfer** using the Help drop-down menu. Select the 'Transfer license from a removable disk to computer' option and click the **OK** button. This completes the transfer process.

Figure 15-5 Software License Transfer to Disk

1. Finally, install the removable disk from step 6 into the drive on the new computer and select **Software License** and **Transfer** using the Help drop-down menu. Select the 'Transfer license from a removable disk to computer' option and click the **OK** button. This completes the transfer process.

Figure 15-6 Software License Transfer to New Computer
If you are upgrading a version of RAYCHEM Supervisor using SQL Express to one using SQL Server (RAYCHEM Supervisor with Multi-User/Server Capability) perform the following steps:

1. Backup the SQL Express database on your existing computer using the RAYCHEM Supervisor Database Backup function (see Section 14.2.1). Copy the backup file to a removable drive.
2. If you are updating the existing computer, ensure that Microsoft Windows Server 2000 has been installed, and that you have uninstalled the previous version of the RAYCHEM Supervisor Master Server software (see Section 4.8.1).
3. Ensure that the new computer has been configured with all of the appropriate software as outlined in Sections 1 and 2.
4. Stop the RAYCHEM Supervisor Master Server (see Section 3.3).
5. Restore the database using the RAYCHEM Supervisor Master Server Configuration utility as described in Section 14.2.2.
6. Start the RAYCHEM Supervisor Master Server (see Section 3.2).
7. If your new system includes new Slave Servers, follow the steps outlined in Section 3, Quick Start Guide, Multi-User/Server (SQL Server) RAYCHEM Supervisor Installations, Steps 2 and 3.
8. Register and Activate your new software (see Section 15).
When you first install RAYCHEM Supervisor software on to your computer it will run in DEMO time restricted mode. In this mode, the software will limit the number of simultaneous users to four and no Slave servers will be supported.

The software will run continuously for 14 days, after which it will expire. When the system has expired no user will be allowed to login and you must stop and start the Master Server Service to reset the expiry timer.

To eliminate the expiry timer, you must:

1. Register your software with nVent.
2. Get a free activation code to activate your software. This free activation sets your copy of RAYCHEM Supervisor to a non-time restricted, fully operational mode.

There are two versions of RAYCHEM Supervisor software available:

3. The Standard version of the software includes licenses for up to four Users and no Slave servers.
4. RAYCHEM Supervisor with Multi-user/server Capability will be limited to the number of users and Slave Server connections that you have purchased. Along with your purchase of a licensed copy of RAYCHEM Supervisor, you will receive a Configuration (Config) Code. This Config code will be used to generate a Request code, and subsequently activate your software.

**IMPORTANT:** The Standard version of RAYCHEM Supervisor supports only Microsoft SQL Express databases. If Microsoft SQL Server is required due to your system's size or configuration, you must purchase a licensed version of RAYCHEM Supervisor with Multi-User/Server Capability.

### 16.1 ACTIVATE SOFTWARE LICENSE

Using a Client computer’s main window, click the Help drop-down menu and select **Software License**, then **Activate**. The License Activation window will be displayed.

You can perform three types of activation using the Activate Software License window.

#### 16.1.1 ACTIVATE A DEMO VERSION

If you did not purchase your copy of the RAYCHEM Supervisor software and would like to activate it:

1. Select Activate DEMO to Standard Version from the Activation Type drop-down box. This process will convert your copy from DEMO time-restricted mode into non-time restricted Standard mode.
2. A set of Configuration (Config) Codes will be filled in for you in the Config Code boxes, and you may click the **Generate Request Code** button to generate a Request Code.
Once you have the Request Code, you can use it to get an Activation Code from nVent. To activate using the Internet, go to the nVent Website at nVent.com and follow the links to the Supervisory Software section of the Website. Use the RAYCHEM Supervisor Registration selection to start the activation process. You must have your Request Code available as you will be asked to provide it.

3. Once you have obtained your Activation Code, enter it into the Activation Code boxes and click the **Activate Now** button. If there are no errors, you will see a message indicating a successful activation.

### 16.1.2 ACTIVATE A NEW LICENSE

If you have purchased your copy of RAYCHEM Supervisor with Multi-User/Server Capability and you need to activate it, locate the Configuration (Config) Code label located on the case of your RAYCHEM Supervisor CD.

To activate a new license:

1. Select **Activate New License** from the Activation Type drop-down menu.
2. Enter the Config Code on the label into the Config Code boxes.
3. Click the **Generate Request Code** button. If the Config Code is valid, the Request Code text boxes will be filled in with a Request Code.
4. Once you have the Request Code, you can use it to get an Activation Code from nVent. To activate using the Internet, go to the nVent Website at nVent.com and follow the links to the Supervisory Software section of the Website. Use the RAYCHEM Supervisor Registration selection to start the activation process. You must have your Request Code available as you will be asked to provide it.
5. Once you have obtained your Activation Code, enter it into the Activation Code boxes and click the **Activate Now** button. If there are no errors, you will see a message indicating a successful activation.

### 16.1.3 ACTIVATE AN UPGRADE

When upgrading the number of Server and/or User licenses for an existing copy of RAYCHEM Supervisor software with Multi-User/Server Capability, you will need to activate the additional licenses. Locate the Configuration (Config) Code label located on the case of your RAYCHEM Supervisor Upgrade CD.

To activate an Upgrade:

1. Select **Activate License Upgrade** from the Activation Type drop-down menu.
2. Enter the Config Code on the label into the Config Code boxes.
3. Click the **Generate Request Code** button. If the Config Code is valid, the Request Code text boxes will be filled in with a Request Code.
4. Once you have the Request Code, you can use it to get an Activation Code from nVent. To activate using the Internet, go to the nVent Website at nVent.com and follow the links to the Supervisory Software section of the Website. Use the RAYCHEM Supervisor Registration selection to start the activation process. You must have your Request Code available as you will be asked to provide it.

5. Once you have obtained your Activation Code, enter it into the Activation Code boxes and click the **Activate Now** button. If there are no errors, you will see a message indicating a successful activation of your upgrade.

You may verify the upgraded number of Server and/or User licenses by logging into RAYCHEM Supervisor and using the Help ➔ About window to display the total number of licenses.

![Figure 16-2 About RAYCHEM Supervisor](image)

**16.1.4 UPGRADE SQL SERVER LICENSES**

Once you have completed the upgrade process, increment the number of SQL Server licenses that you are approved to use. Make note of the total number and type of SQL Server 2000 Client Access Licenses (CALs) that you now own by looking at the summary in the RAYCHEM Supervisor Help ➔ About window (See Figure 14-1-3: in this example, there are a total of 2 Device + 9 User CALS for a total of 11 SQL Server CALs).

1. On the computer where you have installed SQL Server, click **Start ➔ Control Panel ➔ SQL Server 2000 Licensing Setup.**
2. When prompted to choose the Licensing Mode, select the **Per Seat** mode and enter the total number of CALs (devices) that you noted on the RAYCHEM Supervisor Help → About window.

### 16.1.5 UPGRADE WINDOWS SERVER LICENSES

Upgrading the number of Slave Servers or Users in a RAYCHEM Supervisor system will also require that you increase the number of Microsoft Windows® 2003 Server or Windows® 2000 Server licenses that you own.

The user is responsible for ensuring that the proper licensing following the latest requirements is obtained from Microsoft for legal use of Windows® Server and User or Device connections.

A number of options for Windows Server Client Access Licenses (CALs) are available from Microsoft. For a detailed description of the various options, see the Microsoft Website at [www.microsoft.com/resources/sam/lic_cal.mspx](http://www.microsoft.com/resources/sam/lic_cal.mspx).

Typical RAYCHEM Supervisor systems will use a mix of Device and User CALs. You will need to purchase a separate Windows Server Device CAL for each Master and Slave Server and a separate Windows Server User CAL for each User in your RAYCHEM system. You can verify the number of each type of Windows Server CAL that you require by looking at the summary in the RAYCHEM Supervisor Help → About window (See Figure 15-2 About RAYCHEM Supervisor).

### 16.2 REGISTERING ONLINE

Click “Register” under the Help pull down menu in the RAYCHEM Supervisor Client main screen to complete the registration form online.

### 16.3 TRANSFERRING A LICENSE TO ANOTHER COMPUTER

A Software License may be transferred from one computer to another. In order to transfer the license to a different computer, you must have a valid license in the computer presently running the RAYCHEM Supervisor Master software.

Use the following steps to transfer a license:
1. Install the RAYCHEM Supervisor Master Server and Client software onto the new computer. This computer should be connected to your plant or office network.

2. On the new computer, start the Master Server service (refer to Section 4.2 “Starting Your RAYCHEM Supervisor Master or Slave Server”), then start the Client software. Log in to the Master server using the default user ‘admin’.

3. Insert a blank floppy disk or a removable disk (also known as a memory stick, flash or USB drive) into the new computer.

4. On the new computer’s Client main window, use the Help drop-down menu and select Software License and Transfer. Once the Software Transfer window displays, select the ‘Create a blank software license on to a removable disk’ option and select the drive letter that corresponds to the removable disk that you have installed in step 3 above.

5. Click the OK button to start the process.

![Software License Transfer](image)

Figure 16-4 Create a Blank Software License

6. Insert the blank software license removable disk created in the previous step into the existing Master Server computer. Again, use the Help drop-down menu and select Software License and Transfer. Select the ‘Transfer license from computer to a removable disk’ option and click the OK button to transfer the software license to the removable disk. The old Master Server computer will be updated to DEMO mode.
7. Finally, install the removable disk from step 6 into the drive on the new computer and select Software License and Transfer using the Help drop-down menu. Select the 'Transfer license from a removable disk to computer' option and click the OK button. This completes the transfer process.
16.4 UPGRADING RAYCHEM SUPERVISOR FROM SQL EXPRESS TO SQL SERVER 2000

If you are upgrading a version of RAYCHEM Supervisor using SQL Express to one using SQL Server (RAYCHEM Supervisor with Multi-User/Server Capability) perform the following steps:

1. Backup the SQL Express database on your existing computer using the RAYCHEM Supervisor Database Backup function (see Section 14.2.1). Copy the backup file to a removable drive.

2. If you are updating the existing computer, ensure that Microsoft Windows Server 2000 has been installed, and that you have uninstalled the previous version of the RAYCHEM Supervisor Master Server software (see Section 4.8.1).

3. Ensure that the new computer has been configured with all of the appropriate software as outlined in Sections 1 and 2.

4. Stop the RAYCHEM Supervisor Master Server (see Section 3.3).

5. Restore the database using the RAYCHEM Supervisor Master Server Configuration utility as described in Section 14.2.2.

6. Start the RAYCHEM Supervisor Master Server (see Section 3.2).

7. If your new system includes new Slave Servers, follow the steps outlined in Section 3, Quick Start Guide, Multi-User/Server (SQL Server) RAYCHEM Supervisor Installations:, Steps 2 and 3.

8. Register and Activate your new software (see Section 15).
APPENDIX A – TROUBLESHOOTING

A-1 INSTALLATION ERRORS

Cannot install Master Server due to database error
Ensure that the Microsoft SQL Server or SQL Express is properly installed and running on the computer where you are installing RAYCHEM Supervisor.

Verify that the Master Server name has been typed in correctly.

A-2 STARTUP AND RUN-TIME ERRORS

Cannot log in to RAYCHEM Supervisor
Verify the following:

a. Make sure you are logging in to the Master Server
b. Make sure the Master Server is running
c. Make sure you have a LAN connection and it is working properly

“Device not found” window is displayed when trying to monitor an HTC
If the HTC is connected to a Slave Server, verify that the Slave Server is running and connected to the LAN.

Cannot add Server
Make sure RAYCHEM Supervisor is activated.

Ensure that the Server is online.

Cannot receive new alarms
If you have a firewall enabled, verify that ports 8888 and 8889 are open to the RAYCHEM Supervisor Client software.

RAYCHEM Supervisor runs very slowly
If your system includes more than 500 to 1000 controllers, or you have multiple users running a number of data trending or batch jobs, you may need to upgrade your database and RAYCHEM Supervisor to use Microsoft SQL Server.

A-3 COMMUNICATION ERRORS

Communication Failures
When RAYCHEM Supervisor is connected to GCCs and HTC-direct controllers using a 2-wire RS-485 configuration, make sure that the Tx Delay setting for each GCC and HTC-direct controller is set to at least 0.06 seconds. This will ensure that the GCC or HTC-direct devices do not start to transmit a reply until RAYCHEM Supervisor has turned off its driver.

A-4 OTHER ERRORS

Some text does not display properly in the “Help About” window
If you are using McAfee Virus Scan software, you may have to disable the “Buffer Overflow Protection” option in the McAfee setup to eliminate this problem.
APPENDIX B – RAYCHEM SUPERVISOR DATABASE CONVERSION UTILITY

B-1 INTRODUCTION

The RAYCHEM Supervisor database conversion utility was created to facilitate upgrading from RAYCHEM Supervisor version 1.x (referred to as "RAYCHEM SupervisorV1") to RAYCHEM Supervisor version 2.x (referred to as "RAYCHEM SupervisorV2").

This conversion utility converts RAYCHEM SupervisorV1 system data into XML format, which can be imported into a RAYCHEM SupervisorV2 system. The utility allows the user to choose what existing data to convert, and then export the data to a file in XML format. The exported data can then be imported into RAYCHEM SupervisorV2 using the RAYCHEM Supervisor Client’s import function.

B-2 SYSTEM REQUIREMENTS

The utility runs on Microsoft .NET framework version 4.0.

B-3 INSTALLING THE RAYCHEM SUPERVISOR DATABASE CONVERSION UTILITY

The RAYCHEM Supervisor Database Conversion Utility is packaged with the RAYCHEM Supervisor Client software. It can be found in the ConvertTools folder, under the RAYCHEM Supervisor Client installation folder. The utility executable is RAYCHEM SupervisorConvert.exe.

This utility requires the CsharpZip.dll to run; therefore you must copy both files if you have to run the software on another computer.

B-4 USING THE RAYCHEM SUPERVISOR DATABASE CONVERSION UTILITY

Figure B-4 below shows the Utility’s main window.

![Figure B-1. Main window](image)

[Image of the Utility’s main window]
B-4-1 Specifying the RAYCHEM Supervisor V1 Installation Path

In the RAYCHEM Supervisor Program Path textbox, type the installation path of RAYCHEM SupervisorV1. You may use the browse button at the right to browse to the folder. Any folder that has the same structure as the RAYCHEM SupervisorV1 installation folder may be used. This folder should contain all the RAYCHEM SupervisorV1 database files to be converted.

B-4-2 Choosing the Data to Convert

From the main UI, you can choose what data you want to convert into the new XML-based format. Some data items are dependent on others, and in these cases, you cannot convert the dependent data alone. Independent data can be converted separately, or at the same time as the other data.

B-4-3 Trend Data and Event Logs

If you choose to convert Trend Data and/or Event Logs, you must manually copy the converted data files to the Master Server computer after the conversion has been completed. The converted Event Log files are stored in the "Archived" folder, and it may be found under the RAYCHEM Supervisor Program Path folder. The converted Trend Data files are stored in the "Archived\TrendData" folder, which may also be found under the RAYCHEM Supervisor Program Path folder.

On the Master Server computer under the folder "C:\Program Files\nVent\RAYCHEM Master Server", you will find the "Archives" and "Archives\TrendData" folders. Copy the converted data files to these corresponding folders on the Master Server computer.

B-4-4 Using New Drawing Path

When you convert devices, their drawing paths will also be converted. If you want to copy the device drawings to a new folder, such as a network shared folder to allow users to view the drawings from different client computers, you can choose the "Use new drawing path" option to specify a new path. The utility will replace all device drawing paths with the new path, keeping the drawing file names only. Note that the utility does not copy the actual drawing files for you.

You can also change the drawing paths after you have imported the data into RAYCHEM SupervisorV2. You can do so using the RAYCHEM Supervisor Client’s "Batch Change Drawing Paths" function.

B-4-5 Converting the Data

When you click the Convert button, the utility will prompt you for a file name to save the converted data, as shown in the figure that follows.
You can choose to save the file with the extension of RAYCHEM Supervisor or XML – either format may be imported into RAYCHEM SupervisorV2.

Conversion time will depend on how much data you have chosen to convert. A progress bar will be shown to indicate conversion progress. After the conversion has been completed, if there have been any errors during the conversion, a window will be shown listing the errors/messages, as in Figure C-3 below.

You may save this error list for reference by clicking the Save As button.

**B-4-6 Importing Data into RAYCHEM Supervisor V2.X**

The exported data file can be imported into RAYCHEM SupervisorV2 using the RAYCHEM Supervisor Client’s import function. Please refer to Section 15.1 Export and Import for instructions on how to perform this operation.
APPENDIX C – SQL SERVER DATABASE MAINTENANCE PLAN AND RECOMMENDED BACKUP PROCEDURE FOR RAYCHEM SUPERVISOR

**IMPORTANT:** Support from your IT Department is recommended for this procedure.

**IMPORTANT:** The procedure describes in this section applies to Microsoft SQL Server 2000 only. If you are not using Microsoft SQL Server 2000, please refer to the appropriate section in your SQL Server documentation.

C-1 SETUP A DATABASE MAINTENANCE PLAN

To setup a database maintenance plan:

1. From the Start menu, select All Programs, then select MICROSOFT SQL SERVER.
2. Launch Enterprise Manager and expand the Databases folder until your database appears, then expand the Management folder.

![Figure C-1. SQL Server Enterprise Manager](image)

3. Right click the Database Maintenance Plans and select **New Maintenance Plan**. The Database Maintenance Wizard will allow you to set up a maintenance plan that will automatically backup the database.
4. When the Welcome page appears as in the following example, click **Next**.
5. In the event that your database becomes corrupted, select the All Databases option and click Next as displayed in the following example.

6. Define the options for Data Optimization by selecting the Reorganize data and index pages option. The schedule defaults to: Occurs every 1 week(s) on Sunday, 1:00:00AM as shown in the following example.
If the default schedule does not accommodate your needs, click **Change**, set the schedule as desired, and click **OK** as shown in the following example.

From the Database Integrity Check window, define the options for a Database Integrity Check and click **Next**. At a minimum, accept the default values as shown in the following example.
9. On the Specify the Database Backup Plan window, define options for the database Backup Plan by selecting the **Backup** option and the **Verify** option, and setting the location to **Disk**. The default schedule is set to: Occurs every 1 week(s) on Sunday, 2:00:00AM. If the schedule does not accommodate your needs, click **Change**. It is recommended that the Backup Databases function be run after hours. The time it takes to complete a backup depends on the size of the database.
10. From the Specify Backup Disk Directory window, specify the following options and click Next as shown in the following example.

- **Define the disk backup location.** You may use the default backup directory or click the **Browse** button to choose an alternate location. It is generally best to choose a network drive. However, if you select the default location, ensure that the computer gets backed up on a regular basis.

- **If you select the **Create a subdirectory** option, the system backs up each database into separate folders.

- **Select the **Remove files older than** option.** This option is recommended in order to not overload the backup directory.

![Specify Backup Disk Directory](image.png)

Figure C-8. Specify Backup Disk Directory
11. From the Specify the Transaction Log Backup Plan window, select the **Back up the transaction log as part of the maintenance plan** option. If this option is selected, ensure the options are the same as those chosen in the database backup (step 9).

![Database Maintenance Plan Wizard](image1)

**Figure C-9. Backup Log Selection**

12. From the Reports to Generate window, select the **Write report to a text file in directory** option and click **Next** if you want the maintenance plan generate reports.

![Database Maintenance Plan Wizard](image2)

**Figure C-10. Backup Report Generation**
13. From the Maintenance Plan History window, define the options for the Maintenance Plan History and click **Next**. The default options are usually adequate. You can view the Maintenance Plan History by right-clicking the maintenance Plan and selecting **Maintenance Plan History**.

![Figure C-11. Maintenance Plan History](image)

14. Enter a name for your plan and click **Finish** to complete the setup process and exit the Wizard.

![Figure C-12. Complete the Wizard](image)
C-2 MAKING THE SQL SERVER AGENT ACTIVE

Execution of the Maintenance Plan requires that the SQL Server Agent be active— if it is not, the system will display an error message. If you see the following error message from the SQL Server Enterprise Manager, click OK, then click Finish on the Complete the Wizard window.

Figure C-13. SQL Server Agent Error Message

To activate the SQL Server Agent:

1. From the Start menu, select → Settings → Control Panel → Administrative Tools → Component Services → Services (Local) → SQLSERVERAGENT as shown in the following example.

Figure C-14. Starting the SQL Server Agent Service

2. Right click on SQLSERVERAGENT and go to Properties. In the Startup type field, select Automatic and click OK as displayed in the following example.
3. Right click the SQLSERVERAGENT, click Start and then click OK.
4. The SQLSERVERAGENT service status should now be displayed as “Started” and the Startup Type should be displayed as “Automatic” as in the following example of an activated SQL Server Agent.

![SQL Server Agent Properties](image1)

**Figure C-15. SQL Server Agent Properties**

C-3 RESTORING YOUR DATABASE

**IMPORTANT:** Before restoring the RAYCHEM Supervisor Database, the RAYCHEM Supervisor Master Server Service must be stopped. See Section 3-3 in the RAYCHEM Supervisor User Manual for detailed instructions on how this can be done.

To restore the RAYCHEM Supervisor SQL database:

1. Navigate to the folder where the database is located and click etplus as shown in the following example.

![Component Services](image2)

**Figure C-16. SQL Server Agent Component Status**
Figure C-17. Select the Database

2. From the menu, select **Tools** and then **Restore Database** as in the following example.

Figure C-18. Select Restore Feature
3. From the Restore Database window, choose the file to restore from, and click **OK** as shown in the following example. Depending on the size of the database, this process may take a few minutes. Once the process is complete the Master Server Database will be restored.

**IMPORTANT:** Once the Database has been restored, the RAYCHEM Master Server service must be restarted. See Section 3-2 in the RAYCHEM Supervisor User Manual for detailed instructions on how this can be done.

![Restore database window](image)

Figure C-19. Restore the Database
APPENDIX D – COMMON ALARMS SYSTEM OVERVIEW

D-1 INTRODUCTION

In the past, the Common Alarms function was requested by several of our large customers. These customers have the need for remote notification of EHT system alarms occurring in different areas of their plant. They wanted to ensure when alarms do occur the alarm notification happens in various locations in the plant so maintenance personnel can be alerted. This kind of application requires the use a RMC device. A RMC device has Input and Output modules, and each Output module contains 1 or more Output relays. These relays can be connected to their DCS systems, annunciation panels, and/or other devices. For normal operation, a RMC device connects to a Modbus network and it allows an upstream device such as RAYCHEM Supervisor to control the state of the Output Relays. The name RMC refers to Remote Module Control, and is a product sold by nVent. The original RMC is made up of a Wago 750-312 serial coupler and several Wago Input and Output modules. Recently an Ethernet version is available (i.e Wago 750-352).

Due to varying EHT system sizes, multiple alarm output contacts are required. The feature needs to be flexible enough to allow users to toggle alarm contacts under rules that vary from any alarm on any device, to specific alarm conditions on a specific device in a specific device group.

D-2 FUNCTIONALITY

This section describes the fundamentals of the Common Alarms, from each of the available settings to the normal operating specifications.

D-2-1 Topology of a Typical EHT System

For a typically EHT System (Electric Heat Trace) there are Communication gateways (i.e. GCCs, NGC-40 Bridges, NGC-30 UITs) and heat trace controllers along with some Master communication software such as RAYCHEM Supervisor used to configuration and monitor those devices. For Remote Alarm Relay capability, there would be RMC devices as well. These RMC devices are used for its output relays. Figure 1.2 illustrated the typical hardware/software topology.
D-2-2 Common Alarms Configuration

RAYCHEM Supervisor currently supports up to 16 Common Alarms Output. Each Common Alarms Output controls 1 Output relay on the RMC device. By design only the Master Server is allowed to create and manage the Common Alarms. This means that if a RMC is connected on a RS-485 network, then a serial connection is necessary from the Master Server computer to the RMC. This limitation can be avoided if an Ethernet RMC is used, as it can reside anywhere a network connection exists.

For each Common Alarms Output, the following configurations are available:

<table>
<thead>
<tr>
<th>Common Alarm Configuration Setting</th>
<th>Description</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant Group</td>
<td>The Plant Group defines a filter for alarms that belongs to a particular Plant Group. For example if this is set to Plant Group #1, then only alarms that are from devices that belongs to Plant Group #1 will be affect the operation of this Common Alarms Output.</td>
<td>The available Plant Groups defined in the system. Default: All All (i.e. all alarms) is the same as no filter. Therefore any alarms will affect this Common Alarms Output.</td>
</tr>
<tr>
<td>Alarm Types</td>
<td>This is the filter for types of alarms. If this filter is set, only those alarm types will affect the operation of this Common Alarms Output.</td>
<td>Any, Low Temperature, High Temperature, Ground Fault Trip, Ground Fault, Low Current, High Current, TS Failure, Communication Failure.</td>
</tr>
<tr>
<td>Common Alarm Module</td>
<td>A Common Alarm Module represents the hardware that is to be controlled by this Common Alarms Output. A RMC for example can be used as the Common Alarms Module. There can be 1 or more Common Alarms Modules in the system</td>
<td>Default: None To create Common Alarms Module, use the Manage Common Alarms Modules menu option under the Common Alarm Outputs menu.</td>
</tr>
<tr>
<td>Channel</td>
<td>The channel defines the output relay that is controlled by this Common Alarms Output. For example, a RMC can have more than 32 Output relays depending on the type of Output relay modules used. In order to access relay #5, you would need to set the channel to 5. The index of an output relay is sequential and it starts at 1.</td>
<td>Default: 1</td>
</tr>
<tr>
<td>Alarm Mode</td>
<td>The Alarm mode defines the Common Alarms Output behavior. The relay output can be either On or either Off depending on the alarm conditions, or it can be toggled where the output is turn Off and then back On. For more explanation of the Alarm Mode and Alarm State see the section 2.2.</td>
<td>Disable, Steady State, Toggle Default: Disable A Disable setting will disable this Common Alarms Output.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Range</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Toggle Duration</td>
<td>The Toggle Duration is used only when the Alarm Mode is set to Toggle. When a new alarm is detected, the Common Alarms Output will toggle the output relay by setting the relay Off, and holds it Off for the Toggle duration then returning the relay to On again.</td>
<td>Range: 1 to 5 Seconds</td>
</tr>
<tr>
<td>Email Address</td>
<td>An email address can be entered for this Common Alarms Output. If email address is used then an email is send to SMTP server when alarms are detected. The SMTP server settings are defined in the System Preferences menu under the General Tab.</td>
<td>Default: empty field</td>
</tr>
</tbody>
</table>

**D-2-3 Common Alarm Output States**

Each of the Common Alarms Output can be in the following states:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVE_OFF</td>
<td>Active means this common alarms output is not disabled. The Alarm Mode is set either as Steady or Toggle. During startup or initialization, all Common Alarms Output that are not disabled will be set to this state.</td>
<td>For a Normally Open relay, the relay in this state is Off or Not Energized.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For a Normally Closed relay, the relay in this state is On or Energized.</td>
</tr>
<tr>
<td>ACTIVE_ON</td>
<td>This state is used mainly for Alarm mode that is set as toggle. For the Toggle type alarm mode, when there are no alarms detected, it remains in the ACTIVE_OFF state, when the 1st set off alarms are detected, the common alarm output will switch to the ACTIVE_ON state.</td>
<td>For a Normally Open relay, the relay in this state is On or Energized.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For a Normally Closed relay, the relay in this state is Off or Not Energized.</td>
</tr>
<tr>
<td>ACTIVE_IN_TOGGLESTATE</td>
<td>This state is used mainly for Alarm mode that is set as toggle. For the Toggle type alarm mode, it must first be in the ACTIVE_ON state, when new alarms are detected it will go into the ACTIVE_IN_TOGGLESTATE. The output will be toggle Off and back On with a delay between toggle using the Toggle interval.</td>
<td>For a Normally Open relay, the relay in this state turns Off and after the toggle interval, turns back On.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For a Normally Closed relay, the relay in this state turns On and after the toggle interval, turns back Off.</td>
</tr>
<tr>
<td>INACTIVE</td>
<td>This state is set for any common alarms output that are disabled. No action to control the relay in any alarm conditions.</td>
<td></td>
</tr>
<tr>
<td>ACTIVE_INCOMMFAILURE</td>
<td>This is an error status that is masked into the State variable. (i.e Bit wise OR operation)</td>
<td></td>
</tr>
<tr>
<td>ACTIVE_INWRONGSTATE</td>
<td>This is an error status that is masked into the State variable. (i.e. Bit wise OR operation)</td>
<td></td>
</tr>
</tbody>
</table>
D-2-4 State diagram for Alarm Mode set as Steady State:

D-2-5 State diagram for Alarm Mode set as Toggle State:
D-2-6 State diagram for Alarm Mode set as Disabled:

<table>
<thead>
<tr>
<th>Common Alarms</th>
<th>No Alarm</th>
<th>New Alarms Detected</th>
<th>More new Alarms Detected</th>
<th>Alarms Cleared</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output #1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Alarm Mode set as Disabled)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output = INACTIVE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Data trending and data collection are options available in Raychem Supervisor. The material covered in this section provides guidelines for users that are interested in exploring these options.

To trend data, a Trend Group must first be defined (for information on Trend Group Setup please refer to the section on Trending and Data Logging above). A Trend Group consists of a Group of devices to trend, a Logging Interval (aka. Trend / Read interval), the Maximum number of reads, and the action to take when the maximum number of reads is reached. Trended data includes process variables, minimum and maximum temperatures, maintenance data, and alarm status for each device trended.

The processes for data trending and data collection are resource intensive, therefore, enabling these options will affect the overall performance of Raychem Supervisor. In order to maximize the use of Raychem Supervisor and optimize performance, there are three specific items that must be considered:

- Logging Interval
- Data Storage Size
- Maximum number of Reads

E-1 LOGGING INTERVAL

A Logging Interval is assigned to a Trend Group, and it is the time required to retrieve data from all devices in the Trend Group. As an example - if a Trend Group is assigned 100 devices, and it requires 900 milliseconds (note 1) to retrieve trend data from 1 device, the minimum Logging Interval should be no less than: 100 devices x 900 milliseconds, or 90 seconds. As this time represents the minimum amount of time it would take Supervisor to collect trend data for all 100 devices, the Logging Interval should be set above this value to allow Raychem to scan all devices.

It is possible to determine a more accurate Logging Interval through the use of the diagnostics function in Supervisor. This tool can log communication activities, allowing one to inspect the Modbus messaging for more details. Knowledge of the Modbus protocol is required to understand the information gathered from the log, and more information on logging communication activities can be found in the section on Diagnostics Functions above.

Many factors affect Logging Interval, such as the controller type, the number of circuits installed in a given panel, and the communication connections used (such as serial, Ethernet TCP/IP, or through an Ethernet gateway). The factor that affects the minimum Logging Interval the greatest is the type of connection used to connect heat trace controllers. The most common types of connections are Serial through COM ports, or Ethernet TCP/IP through LAN ports. For data collection in Raychem Supervisor, Supervisor allocates 1 task (note 2) for each Serial COM Port used, and 5 tasks for Ethernet TCP/IP connections; this task allocation is per Server based.

If Serial COM ports are used, increasing the number of physical connections (i.e. loops) used can help reduce the minimum Logging Interval as it allows Raychem Supervisor to multitask more effectively. However, capacity is dependent on the type of Raychem Installation – Standard or Enterprise.

For Raychem Supervisor Standard, the total number of tasks is limited to 1 task per COM Port (to a maximum of 9 COM ports), and 5 tasks for Ethernet TCP/IP connections. Therefore the most tasks a Standard installation can manage at once is: 9 (COM) tasks + 5 (Ethernet) tasks, for a total of 14 tasks.

For the Raychem Supervisor Enterprise, the total number of tasks are the sum of all tasks for the Master and Slave Servers combined. As an example – for an Enterprise system with 5 Slave Servers and 1 Master Server, with each Server using 1 COM port and 1 Ethernet TCP/IP port for communications, there will be 1 (COM) task + 5 (Ethernet) tasks, for a total of 6 tasks running on each Server. Therefore, total number of tasks dedicated for data collection is 6 (Tasks for each Server) x 6 (Servers), for a total of 36 tasks. This number can be increased by using additional COM ports on each Server as was demonstrated in the Standard setup above.
Additional information on ports, tasks, and Logging Intervals is provided in the table below:

<table>
<thead>
<tr>
<th>Port Connection Used</th>
<th>Task Allocation</th>
<th>Minimum Logging Interval (Using a 500 Circuit example)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single COM Port connection</td>
<td>1</td>
<td>500 circuits x 0.9 seconds = 450 seconds</td>
</tr>
<tr>
<td>Multiple COM Port connections</td>
<td>N tasks (Maximum of 9 for 9 COM Ports)</td>
<td>(500 circuits x 0.9) / N = 450 seconds / N</td>
</tr>
<tr>
<td>Ethernet TCP/IP connection</td>
<td>5 tasks</td>
<td>Supervisor assigns each device with an IP address to a task. Devices with the same IP address will be grouped to the same task if possible. Depending on the number of devices in the system, at least 1 task is allocated in the system. For example: if 500 circuits is distributed evenly on 5 IP addresses, the polling interval would be (500 / 5) * 0.9 seconds, or 90 seconds per IP. Otherwise, the minimum Logging Interval will be the interval for the IP with the greatest number of devices</td>
</tr>
</tbody>
</table>

*The above is based on the assumption that an equal number of circuits are distributed over N COM Ports, otherwise the minimum Logging Interval will be the interval for the COM port with the greatest number of devices.

**Note 1:** Based on past observations of Raychem Supervisor communicating to NGC-20 and NGC-40 systems, using a serial connection at 9600 Baud, the average polling time required to retrieve data from 1 device is approximately 900 milliseconds. Actual times may vary and are dependent on network configuration and equipment settings. Consider this time as a starting point in determining minimum Trend requirements.

**Note 2:** In computing, a task is a unit of execution / process used to accomplish some purpose. All of today’s operating systems support multitasking, allowing multiple tasks to run concurrently, each taking turns using the resources of the computer.

---

**E-2 DATA STORAGE SIZE**

Trend data is stored in the SQL Server database until archived. The size of the trend data depends in part on the number and type of devices being trended. For example, the table below shows the different types of devices and their respective data storage sizes. The data size represents the number of bytes required to store trend data for 1 device:

<table>
<thead>
<tr>
<th>Device Type</th>
<th>Data size (Bytes) as stored in SQL database</th>
</tr>
</thead>
<tbody>
<tr>
<td>910,920, CM2000, CM2000+ and older controllers</td>
<td>1370</td>
</tr>
<tr>
<td>NGC-20</td>
<td>1545</td>
</tr>
<tr>
<td>NGC-30 UIT Circuit</td>
<td>1370</td>
</tr>
<tr>
<td>NGC-40 HTC</td>
<td>1614</td>
</tr>
<tr>
<td>NGC-40 HTC3</td>
<td>2146</td>
</tr>
<tr>
<td>NGC-40 SLIM</td>
<td>677</td>
</tr>
<tr>
<td>NGC-40 IO</td>
<td>827</td>
</tr>
<tr>
<td>Elexant 4010i/4020i</td>
<td>3050</td>
</tr>
</tbody>
</table>
E-3 MAXIMUM NUMBER OF READS

The end of a single Logging Interval equates to a single Read event (all required circuits have been polled) in Supervisor. The Maximum Number of Reads defines when Supervisor is required to create an archive file of the Trend data and manage data storage sizes (described further in section E-2).

The following table illustrates how to determine the data storage requirements of Trend data and Archive files.

<table>
<thead>
<tr>
<th>Trend Data Storage Size Requirement</th>
<th>Archive File Storage Size Requirement (note 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Requirements Calculation = Data size per device x Number of Reads x Number of Devices)</td>
<td>Using compression ratio of 14 (note 4)</td>
</tr>
<tr>
<td>1) Trending 1000 circuits:</td>
<td>155 MB / 14 = 11 MB</td>
</tr>
<tr>
<td>1614 Bytes * 96 reads (note 5) * 1000 circuits = 155 MB</td>
<td></td>
</tr>
<tr>
<td>2) Trending 2000 circuits:</td>
<td>310 MB / 14 = 22 MB</td>
</tr>
<tr>
<td>1614 Bytes * 96 reads (note 5) * 2000 circuits = 310 MB</td>
<td></td>
</tr>
</tbody>
</table>

Note 3 – Archived Trend data files are stored under the Raychem Supervisor Master Server installation folder (i.e. C:\Program Files (x86)\nVent Thermal\Supervisor Master Server\Archives\TrendData).

Note 4 – The compression ratio is determined to be approximately 14 based on archival tests. Actual compression ratios may vary depending on the device types used (this example is in relation to NGC-40 HTC devices, but is indicative of other device types).

Note 5 – A Logging Interval of 15 minutes, with data archived daily (24 hours * 60 min. per hour / 15 min. Logging Interval = 96 reads per day).

E-4 USAGE AND SYSTEM REQUIREMENTS FOR RAYCHEM SUPERVISOR STANDARD AND ENTERPRISE INSTALLATIONS

Raychem Supervisor Standard includes SQL Server Express Edition, which is a free version of Microsoft SQL Server Edition. SQL Express is a lighter version of SQL Server, and as a result, there are limitations to be aware of. The table below lists some of the limits for different SQL Servers since SQL Server 2008. SQL Server Express allows for a maximum of 1 GB of memory for cache, and 1 CPU limit. This restriction limits the servers performance even if the host computer has sufficient horse power. This is not the case for the SQL Server edition. SQL Server edition will make full use of the available horse power in the host machine to run as fast as possible. To improve performance under SQL Server, add more memory or upgrade to a faster processor / motherboard:
Due to the performance limitation of SQL Server Express edition, the maximum amount of trend data stored in the SQL database should be kept to less than 60% of the 4 GB maximum, which is approximately 2.4 GB. This would limit the number of circuits to 1000, assuming 1000 circuits are trended over 1440 reads, which results in the storage size of over 2.3 GB.

For optimum performance and scalability, subdivide the total number of controllers and assign them to individual Slave servers. Each Slave Server will manage data collection independently, which allows for simultaneous data collection. The data collected by each Slave Server will be combined and stored in the SQL Server database, which resides on the Master Server. This requires the host computer for the SQL Server database to be equipped with sufficient memory and power to handle the data transactions to save the data. Additionally, there must be sufficient free disk space for saving the archived trend data files.

The recommendations below are in support of the requirements defined within each individual Raychem Supervisor manual. They are estimations of free disk space requirements based on 15 minute Logging Intervals, with trend data archived daily. For illustration purposes a maximum number of 100 Reads is selected: